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1. Welcome to the Vista 
Welcome to the User Guide for the Jands Vista lighting console. This guide is 
intended to give you the information you need to get your Vista up and running 
as quickly as possible. 

Note that this guide will be regularly updated as enhancements are made to the 
Vista. A current version of the manual is available at www.jandsvista.com. 

What’s different about the Vista? 
You’ll have noticed that the Vista is a bit different to most other consoles you’ve 
used. Instead of a keypad, it uses a pen; instead of relying on you entering 
hundreds of key combinations, the Vista lets you do everything visually; instead 
of representing your show as numbers, the Vista represents it as events 
happening over time. 

If you’ve seen any of the digital editing software packages for sound and video 
that are available these days, the most different aspect of the Vista, the timeline, 
will be instantly familiar to you. If not, don’t worry, once you start using it you’ll 
pick it up very quickly. 

The Vista is different, but that’s what makes it so much easier to use. Once 
you’ve read this guide you’ll have enough of an idea of how this console works 
to create your first lightshow. 

What things are the same as on other 
consoles? 
Apart from the pen and the timeline concept, the Vista contains all the basic 
elements of live lighting that you’re familiar with. You’ll find controls for 
intensity, colour, beam, gobos and so on; you’ll find libraries of all the 
manufacturers’ most popular fixtures to choose from; you’ll find a console that 
has the usual faders, buttons and LCD displays. 

So don’t worry, the Vista has a lot in common with other consoles – we’ve taken 
all the best elements of existing consoles and added a whole new dimension to 
them. You’ll soon be right at home with the Vista. 
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About the generic fixture model 
One thing about the Vista that’s not immediately obvious is the ‘generic fixture 
model’. What is it? It’s a part of the software that works in the background and 
enables all fixtures, no matter what type or manufacturer to be treated the same 
way.  

Let’s say you’ve programmed a show using one brand of fixture but need to 
replace some of them with a different kind. Normally this would be a major 
hassle because you’d have to find a similar fixture then re-program each and 
every cue. 

With the Vista, you can replace a fixture and you don’t have to do any re-
programming. Why? Because everything you’ve programmed is stored in 
generic form rather than as specific DMX channel values. For instance if you’ve 
programmed the lights to be Red, the Vista can send that information to any light 
and achieve the same colour. 

Sure, if you replace a fixture that has colour mixing with a fixture that has a fixed 
colour wheel, you won’t expect to get the exact same result, but even in this case, 
the Vista will adapt and provide as near a match as the replacement fixture is 
capable of. 

Need more information? 
If you have questions about the Vista or you’d like more information, go to our 
website at www.jandsvista.com, or call us on +61-2-9582-0909. 
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2. Getting started 

Setting up the console 

Power 
Connect the Vista T, I or  S series console to any mains supply between 100 and 
240vAC. The Vista M series obtains power via the USB port 

External displays 
You can attach two external displays, including touch screen monitors to the 
Vista T series consoles using standard VGA connectors.  
Vista I series consoles have connections for  one DVI and one VGA monitor. A 
DVI – VGA cable can be used if you prefer to use two VGA monitors. 
Vista L series consoles have connections for one DVI / HDMI  and one DVI / 
VGA monitor. 

Vista has been tested with Wacom pen tablet LCDs and  ELO ‘Intellitouch 
and Accutouch’ monitors.  ELO makes many different touch screen monitors 
and not all models may be compatible. Please check for compatibility before 
purchasing touch screen monitors for use with your Vista console. 

 

For Vista M and S series control surfaces, monitor configuration will depend on 
the configuration of the computer you are using. 

Desk Lights 
You can attach two Littlelite or equivalent desklights to the Vista L and T series 
console and one to the I and S series consoles.  
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Switching on 
When you switch the console power on or launch the application on your PC, 
Vista starts up and displays the opening splash screen: 

 

Once it finishes loading the program, Vista displays the Patch screen. If this is the 
first time you’ve opened Vista V2 or you are starting a new show the patch table 
will be empty.: 
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This is the Patch window, waiting for you to start creating a new show. To see 
the other Vista windows you use the buttons on the toolbar at the top left of the 
screen: 

This button… does this… 

 
displays the Patch window  

 
displays the Console hardware simulation window 

 
displays the Programmer Fixtures window 

 
displays the Programmer Timeline view.  

 
displays the Playback control window  

 
displays the fixture Output window 
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Creating and loading shows 

Creating a show 
To create a new show at any time, choose the New Show option from the File 
menu. 

Loading existing shows 
To load a show you’ve already created, choose the Open  Show option from the 
File menu. Vista displays the Open Show window: 

 

To load a show archive  you’ve previously saved (or transferred to the console 
using the export / import function), find the directory containing it, then click on 
the filename to select it and hit the Open button to load it. 

Saving shows 
To save a show at any time, choose the Save Show option from the File menu. As 
with any computer, it’s a good idea to save regularly in case of power failure. 
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The first time you save a new show, Vista displays the Save As window: 

 

Type a name for the file and then click the Save button. Vista automatically 
creates a show folder, with the same name and puts the show file inside it. Once 
you’ve named the file, each time you choose the Save option from then on, Vista 
overwrites that file with the new details without displaying this window. 

Saving copies of shows 
To save a separate version of a show with a different name, choose the Save 
Show As… option from the File menu. You can then give the file another name 
and save it in a separate show folder. 

Importing show archives 
You can also open shows you’ve created on a PC or another console onto the 
Vista. The shows must be on a CD or any kind of storage device that connects to 
the Universal Serial Bus (USB) port (such as a memory stick). 

To open a show, attach the USB device or put the CD in the CD drive (if 
available) and choose the Import > Show… option from the File menu. 

Exporting show archives (backing up) 
It’s extremely important to make backup copies of your show user data folders. 
Like any other computer, the Vista stores your shows on a hard drive, and 
although it’s extremely unlikely, if this drive were to fail (e.g. if the console was 
dropped) you could lose all the show files stored on it.  

For this reason we recommend that you make regular backups of your work, 
onto a storage device that you can connect via a USB port.  

To export a show archive onto an external storage device: 
1. Connect a USB Flash drive or  external disk  to the USB port. 

2. Choose the Export option from the File menu. Vista displays the Export 
window: 
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3. Click on the Show button and then select the show to backup from the list of 
show files. 

4. Click the Next button. Vista displays the Export window: 

 

5. Click the Browse button and choose a drive and directory on the computer 
or storage device and hit the Export button. 

6. Click the Finish button to close the Export window. 

Deleting shows 
To delete a show, choose the Open show option from the File menu, then right-
click on the show folder name and choose ‘Delete’ from the popup menu. 

 

Password‐protecting your console or show 
You can lock your  console or show file or disable editing, with a password. To 
do this: 
1. Choose the Lock option from the File menu. Vista displays a popup menu 

with three options: 
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This option… does this… 

Lock entire 
console 

the password is required to use any console functions or 
controls.  

Disable all 
editing 

the password is required to edit cuelists, groups, presets and 
all other show components  

Lock current 
show 

the password is required to save changes to the show file 

 

2. Select an option from the popup menu. Vista displays the Password 
window: 

 

3. Enter your password in both  boxes and click ‘OK’ 

 Your show or console is now password protected.
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3. Using the interface  
The latest version of Vista features a new simpler layout. No matter whether you 
have worked with Vista before or are seeing it for the first time it’s worth taking 
some time to get familiar with the new window layout and options.  

Menu bar 
At the top of the window you’ll see the main menu bar. Click on any menu 
heading to access Vista’s dialog boxes, submenus and commands. 
The main menu bar also shows: 

• the show file name - if Autosave is turned on you’ll see 
‘[A]’ after the show name 

• the Grand Master level setting 

• the time. 

Main toolbar 
At the top of the window you’ll see the main toolbar which is common to ALL 
windows. This toolbar contain the most frequently used buttons and is divided 
into three sections. The centre section contains 12 buttons that map to the 
Function buttons on Vista consoles and the ‘F’ keys on your keyboard you can be 
customized to suit your style of operation. 

Window navigation 
You switch between the main windows using the 6 buttons on the top left side of 
the main toolbar. You can also switch between windows by selecting the Patch, 
Console, Fixture Chooser, Timeline, Playback or Output option from the View 
menu. 

 

Hovering over the icons shows the button name.  

This button… does this… 

  (Alt + 1) displays the Patch window  

  (Alt + 2) displays the Console hardware simulation window 
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This button… does this… 

  (Alt + 3) displays the Programmer Fixtures window 

  (Alt + 4) displays the Programmer Timeline view.  

  (Alt + 5) displays the Playback control window  

  (Alt + 6) displays the fixture Output window 

V1 classic style window navigation 
If you prefer to select windows from the bottom of the screen you can open a 
toolbar that emulates the earlier versions of Vista. To do this select the ‘Vista 
Toolbar’ option from the View menu.  

Vista places the toolbar at the bottom of the window: 

 

Click on the buttons to select the Patch, Console, Fixture Chooser, Timeline, 
Playback or Output window. 

The Soft buttons 
The twelve buttons in the centre of the main toolbar provide quick access to 
frequently used commands, functions and windows. 

• If you are using a T series console these buttons are 
automatically mapped to the function buttons, above the 
LCD / tablet. 

• If you are using an I or S series unit the first 6 (5 on the S3) 
buttons are automatically mapped to the function buttons 
in the top centre section of the control surface. 

• For all Vista systems you can use your keyboard F1-F12 
buttons to activate these buttons. 

 

You can display text labels, for the function buttons, at the top of your tablet 
or monitor. To do this select the ‘Softkey Toolbar’ option from the View 
menu. 
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Standard buttons 
When you first start a new show Vista loads the standard set of buttons but you 
can customize each and every button, as described below. 

This button… does this… 

 
Saves the show file to disk 

 
Opens a new Cuelist in the Editor 

 
Opens an existing Cuelist in the Editor  

 
HiLite 

Turns on the Editor’s ‘Highlight’ mode. When you are focusing 
or testing your fixtures you can use Highlight  to bring up the 
intensity of each fixture automatically when you select it in the 
Fixture Chooser.  

 
Store Part 

displays the Store Part window where you can save the 
contents of the editor to any cue in any cuelist. Store part 
provides many options and must be used for tracking to 
operate correctly.  See Store Part on page xxx 

 
Store All 

displays the Store Look window where you can save the 
complete output (the look on stage). Storing this way will 
ensure that when you play a Cue back it will appear exactly as 
it did when you saved it 

 
Clear 

Clear all information coming from the Live tab. 

If a Cuelist tab is selected this button closes that tab.  

 
Update 

displays the Update window where information coming from 
the Editor (the Live tab or any Cuelist tab) can be used to 
update one or more Cues and Presets. 

 
Blind 

Turns the output from the editor off. In this mode you can still 
edit cues but there will be no output sent from the editor to 
your fixtures. 

 
Live 

displays the Live time window where you can set a fade time 
that applies to  any selections you make from the editor 
palettes or presets.  

 
FX 

displays the SmartFX window where you can create and edit 
effects. See SmartFX  on page 7-1
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This button… does this… 

 
Release All 

Clicking this button releases all the fixtures from their current 
settings as determined by the cuelists that are running and 
returns them to their default state. 

Modified soft buttons 
The soft buttons provide different functions when you press the Red (Shift), 
Green (Alt), Yellow (Control) or Blue (Control+Alt) modifier. 

Shift set (Red modifier) 
Hold down the Red modifier button or the Shift button, on your keyboard, to 
access and display the Shift set. 

 
 

This button… does this… 

 
Next Fixture 

Used to step through fixtures, selects the 1st fixture (or the one 
after the current selection) and de-selects the others. Each 
subsequent press selects the next fixture. Useful when focusing 
fixtures.  

 
Previous 
Fixture 

Used to step through fixtures, selects the last fixture (or the one 
before the current selection) and de-selects the others. Each 
subsequent press selects the previous fixture. Useful when 
focusing fixtures.  

 
Invert 

Inverts the fixture selection (i.e. all selected fixtures are de-
selected and all de-selected fixtures are selected). 

 
Active 

Selects all the active fixtures (i.e. those that have Intensity). 

 
Programmed 

Select all the fixtures that are programmed in the current cue. 

 
All 

Selects every fixture. 
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This button… does this… 

 
De-select all 

De-selects all fixtures 

 
Previous 
selection 

Vista remembers the last set of fixtures you selected; you use this 
button to toggle back to your previous fixture selection. 

 
Next selection 

If you have used the previous selection command this button 
will toggle back to the fixture selection you had before pressing 
previous selection. 

 
Strike 

Ignites the lamps in the selected fixtures 

 
Douse 

Switches off the lamps in the selected fixtures off. 

 
Reset 

Resets the selected fixtures to their factory default settings. This 
is useful if a fixture has a control problem and you need to get it 
‘back to normal’.  

Alt set (Green Modifier) 
Hold down the Green modifier button or the Alt (Option) button, on your 
keyboard, to access and display the Atlt (Option) set. 

 
 

This button… does this… 

 
Open Cuelist 

Opens a new Cuelist in the Editor 

 
New cuelist 

Opens an existing Cuelist in the Editor  
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This button… does this… 

 
Append cue 

Adds a new cue at the end of the cuelist being edited 

 
Insert before 

Inserts a new cue, before the cue that is being edited 

 
Insert after 

Adds a new cue after the cue that is being edited. 

 
Delete Cue 

Deletes the selected cue 

 
New Preset 

Displays the Create Preset window 

 
New Extract 

Displays the Create Extract window 

 
New Snapshot 

Displays the Create Snapshot window 

 
New Group 

Displays the Create Fixture Group window 

 
Update Group 

Updates the selected group to include any additional fixtures 
that have been selected. 

 
New Matrix 

Creates a new fixture matrix container in the Fixture Chooser 
window 
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Ctrl set (Yellow Modifier) 
Hold down the Yellow modifier button or the Control button, on your keyboard, 
to access and display the Control set. 

 
 

This button… does this… 

Live properties Opens a Live tab properties window. 

Cuelist 
properties 

Opens the Cuelist properties window. 

Insert 
Command 

Opens the Insert Command window where you can add a 
command to the cue you are editing (i.e. to play another cue) 

Convert to 
release events 

Sets the selected events to release the feature. 

Merge Cues Merges the events in2 or more selected cues into a single cue. 
Select the cues in the Cue navigator bar. 

Show tracked 
events 

Shows or hides tracked events in the time line. Tracked events 
are shown in a lighter, transparent colour and cannot be selected. 

Clear Fixtures Clears all features from the selected fixtures so that they return 
to their previous state. 

Home Fixtures Sends the selected fixtures to their Home settings 

Block cue Blocking copies any tracked events into the selected cue and 
prevents any future changes, to earlier cues from tracking 
through. This means that no matter what changes are made to 
other cues in the list, the cue will play back the exact look it had 
at the time it was blocked. 

See Blocking a cue on page 6-18

Super - Block 
cue 

If you ‘Super Block’ a cue, when it runs any features, for the 
fixtures in the cue, that aren’t included in the cue are 
automatically sent to their home value. This means that the cue 
will look as it would if no other cuelist was playing. 

Un-Block cue Removes redundant events, from the selected cue. This means 
that if the selected cue includes an event that is the exactly the 
same as an event that is tracking through from a previous cue, 
that event will be removed. Unblocking will not change the cue’s 
look. 
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This button… does this… 

Move in Black Opens the Move in Black window where you can Mark a cue 
and add MIB events that pre-set the selected fixtures so that 
when they turn on you don’t see them moving, changing colour 
etc. 

Ctrl + Alt set (Blue Modifier) 
Hold down the Blue modifier button or the Control & Alt  buttons, on your 
keyboard, to access and display the Control-Alt set. 

 
 

This button… does this… 

Show selection 
order 

Shows selection order numbers on the fixture icons. 

Show Tracked 
Events 

Shows timeline events for tracked fetures. 

Cue Only 
Editing 

 

Not used  

Not used  

Set Event 
Timing 

Opens the event timing window. 

Align Start Aligns the start position of the selected events. 

Align End Aligns the end position of the selected events. 

Not used  

Not used  

Stop FX Stops all running effects. 

Not used  
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Configuring the soft buttons 
To change the function of a soft button, right click on the button and choose a 
command or function from the popup menu. Any command from any menu can 
be assigned to the soft button. To change one of the alternate sets hold the Shift, 
Alt or Ctrl key while right clicking. 

Soft key toolbar 
The soft buttons correspond to the hardware buttons above the main screen on L 
and T series consoles. To make it easier to identify the buttons you can add on-
screen labels below the buttons. To do this select the ‘Softkey Toolbar’ option 
from the View menu.  

Vista places the softkey labels toolbar at the top of the window: 

 

The Sidebar 
To show or hide the sidebar click on the ‘Sidebar’ button at the top right side of 
the main menu bar: 

 

The sidebar provides access to different features, depending on the window you 
have open: 

• In the Patch window you use the sidebar to select fixtures 
from the library, and configure them. 

• In the Console window you use the sidebar to select 
components (i.e. Cuelists, Groups, Presets and more) and 
assign them to the Playback sets. You can also assign fader 
and button functions to the playback controls. 

• In the Fixture Chooser and Timeline the sidebar contains 
the palettes (i.e. Intensity, Position, Colour, Gobo, Beam) 
and component panels (i.e. Groups, Presets, Extracts, 
Effects and more) 

• There is no sidebar in the Playback Control and Output 
windows. 

Configuring the sidebar 
If you prefer the Sidebar can be moved to the left side of all windows. To do this 
select the Sidebar, ‘Dock Left’ option from the View menu. 
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You can adjust the width of the sidebar by clicking on the window divider and 
dragging to the left or right. 

 

Toolbars 
Most windows have optional toolbars that provide buttons for sets of menu 
commands. To show or hide any of the optional toolbars select the ‘Toolbars’ 
option from the view menu.  

Patch window toolbars 
There are three toolbars available on the Patch window 

View toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This button… does this… 

Table view Switches the main panel of the Patch window to the standard 
Table view. 

List view Switches the main panel of the Patch window to the List view 
where the patched fixtures are shown as a list. 

DMX view Switches the main panel of the Patch window to the DMX view 
where the output of each channel of each fixtures is shown, on 
the patch table. 

Fixture Macro toolbar (also available on the Chooser & Timeline window 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 
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This button… does this… 

 
Strike  Ignites the lamps in the selected fixtures.  

 
Douse Switches off the lamps in the selected fixtures off. 

 
Reset 

Resets the selected fixtures to their factory default settings. 
This is useful if a fixture has a control problem and you need 
to get it ‘back to normal’.  

Connections toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This button… does this… 

Connect Open the DMX Connections window where you can connect 
your console’s DMX outputs and any external Ethernet-DMX 
interface boxes to the patch universes. 

 

Chooser & Timeline window toolbars 
There are nine toolbars available on the Editor windows 

Update toolbar 
All the buttons, on this toolbar, are available on the standard soft button set. 
However if you have re-configured the soft buttons this toolbar may be useful: 

 

This button… does this… 

 
Opens a new Cuelist in the Editor 

 
Opens an existing Cuelist in the Editor  

 
Store Part 

displays the Store Part window where you can save the 
contents of the editor to any cue in any cuelist. Store part 
provides many options and must be used for tracking to 
operate correctly.  See Store Part on page xxx 
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This button… does this… 

 
Store Look 

displays the Store Look window where you can save the 
complete output (the look on stage). Storing this way will 
ensure that when you play a Cue back it will appear exactly as 
it did when you saved it 

 
Clear 

Clear all information coming from the Live tab. 

If a Cuelist tab is selected this button closes that tab.  

 
Update 

displays the Update window where information coming from 
the Editor (the Live tab or any Cuelist tab) can be used to 
update one or more Cues and Presets. 

 
Blind 

Turns the output from the editor off. In this mode you can still 
edit cues but there will be no output sent from the editor to 
your fixtures. 

 
Live 

displays the Live time window where you can set a fade time 
that applies to  any selections you make from the editor 
palettes or presets.  

Edit  toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This icon… does this… 

 Ctrl X 
Cuts the selected item. 

 Ctrl C 
Copies the selected item 

 Ctrl V 
Pastes the selected item. 

Undo toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This icon… does this… 
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This icon… does this… 

 Ctrl+Z Undo the last action 

 Ctrl+Y Redo the last action 

Fixture selection toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 
 

This icon… does this… 

 
Previous selection 

Vista remembers the last set of fixtures you selected; 
you use this button to toggle back to your previous 
fixture selection. 

 
Next selection 

If you have used the previous selection command this 
button will toggle back to the fixture selection you had 
before pressing previous selection. 

 
Previous Fixture 

Used to step through fixtures, selects the last fixture (or 
the one before the current selection) and de-selects the 
others. Each subsequent press selects the previous 
fixture. Useful when focusing fixtures.  

 
Next Fixture 

Used to step through fixtures, selects the 1st fixture (or 
the one after the current selection) and de-selects the 
others. Each subsequent press selects the next fixture. 
Useful when focusing fixtures.  

De-select all De-selects all fixtures 

 
Invert 

Inverts the fixture selection (i.e. all selected fixtures are 
de-selected and all de-selected fixtures are selected). 

 All 
Selects every fixture. 

 
Active 

Selects all the active fixtures (i.e. those that have 
Intensity). 
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This icon… does this… 

 
Programmed 

Select all the fixtures that are programmed in the 
current cue. 

Command Line toolbar 
See Using a keypad in the programmer windowon Page 5-51

Fan toolbar 
The fan toolbar is used to set how Feature values and Event times are spread. 

 

This option… does this… 

 Linear Fan 

Diverged from centre.  

Fanned values radiate in both positive and negative 
directions from the base value, starting from the centre 
of the fixture selection 

 Fan from end 

Linear from Start 

The fanned feature values radiate in one direction from 
the base value, starting from the first selected fixture. 

 Fan from start 

Linear from End 

The fanned feature values radiate in one direction from 
the base value, starting from the last selected fixture. 

 Fan from centre. 

Linear from Extremities 

The fanned feature values radiate in one direction from 
the base value, starting from the first and last selected 
fixtures. 

 Inverted fan 

Diverged from 
extremities 

The fanned values radiate in both positive and negative 
directions from the base value, starting from the first 
and last selected fixture. 

 Fan from both ends 

Linear from Centre 

The fanned feature values radiate in one direction from 
the base value, starting from the centre of the fixture 
selection. 

 

To fan a feature or events, select the fan mode and hold the Yellow modifier 
or Control key while setting the feature value or dragging the event bars. 
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Components toolbar 
The components toolbar includes buttons to create new Presets, Groups and 
Extracts 

 

This option… does this… 

 Preset Opens the create New Preset window. 

 Group Opens the create New Group window. 

 Extract Opens the create New Extract window. 
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4. Patching your rig 
Once you’ve got your Vista system connected and powered up you can patch 
your fixtures the way you want them using the Patch window. 

If it’s not already open click on the Patch icon or select the ‘Patch’ option from the 
Window menu, Vista displays the Patch screen: 

 

This is where you set up all the fixtures in your rig. You tell the Vista which DMX 
channels each fixture is assigned to, and in which universe, and can set a range of 
parameters to customise how each fixture operates. 

Adding fixtures to the patch 
The Fixture Type box in the sidebar gives you a few ways to add fixtures to the 
patch. You can: 

• choose a fixture from the ‘Factory’ folder, which lists the 
most up to date fixtures in the Vista library by 
manufacturer and then in alphabetical order. 

• choose a fixture from the ‘User’ list, which includes all 
fixtures that you have created. 

• choose a fixture by first typing in the ‘Search’ box to filter 
the list down to just those fixtures that match what you’ve 
typed. 
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Choosing a fixture from the Factory list 
To add a fixture from the Factory list: 
1.  Click the ‘+’ symbol beside ‘Factory’ in the Fixture Type box. Vista displays 

a list of manufacturer’s folders. 

2. Click the ‘+’ symbol beside the name of the manufacturer you want, to 
display the list of fixtures in that folder. 

3. Scroll down the list until you find the fixture you want. 

Adding the fixture to the patch panel 
Once you’ve selected the fixture you want, there are two ways to add it to the 
patch panel: 

• you can drag and drop one or more fixtures onto a specific 
DMX location on the panel, or 

• you can use the Patch tab to place multiple copes of the 
fixture onto the patch panel. 

Dragging and dropping individual fixtures 
To patch fixtures this way, just click on the name of the fixture in the Fixture type 
box, type a number in the ‘Quantity’ box and drag the fixture(s) over to the spot 
on the patch panel where you want it.  

When you ‘drop’ the fixture, Vista fills the required number of DMX channels 
with that fixture’s details. This example shows 8 Vari*lite VL2500 spot fixtures 
that use 22 DMX channels each, dropped onto channel 1: 

 

Once you’ve dropped a fixture onto the patch panel you can move it around to 
any channel by clicking on it and dragging it to a new location.  

Vista represents the fixture as a solid coloured bar with an ID number before the 
name. The bar covers as many DMX channels as the fixture needs, and some 
fixtures will take up more channels than others.  

A solid colour shows that this fixture is currently selected. If you click anywhere 
else in the patch panel, Vista de-selects the fixture and makes the colour 
transparent to show that it’s no longer selected. 
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In our example above the selected fixture is called ‘2 VL2500Sp’. This title 
consists of two components: 

• a unique ID number [2], that Vista assigns automatically. 
This number identifies the fixture uniquely within the 
whole system, across all the universes (i.e. no two fixtures 
will ever have the same unique ID number). 

• a name (VL2500Sp)), which you can change if you want in 
the Name field on the Properties tab.  

Patching multiple fixtures with the Patch box 
If you prefer using the keyboard to patch your fixtures you can use the Patch tab 
in the sidebar. 

You use this feature to add multiple instances of a fixture at once. To do this: 
1. Select the fixture you want from the ‘Factory’ or ‘User’ lists in the Fixture 

Type box. 

2. In the Quantity field, enter how many of this type of fixture you want to add. 

3. If not already selected, click the Patch tab to display the Patch box: 

 

4. If you want to give the fixture a different name, type it in the Name field. 

5. If you want to assign a specific set of unique ID numbers to this group of 
fixtures, click in the Fixture Number from field and set the unique ID 
number (e.g. <44>) you want for the first fixture in the group. If you don’t set 
this, Vista assigns the next valid number. 

6. Type a number in the ‘Multi Patch’ box if you want multiple copies to be 
patched as one fixture. Use this option, for example, when patching multiple 
dimmers as a single fixture. 
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7. In the DMX Universe field, Vista automatically displays the number of the 
currently selected universe. If you want to add these fixtures to another 
universe, enter the universe number.  

8. In the DMX address field, set the number of the DMX channel where you 
want this group of fixtures to start. If you’ve already added any fixtures to 
this universe, Vista displays the next channel number in sequence. 

9. If you prefer, you can patch fixtures to an ‘absolute address’ For example 
typing 513 in the Absolute address field, automatically sets the Universe to 2 
and the DMX number to 1. If you’ve already added any fixtures to this 
universe, Vista displays the next channel number in sequence.  

10. In the Spacing field, Vista displays the number of channels each instance of 
the fixture you’ve selected will take up. If you want to leave empty channels 
between each fixture you can increase this number. For example, if a fixture 
normally uses twelve channels and you increase this number to 14, Vista 
leaves a gap of two channels between each fixture in the group. 

11. When you’ve set all the fields the way you want them, click the Patch button. 
Vista adds the group of fixtures to the patch panel.  

If you’ve already added a bunch of fixtures between say, channel 10 and 
channel 50, and you add another batch starting at channel 1, Vista fits as 
many of them as it can into channels 1 to 9, then ‘flows’ the rest over to 
channel 51. 

 

  on 
ixtures and then tab 

through the Quantity and other fields. 

, 
iverse tab at the top of the patch panel to display the next set of 

DMX channels. 

 
n 

you drop them on the screen, Vista re-arranges them all from that channel. 

After you type in the search box you can use the ‘Down Arrow’ button
your keyboard to move the cursor into the list of f

Changing universes 
Each universe can only handle a certain number of fixtures, depending on the 
number of DMX channels each fixture needs. To add fixtures to another universe
click another Un

Re‐arranging fixtures on the patch panel 

Moving fixtures around the patch panel 
Once you’ve added fixtures to the panel you can re-arrange them however you
want. Just select the fixtures you want and drag them to a new channel; whe
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Note that you can’t place them in such a way that any of the channels will ‘fall 
off’ the end of the universe.  

Renaming fixtures 
To rename one or more fixtures select them in the universe panel and choose the 
Properties tab in the sidebar: 

 

Enter the name you want to give the selected fixtures in the ‘Name’ field and hit 
Enter. Vista renames all the fixtures you had selected. 

Renumbering fixtures 
To change the unique system-wide ID number (e.g. <12>) of a fixture (it is not 
possible to renumber more than one fixture at a time): 
1. Select the fixture in the universe panel. 

2. Choose the Properties tab in the sidebar. 

3. In the ID field, enter the new ID number and hit Enter on your keyboard.  

Deleting fixtures 
You can delete fixtures from the patch panel at any time To do this: 

1. Select the fixture in the universe panel. 

2. Select the ‘Delete fixtures’ option from the Patch menu or right click on the 
fixture(s) you want to delete and select ‘delete’ from the popup menu. 

Setting fixture properties 
Once you’ve added the fixtures to the patch panel and placed them where you 
want them, you can set a number of properties for each fixture using the 
Properties and Transforms tabs in the sidebar. 
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To view and set the properties for one or more fixtures, use the pen to select the 
fixtures you want on the patch panel. Vista displays the details of those fixtures 
in the Properties and Transforms tabs: 

 

If you select multiple types of fixture, Vista displays the details of the first 
type you selected. If the Patch box is currently displayed, press the 
Properties tab to display the Properties box. 

 

Properties tab 

Name The name you entered or Vista assigned to this fixture when you 
dropped it onto to the patch panel. You can edit this here if you 
want to. 

ID The unique system-wide ID number assigned to this fixture 
when you dropped it onto the patch panel. You can change this 
number here if you want to, but note that Vista won’t allow you 
to use a number that’s already assigned to another fixture. 

Type This field is not editable. To change the type of fixture without 
having to remove it click on the ‘Change Fixture Type’ button 
(see Swapping a fixture type). 

Notes This field is used to display notes about the fixture. You can add 
whatever you like in this field. 

Transforms tab 

Preheat A percentage value that sets the voltage the fixture lamp will sit 
at until you switch it on. This is useful for lamps such as Par 64s 
that take time to switch on from a cold start.  

Limit A percentage value that determines the maximum intensity the 
fixture will ever reach. This is useful if you want to prolong 
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lamp life or prevent fixtures from ever reaching full intensity.  

Dimmer 
Curve ons; 

nverse 

This popup lets you select a dimmer fade curve. The default 
option is Linear but you can select one of the available opti
Linear, Damp, Snap Start, Snap end,  Square Law, I
Square, Switch, Hot power, Flourescent and Sinus 

Preview in  the chooser, to Check this box if you’d like the fixture icons, in
Chooser display the effects of the Intensity transforms. 

Invert pan is 
e sweep 

Selecting this checkbox reverses the sweep of the pan for th
fixture. This is useful when you’re coordinating th
directions of fixtures hung in different directions. 

Invert tilt  
e sweep 

Selecting this checkbox reverses the sweep of the tilt for this
fixture. This is useful when you’re coordinating th
directions of fixtures hung in different directions. 

Swap 
pan/tilt is 

 the movements of fixtures hung on 

Selecting this checkbox swaps the pan and tilt controls, so the 
fixture will pan when given a tilt command and vice-versa. Th
is useful for coordinating
vertical trusses or pipes. 

Preview  the chooser, to 
display the effects of the Position transforms. 
Check this box if you’d like the fixture icons, in

Advanced transforms 
The advanced button provides access to more Fixture ‘Transformers’ that allow 
you to further customize fixtures. For example the Pan and Tilt Offset parameters 

en the transform window 

allow you to correct the home position for fixtures that are hung at an angle. 

To add a transform click the Advanced button to op
then click the Add button to choose a transformer. 
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S sformers a ble from the Properties tab as described 
a  one of th ansformers click on Pan offset or Tilt 
O

This option… 

ome of the tran
bove. To choose

re also availa
e advanced tr

ffset. 

does this… 

Minimum Sets the minimum (percentage) value for this f
For example setting a value of -25 on Pan means th
fixtures will only pan left ¾ of their normal ran

eature. 
e 

ge 

Maximum Sets the maximum (percentage) value for this 

ange 

feature. For example setting a value of -25 on Pan 
means the fixtures will only pan left ¾ of their 
normal r

Offset Sets the offset angle. For example setting a Pan offset
of 45 would move the fixtures Home position 
degrees 

 
by 45 

Value Curve e curve. The default 
option is Linear but you can select one of the 

vailable options; Linear, Damp, Snap Start, Snap 
nd,  Square Law, Inverse Square, Switch, Hot 
ower, Flourescent and Sinus 

This popup lets you select a fad

a
e
p

Invert  

 

Preview in Chooser Check this option to see the effect of the transform 
shown on the fixture chooser icons. 

Channels tab 
This is a list of the features and channel numbers of the fixture and which DMX 
channel is controlling each feature. 

nt types 
e table, List or DMX 

ee corresponding buttons: in 
the toolbar. 

 

Viewing the patch in different ways 
Vista gives you three different views of your patch so you can get differe
of information about the patch. To change the view, select th
option from the View menu or click one of the thr
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Table view 
The Patch screen defaults to the Table view, as shown earlier in this section. This 
is the view you will use most of the time: here you can drag and drop fixtures 
into the patch panel for each universe and arrange them the way you want them. 

List view 
If you choose the List option Vista displays the fixtures as a list with columns for 
the fixture: 

 

You can choose the columns you want to show or hide by right-clicking in the 
header row and choosing the fields you want from the popup menu. You can 
also re-arrange the columns by clicking on the column name and dragging it to 
the left or right. The default column arrangement is: 

Fixture Label (as shown in the chooser window), 
ID number 
Name 
Fixture type 
Patch part – for fixtures which re patched in 2 or more parts. For example some 
fixtures have a Intensity (Dimmer) part that is patched separately  
DMX Universe 
DMX Address 

If you click on any of the column headings the list will sort by that column. Click 
again to change the sort from ascending to descending or vice versa. 

DMX view 
If you choose the DMX option Vista displays a table view where each cell shows 
the DMX channel and its output level: 
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You use this screen to display the output values of each and every DMX channel. 
Each cell displays the channel number and it’s DMX output value. The cells are 
clear if there is no output and change to a highlighted box if the output is 
adjusted. To display another output simply click on one of the other Universe 
tabs at the top of the display. 

Controlling the fixtures 
The Patch menu includes commands to control whatever fixtures are currently 
selected on the Patch panel there are also buttons for three of these commands:  

 

Note that only some fixture types support these functions; refer to the user guide 
for your fixture types.  

This command… does this… 

 
Strike  Ignites the lamps in the selected fixtures.  

 
Douse Switches off the lamps in the selected fixtures off. 

 
Reset 

Resets the selected fixtures to their factory default 
settings. This is useful if a fixture has a control problem 
and you need to get it ‘back to normal’.  

 Park 

Holds the fixture in it’s current settings.  

For example to provide fixed lighting for backstage.. Once 
you’ve parked a fixture it will ignore all instructions until 
it is un-parked. 

 Unpark Sets a parked fixture to operate normally. 

 

These five commands are available through the Fixture menu and by right-
clicking on the fixture icons in the Programmer or Patch window. 

 

Cloning fixtures 
Cloning is a special way to add fixtures to your patch. This method is useful if 
you’ve already programmed your show and want to include some new fixtures 
automatically in any Clips, Groups and Presets that you’ve created. 

To clone one or more fixtures: 
1. Select the fixture(s) you want to clone from the Patch table or list view. 
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2. Select the ‘Clone Fixtures’ option from the Patch menu or right-click on the 
patched fixture and select Clone from the popup menu. Vista creates a clone 
of the selected fixture(s) in the fixture pool at the bottom of the Patch 
window 

3. Drag the cloned fixture(s) into the patch table. 

You can change the fixture type of the cloned fixture(s) by selecting the 
‘Change Fixture Type’ option from the Patch menu, 

 

Exporting and importing patch information 
To save time, you can import and export patch information from comma-
separated value (.csv) files. 

Exporting the patch 
You can also export a .csv file containing your  current show’s patch information. 
To do this: 

1. Select the ‘Export Patch file…’ option from the Patch menu. Vista opens the 
Export Patch window 

2. Give the file a name. The .csv extension is automatically appended. 

3. Navigate to the directory or folder whee you want to save the file. 

4. Click the Save button to confirm and the new fixtures are added to the patch. 

Importing the patch 
You can also import a .csv file containing your patch information. You can 
import a file that you have exported from another show or you can create a file in 
a text editor or spreadsheet program. The easiest way to do this is to create a 
spreadsheet laid out as follows and save it as a .csv file using the Save as 
function. 

ID Univ:Adrs Fixture Type Fixture Name 

1  3:2  Dimmer  Dimmer 

36  3:24  Dimmer  Dimmer 

41  3:75+3:34  copy_of_Scroller Dimmer  Scrl Dim 

42  3:76+3:35  copy_of_Scroller Dimmer  Scrl Dim 

101  1:1  Mac 2000 Wash (Colour Wheel) 16 bit  Mc2000Wc 

102  1:22  Mac 2000 Wash (Colour Wheel) 16 bit  Mc2000Wc 

201  2:1  ColorSpot 700E AT Mode 1  CSp700a1 

202  2:37  ColorSpot 700E AT Mode 1  CSp700a1 

301  1:221  VL2000 Spot Enhanced 16 bit  V2000Se6 
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302  1:241  VL2000 Spot Enhanced 16 bit  V2000Se6 

316  5:1  Color Block 2 Mode 3  ColBk2m3 

317  5:17  Color Block 2 Mode 3  ColBk2m3 

432  9:1  MediaMaster Layer Full 1.0  MeMaLF10 

433  9:44  MediaMaster Layer Full 1.0  MeMaLF10 

437  12:22  VL3000 Spot  VL3000Sp 

438  12:50  VL3000 Spot  VL3000Sp 
 
In this example the spreadsheet has a header row, which is optional, but shown 
here for explanation. The columns are laid out like this: 

• an ID (1), which determines the fixture’s unique ID  

• a Universe : DMX address number (1:1), that sets the 
Universe and DMX start address for this fixture 

• a Fixture Type (<VL3000 Spot>), that sets the type of 
fixture that will be patched 

• a Fixture Name (<VL3000Sp >), that sets the fixture name. 
For two-part fixtures (i.e. fixtures with an external dimmer that is patched 
separately) you need to include both parts of the patch included in the 
Universe/Address column. The format for the two parts is Control+Intensity. 

In the example above, Fixture ID 41 is a Scroller Dimmer with the scroller part 
patched to Universe 3 Channel 75 and the Intensity part patched to Universe 3 
channel 34. 

The ID, Universe:DMX Address information and Fixture Type must be in the .csv 
file. If you don’t specify a valid Vista Fixture Type, Vista prompts you to choose 
the correct fixture from a list when you import the file. The fixture Name does 
not need to match the name used in the Vista library. 
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Configuring the DMX & Ethernet Outputs 
V2 Vista does not automatically connect Universes to the DMX outputs on your 
console or to external Artnet devices. To make these connections you click the 
Connect button on the toolbar to open the DMX Connections screen: 

 

You use this screen to connect to Vista’s DMX outputs, to external Ethernet-DMX 
interface boxes and to broadcast Art-net.  

Vista consoles provide up to four 512-channel DMX outputs. You can add up to 
twelve more outputs by connecting your own external ArtNet or PathPort 
devices to the Ethernet port. You can also add DMX outputs to a console or 
computer using the Vista USB-DMX cable. 

To configure these connections, click the Universes button on the Patch screen 
toolbar or select the ‘Connect universes’ option from the Patch menu. 

This window shows any devices connected via Ethernet or USB to the console or 
PC , and the connection details of the universe. You use it to set up the DMX 
connections for each of your universes and to check that they are working 
correctly.  

You can also connect more than one output to the same Universe. For 
instance you can connect Universe 1 to DMX output 1 and to an Artnet 
broadcast device 
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Connecting Universes to the Console DMX & Ethernet 
Outputs 

The DMX connections window lists all the internal DMX connections, USB-DMX, 
Ethernet-DMX connection boxes and ArtNet compatible devices attached and 
visible to the Vista: 
In this example above you can see several entries: four are the T4 console’s 
inbuilt DMX connections ; the others are Ether-Lynx (Art-net) DMX outputs 
which are on an external interface boxes attached via Ethernet. You may also 
have Pathport devices and the Vista USB to DMX cable. 

If you can’t see a device that you’ve attached to the Vista it may still be 
possible to connect to it by using the ‘ArtNet Broadcasting’ mode. 

 

 e box you may have to disconnect it and 
re-connect it with the new settings. 

unication with the device. You can broadcast to up to four 

1. Find one of the Art-net Broadcast Device lines, there are four available. 

To connect a console or control surface DMX output: 
1. Find the row that corresponds to the DMX output . 

2. Click on the box in the ‘DMX Universe’ column and either type a Universe 
number or use the up and down arrow buttons to select the Universe you 
want. 

To connect an external interface box: 
1. Find the row that corresponds to the Interface box output. Some boxes will 

have multiple outputs. 

2. Click on the box in the ‘DMX Universe’ column and either type a Universe 
number or use the up and down arrow buttons to select the Universe you 
want. 

Disconnecting an output 
To disconnect a DMX output or interface box: 
3. Find the row that corresponds to the DMX output or interface box output. 

4. Click on the box in the ‘DMX Universe’ column and either type ‘0’ or use the 
down arrow buttons to select the ‘Not Assigned’ option. 

To change the settings of an interfac

ArtNet Broadcast Mode 
Some ArtNet-compatible devices may not appear in the DMX Connections 
window. In this case you can set Vista to broadcast ArtNet information without 
first establishing comm
universes. To do this: 

4‐14  Vista User Guide, Version 2 



Patching your rig  Configuring the DMX & Ethernet Outputs 
 

2. Click on the box in the ‘DMX Universe’ column and either type a Universe 
number or use the up and down arrow buttons to select the Universe you 
want. 
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5. The Chooser window 

The Chooser screen 
To get all your fixtures up and running you click the Chooser button on the 
toolbar at the top of the screen. If this is the first time you’ve opened this window 
you should be in the Live tab, otherwise click on the Live tab to make it active.  

Vista displays the Fixtures screen: 

 

This screen consists of four main elements: 
1. The Editor control section where you can select to work with the Live editor 

tab or any Cuelist you have open. If you have a Cuelist open this section 
expands to include the Cue navigation controls. 

2. The Fixture layout panel, where you can display and arrange the fixture 
icons to suit your requirements. 

3. The sidebar where you can use the palette and component panels to adjust 
Intensity, Position, Colour, Gobo, Beam and other settings for each fixture. 

4. The multi-quickpicker panel where you can select Presets, Groups and other 
components. This panel is optional and can be closed so that there is more 
room for the fixture layout panel. 
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Arranging fixtures in a layout 
Vista displays all of the fixtures you added on the Patch screen as icons on the 
Fixture layout panel. When you first view this screen, the fixtures are arranged in 
numerical order, by unique ID, as a bank of icons.  

To re-arrange the fixtures: 
1. Click on the ‘Locked’ button at the bottom of the Chooser window so that it 

changes to ‘Unlocked’. 

2. Drag and drop the fixture icons around to new locations on the screen so 
that they suit you. 

3. To undo a move press Ctrl + Z or select the undo option from the Edit menu. 

4. When you are finished Click on the ‘Unlocked’ button so that it changes back 
to ‘Locked’. 

If you are moving a Group icon, click and hold on it while moving to avoid 
selecting and moving the individual fixtures in the group. 

 

Zooming in and out 
You can adjust the magnification of the fixture layout panel or the size of 
individual fixture and group icons. 
To zoom the fixture layout panel in or out click on the magnify icons in the 
bottom left corner of the fixture chooser window: 

 
To zoom an individual fixture and group icon, hold down the yellow modifier 
button or Control key while licking the icons 

This icon… does this… 

 zooms in or increases the size of the fixture icons. 

 zooms out or decreases the size of the fixture icons. 

 zooms to the icons to the normal scale. 

 You can use the ‘Wheel’ on a suitable mouse to zoom the layout or icons. 

s you like, each 

5.  Layout’ option 
from the popup menu. Vista opens the New layout window. 

Using different layout views 
You can create as many different views of your fixtures a
arranged in its own away. To create a new layout view: 

Right-click in the fixture chooser window and select the ‘New
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6. Type a name for the layout and click OK. Vista creates a new layout and 
adds a corresponding  ‘tab’ at the bottom of the layout panel: 

 

7. Arrange the fixtures as described above. 

8. When you are finished Click on the ‘Unlocked’ button so that it changes back 
to ‘Locked’. 

To switch between layouts click on the tab you want to use. You can select 
fixtures on one tab, switch to another tab and add more fixtures to the selection. 

Managing layout views 
You can add, rename, duplicate or modify a layout view. To do this select the 
‘Manage Layouts’ option from the Chooser menu. Vista opens the Layouts  
window: 

 
The layout window is divided into three panels: 

Layouts 
The Layouts panel shows all the layouts you have created. You can: 

Vista User Guide, Version 2  5‐3 



Arranging fixtures in a layout  The Chooser window 

• Rename a layout by double-clicking on the name and 
typing a new one. 

• Change the order of the layout tabs by selecting a layout 
and moving it up or down the list using the Move Up, 
Move Down, Move to Top and Move to Bottom buttons 

• Add a new Layout by clicking on the Add Layout button 

• Delete a layout by selecting it and clicking on the Delete 
Layout button. 

This icon… does this… 

<< Moves the selected layout to the top. 

<< Moves the selected layout up. 

>> Moves the selected layout down. 

>> Moves the selected layout to the bottom. 

 + Adds a new Layout 

 -  Deletes the selected layout.. 

Layout properties 
The Layout properties panel let’s you configure how a layout displays names, 
IDs and other properties. To do this: 

9. Select the Layout you want to adjust in the Layouts panel: 

This option… does this… 

Lock positions Locks the layout so the fixtures cannot be moved. You 
can also lock and unlock a layout using the 
Locked/Unlocked button beside the layout tabs in the 
Fixture Chooser window 

Labels show  Names Sets the fixture icon text labels to show. 

Labels show IDs Sets the fixture icon ID numbers to show. 

Labels ignore zoom The label size remains fixed when the fixture icons are 
zoomed in or out. 

Notes ignore zoom The notes  size remains fixed when the fixture icons 
are zoomed in or out. 

Auto-show new 
fixtures 

Sets the layout to automatically include any new 
fixtures added in the Patch window. 
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This option… does this… 

Snap to Grid Locks or Unlocks the current layout. Fixture and 
Group icons can not be moved when a layout is 
locked. But they can be scaled. 

Show Gridlines Display a grid on the Fixture Chooser layout pane 

Grid Spacing Sets the space between the grid lines. The higher the 
number the larger the grid spacing. 

Save as Default Saves all options set in the current layout as defaults 
for any new layout. 

You can also adjust some of these settings on the ‘Layouts options’ menu  

 t-clicking on the 
icon(s) or note(s) and selecting Hide from the popup menu.. 

Hiding and ‘un‐hiding’ fixtures and groups 
You can use the Item Visibility panel to hide any fixtures, fixture types or groups 
in a layout. This removes them from the display, but not from the patch.  

To hide Fixture or Group icon or Notes: 
1. Select the Layout you want to work with from the list in the Layouts panel. 

2. Click the + symbol beside the Fixtures or Groups or Notes heading in the 
Item Visibility section to show all the Fixtures types that you’ve patched, the 
Groups that have been created and any Notes. 

3. To hide all Fixture icons of a type, un-tick the checkbox beside that fixture 
type, or click the + symbol beside a fixture type to show all the individual 
Fixtures of that type. 

4. To hide all Group, un-tick the checkbox beside ‘Groups’, or click the + 
symbol to show all the Groups that have been created. 

5. To hide all Notes, un-tick the checkbox beside ‘Notes’, or click the + symbol 
to show all the Notes that have been created. 

6. To hide individual Fixtures, Groups or Notes of a type un-tick the checkbox 
beside the items(s) you want to hide. 

To reveal (unhide) hidden fixtures, tick the checkbox beside the items you want 
to reveal. 

You can also hide fixture  and group icons and  notes by righ
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Layout options 
The Layout options submenu let’s you quickly configure some commonly used 

1.  by clicking on its tab at the bottom of 
hooser p

2 t option u: 

layout properties. To do this: 

 Select the Layout you want to adjust
the Fixture C anel. 

. Select ‘Layou s’ from the Chooser menu. Vista displays the submen

This option… does this… 

False Intensity ensity without sending any Gives the fixture icon int
level to the fixture(s) 

Fixed label size  no matter  the Keeps the fixture label size the same
zoom level of the icons. 

Show selection order ber Sets the icons to show a selection order num
whenever they are selected. 

Show grid Display a grid on the layout pane 

Snap to grid When on fixture icons snap to the grid cells 

Show names Sets the fixture icon text labels to show. 

Show IDs Sets the fixture icon ID numbers to show. 

Auto-add new 
fixtures Patch window. 

Sets the layout to automatically include any new 
fixtures added in the 

Preview refresh rate Sets the refresh rate for the icons. Higher refresh rates 
r large numbers of icons use more processing and / o

power. 

 

Activating layout views 
To activate a layout view, click on the tab for the layout you want to display: 

 

Duplicating a layout 
To duplicate a layout view, click on the tab for the layout you want to duplicate 
then select the Duplicate Layout option from the Chooser menu. Vista displays 

w. 
 

the Duplicate Layout windo
Type a name for the layout and click OK. Vista creates a copy layout and adds a
corresponding  ‘tab’ at the bottom of the layout panel. 
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L isatio
There are a number of ways to customise layouts and the way the fixture icons 
are displayed. To make a tion from the Chooser menu. 

does this… 

ayout organ n 

 change select an op

This option… 

Colours and 
Background 
(submenu) 

Opens a submenu 

- Background colour r of Opens a colour picker to set the background colou
the layout panel 

- Background image Opens a window to select an image to use as a 
background of the layout panel. An image size of 
about 700 x 560px will fill the layout pane 

- Erase Background 
image 

 Removes the background image, if you’ve added one.

- Resize Background Selects the background image which can be moved or 
resized by dragging on the bottom right hand corner. 
Click outside the background when finished. 

- Icon Colour Opens a window to set the outline colour of the 
selected icon(s)  

- Gel Colour Opens a window to set the intensity colour of the
selected icon(s). Useful for simulating the colour filter 

 

on a conventional fixture. 

- Set note colour Opens a window to set the colour of the selected 
note(s). Changes the leader and fill colour. 

Shrink to fit Zooms the layout panel to fit all fixtures.  

Label position Moves the icon label to the right, left, top or botto
the icon. 

m of 

Manage Layouts Opens the Manage Layouts window. 

Duplicate Layout Creates a copy of the current layout and opens a 
ow where it can be named. wind

Layouts options Opens the Layouts options window. 

L isatio

 You can also adjust the layout and icon appearance  by right-clicking on the 
layout or icon(s) or note(s) and selecting an option from the popup menu. 

ayout organ n 2 
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This option… does this… 

Manage Layouts Opens the Layouts window where you can add, 
delete, organise and customise your layouts. 

New layout Opens the New layout window. 

Duplicate layout Duplicates the current layout and opens a window to 
name it. 

Delete layout Immediately deletes the current layout. 

Rename layout Opens the Rename layout window where you can edit 
the name of the current layout. 

Rename Opens the Rename window where you can type a new 
name for the selected fixture(s) 

Renumber Opens the Renumber window where you can type a 
new name for the selected fixture(s) 

Delete item  

Hide items Hides the selected fixture or group icon or note. 

Unhide all items Reveals all hidden items, on the current layout. 

Resize items(s) Allow you to resize the selected matrix 

Rotate items Lets you rotate the fixture icon(s), using an onscreen 
handle, to any angle 

Label position Moves the icon label to the right, left, top or bottom of 
the icon. 

Add note Adds a text box to the layout panel. If a fixture icon is 
selected a leader line will be drawn between the icon 
and the text box. 

New Fixture Group Creates a new fixture group containing all the 
currently selected fixtures. 

Update Fixture 
Group 

Updates the current group to contain whatever 
fixtures are selected. 

Create Matrix Creates a new matrix grid that you can resize by 
dragging on the bottom right hand corner. 

Tip: Deselect all fixtures to enable this option. 

Resize Matrix Allow you to resize the selected matrix 
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This option… does this… 

Align Lets you align a group of fixture icons, to the right, 
left, top or bottom of the group. 

Distribute Lets you distribute a group of fixture icons vertically 
between the top and bottom fixtures or horizontally 
between the furthest left and furthest right fixture in 
the selection. 

Flip Swaps the vertical or horizontal position of a group of 
fixture icons. The left most fixture will move the right 
most and so on. 

Arrange in grid Opens the Grid window to arrange the selected items 
in a grid. Items can be arranged into rows and 
columns and sorted by ID or selection order 

Background colour Opens a colour picker to set the background colour of 
the layout panel 

Background image Opens a window to select an image to use as a 
background of the layout panel. An image size of 
about 700 x 560px will fill the layout pane 

Erase Background 
image 

Removes the background image, if you’ve added one. 

Resize Background Selects the background image which can be moved or 
resized by dragging on the bottom right hand corner. 
Click outside the background when finished. 

Icon Colour Opens a window to set the outline colour of the 
selected icon(s)  

Gel Colour Opens a window to set the intensity colour of the 
selected icon(s). Useful for simulating the colour filter 
on a conventional fixture. 

Set note colour Opens a window to set the colour of the selected 
note(s). Changes the leader and fill colour. 
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Adding notes to the layout window 
You can add text boxes to the fixture window to help identify different fixture 
types or areas. Notes can be either attached to an object on the layout, such as a 
fixture, or can be independent.  

 

To add a note you do this: 
1. To attach a note to a fixture or group, first select the item. For an 

independent note make sure no fixtures or groups are selected. 

2. Right-click in the fixture window and select ‘Add note’ from the popup 
menu. Vista creates a note on the layout. 

3. Type a note and then click on the layout background to finish. 

To move a note first unlock the layout then click on the text and drag it to a new 
location. To edit a note double click on the text and replace or change the text. To 
delete a note right-click on the note and select ‘Delete item’ from the popup 
menu. 

Arranging fixtures in a grid 
You can arrange fixtures in rows and columns. To do this: 
1. Select the fixtures you want to arrange into a grid 

2. Right-click in the fixture window and select ‘Arrange in grid…’ from the 
popup menu. Vista opens the Arrange in Grid window: 
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This option… does this… 

Rows Specify the number of rows you want in the grid. If you 
enter a value here the number of columns is calculated 
automatically. 

Columns Specify the number of columns you want in the grid. If 
you enter a value here the number of rows is calculated 
automatically. 

User ID Sort the fixtures by ID number 

Type / User ID Sort the fixtures by type name then ID number 

Selection Order Sort the fixtures into the order they have been selected 

 

3. Click the OK button to arrange the fixtures. 

Placing fixtures in a Matrix 
You can put fixtures in a special ‘Matrix’ container so that they can be controlled 
individually or as a whole. When fixtures are placed on a matrix you can: 

• Select the matrix and apply settings to all fixtures within it 

• Select fixtures, in the matrix and apply individual settings 
to just the ones you have selected 

• Apply matrix effects that run on the X and Y axis of the 
matrix. For example you can have an intensity effect that 
runs across the matrix like a sliding door or a colour effect 
that runs around the matrix like a clock hand. 

• Apply an animated gif Video effect. 

To create a matrix container and place fixtures in it: 
1. Right-click on the fixture layout panel and select the Create Matrix option 

from the popup menu. Vista creates a matrix container on the current layout: 
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2. Adjust the size of the matrix by clicking on the handle on the bottom right 
hand corner and dragging to the size you want. 

3. Drag your fixtures into the matrix. You can either drag them one by one or as 
a group. If you drag a group of fixtures onto the matrix Vista places them 
across and then down the matrix in ID order. 

 

Selecting fixtures 
The simplest way to select fixtures is to click on the fixture or group icons one by 
one but Vista provides three selection tools and several options to make more 
complex selections. 

Selection tools 
To select a number of fixtures you can draw a ‘marquee’ around (or over) the 
fixtures you want. Vista provides three marquee tools. 

To select the tool you want by click on one of the icons in the lower right corner 
of the fixture layout panel or choose one of the ‘Selection tool’ options from the 
Layouts menu: 

 

This icon… does this… 

 Draws a rectangular marquee as you click and drag 
across a group of fixtures. 

 Let’s you select fixtures by drawing a freehand shape 
around the ones you want. 

 Let’s you select fixtures by drawing a line through the 
ones you want. 
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Sorting fixtures 
It’s often important to sort fixtures in a certain order. For example when you are, 
storing groups, applying effects fanning parameters or copying and pasting 
information from one set of fixtures to another. 

Vista lets you show the selection order and quickly sort fixtures based on their 
ID, selection order, layout position and more. 

Displaying the selection order. 
To display the selection order, choose the ‘Show selection order’ option from the 
Options sub-menu on the Layout menu.  

Vista displays the selection order number in a small circle on the top left side of 
the fixture icon: 

 

Sorting fixtures 
You can sort fixtures in a number of ways. To do this, select the fixtures then 
click the Sort order dropdown on the main toolbar. Vista displays the Sort popup 
window: 

 

This option… sorts the fixtures in… 

Custom Sort An order you create in the Custom sort window. Custom sort 
includes several advanced options as described below. 

Selection the order in which you selected them on the Fixtures chooser 
layout. 

ID ID number order. 
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Random random order. Each time you de-select and re-select fixtures 
they are sorted into another random order. 

Position by columns and rows, from top left to bottom right, based on 
their position in the layout window. 

Manage Sorts This option opens the Manage Sorts window where you can 
customise and save sorts. 

Creating custom sort orders 
When you select the ‘Custom Sort’ option Vista displays the Custom Sort 
window: 

 

You can use this window to create a new sort that includes advanced options for 
grouping fixtures together, repeating applied settings and setting the type of fan 
shape that will be used when fanning a value across the selected fixtures. 

This option… does this… 

Sort Fixtures 
by.. 

sets the basic sort type. The options are as described above – 
ID, Selection Random or Position. 

Fan Shape Let’s you store a fan shape that will be recalled when a saved 
sort order is selected. See ‘Fan shapes’ on page xxx 

Curve sets the distribution of fixtures, along the fan shape. The 
normal setting is ‘Linear’and in this case the fixtures are 
evenly distributed. Other curves, such as square and inverse 
square will bunch some of the fixtures together and spread 
others out. 

Sort Direction Sets the sort order to ascending or descending. 

5‐14  Vista User Guide, Version 2 



The Chooser window  Arranging fixtures in a layout 
 

Fixture 
Ganging 

allow fixtures grouped together, so that if you spread or fan a 
feature setting across some fixtures, the settings can be in 
blocks and / or repeated throughout the selection. See the 
examples below. 

Blocking Let’s you group fixtures in  "blocks" of consecutive fixtures. 
You can set just one block size, for example 2 or set several 
different block sizes (e.g. first block has 4 fixtures, second 
block has 6 fixtures and so on). 

To set complex blocking separate the block sizes with a / 
(forward slash). For example 4/6 

Repeat 
Ganging 

Let’s you repeat feature settings on every 2nd, 3rd,  4th or any 
increment of fixtures. 

Save as… Opens the Custom Sort ‘Save as’ window where you can 
name and save your custom sort 

Selecting Odd and Even numbered fixtures 
You can select just the odd or even numbered fixtures from the fixtures you have 
selected  by setting “Sort fixtures by” to ID and  "repeat ganging" to 2 in the sort 
dialogue. Then, using the next and previous fixture buttons, you can toggle 
between controlling the odd and even fixtures.  

Custom Ganging examples 
In these examples, there are 10 colour mixing fixtures selected and colour is 
fanned across the fixtures using a Custom sort with the following Ganging 
(Blocking and Repeat) settings: 
1. Blocking set to 3, Repeats set to ‘0’ (No repeats) 

  

2. Blocking set to 3, Repeats set to ‘2’ 

  

3. Blocking set to 1/2/3, Repeats set to ‘0’ (No repeats) 

  

4. Blocking set to 2/3, Repeats set to 2 
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Custom Fan shapes 
In these examples, there are 10 fixtures selected and intensity is fanned across the 
fixtures using the following Fan shapes: 
1. Fan from Centre: 

  

2. Fan from both ends: 

  

Fan shapes 
The are several fan shapes that can be set and saved in a Custom sort. 

This option… does this… 

 Linear Fan 

Diverged from centre.  

Fanned values radiate in both positive and negative 
directions from the base value, starting from the 
centre of the fixture selection 

 Fan from end 

Linear from Start 

The fanned feature values radiate in one direction 
from the base value, starting from the first selected 
fixture. 

 Fan from start 

Linear from End 

The fanned feature values radiate in one direction 
from the base value, starting from the last selected 
fixture. 

 Fan from centre. 

Linear from Extremities 

The fanned feature values radiate in one direction 
from the base value, starting from the first and last 
selected fixtures. 

 Inverted fan 

Diverged from 
extremities 

The fanned values radiate in both positive and 
negative directions from the base value, starting 
from the first and last selected fixture. 

 Fan from both ends 

Linear from Centre 

The fanned feature values radiate in one direction 
from the base value, starting from the centre of the 
fixture selection. 
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To fan a feature or events, select the fan mode and hold the Yellow modifier 
or Control key while setting the feature value or dragging the event bars. 

 

 ption is replaced by the ‘Fan from Centre’ and 
‘Inverted Fan’ shapes. 

 
on from the Sort order drop down list. Vista opens the Manage Sorts 

The Vista V1 "Mirror" o

Managing your saved Sorts 
You can rename, duplicate or modify a saved sort. To do this select the ‘Manage
Sorts’ opti
window: 

 

 m ort you’ve saved, do this: 
1. Select the Sort name in the left hand panel. 

2. Modify the Fixture sort, Fan options and other settings. 

3. Click the ‘Save’ button. 

t by double clicking on the name, in the left column, and 
typing a new name. 

To make a copy of a sort, select it and click on the ‘Duplicate’ button. 

To delete a sort, select it and click on the ‘Delete’ button.  

To odify one of the built in sorts or a custom s

Renaming a Sort 
You can rename a sor

Duplicating a Sort 

Deleting a Sort 
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Using the Programmer Sidebar 
The Programmer Sidebar has two tabs: 

 

 to control all the main aspects of your  lighting 
lour gobo and beam.  

Extracts and Snapshots along with the in-built effects. 

e tab in the sidebar 

Summary  detailed  
You switch between the ‘All’ (or summary) view and the detailed views of the 
d ent control pa

The Palette tab includes panels
fixtures: intensity, position, co

The Components tab includes the items you store such as Groups, Presets, 

The Palette tab 
If it’s not already selected, click on the Palett

 or  view

iffer nels using the 7 buttons below the Palette tab. 

 

This button… does this… 

All displays a combined view of the most commonly used 
controls for Intensity, Position, Colour, Gobo and Beam 

 
displays a detailed view of the Intensity controls 

 
displays a detailed view of the Position controls 

 
displays a detailed view of the Colour controls 

displays a detailed view of the Gobo controls 
 

 
displays a detailed view of the Beam controls 

Custom displays controls for every feature of the selected fixture(s). 
o 

not appear on the other panels or to set chanels to values 
that are normally not used. 

These controls are mainly used to control features that d
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Common features of the palettes 
All palettes have a popup menu that you open by clicking the palette type 
button: 

  

Click on the drop down arrow  on any of the palette type button to open a 
popup menu 

This option… does this… 

Clear This option lets you clear all events for that parameter 
type or just some of those events. For example the 

 
individual CMY events 

Colour popup lets you clear the Colour wheel or Colour
Mix or just the 

 
Home 

This option lets you reset all events for that parameter 
type to their default setting (for example no intensity, 
50% pan and tilt, colour white etc). 

 
et Create Pres

This option opens the Preset window so you can create 
a new preset.  

  Clicking on this option opens the Create effect window 
where you can select an effect type, the features to 

New Effect include and enter a name for the effect. 

 

Stop effect 

This option lets stop effe
parameter type

cts that are running for that 
  

 

Many of the palettes h  
value: 

ave slider bars that provide a quick and easy way to set a

 

To adjust a slider setting, either: 

• click the arrows at the left or right hand end to go to 0% 
and 100% respectively 

ar to set the value you want 

. 

 use. 

• click and drag in the slider b

• click in the value box and type a value using the keyboard

To set attributes for one or more fixtures, select the fixtures you want in the 
Fixture Chooser panel, then click on the Palette you want to
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Checking that everything is working 
One of the first things you’ll probably want to do after setting up your rig and 
patching it all in on the Patch screen, is check that everything’s working. The 
quickest way to do this is to select the fixtures, one-by-one or in groups on the 

t colour up a bit.  

1.

2. ures in the Fixture panel.  

4. Click anywhere in the colour palette. 

hat colour at full intensity 

ur and 
any other parameter. 

 If you can’t s an is 
turned fully c ck
up. 

Highlight feature to 
bring up the intensity of each fixture automatically when you select it. 

Fix ure panel, and crank the intensity and 

To do this: 
 Select the ‘All’ view of the palettes. 

Select one or more fixt

3. Click the right-arrow icon at the end of the Intensity slider on the intensity 
palette. 

5. The selected fixtures show t

 You can also use the encoder wheels to set Intensity, Position, Colo

ee y output f  your fixtures check that the Grand Master 
lo wise and that the faders on the Superplayback panel are 

rom

Highlight and Lowlight 
When you are focusing or testing your fixtures you can use 

To do this, either: 

• Click the  Highlight button – normally softbutton #4 
(F4 on your keyboard or, 

• Select the Highlight option from the Tools menu (Ctrl+H). 

You can alter how highlight works by updating the highlight and lowlight 
e The Highlight and Lowlight presets on page 5-47. presets. Se
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Using the All panel 
The All panel has controls for all the most commonly used features of your 

t provides a quick easy way to set Intensity, Position, Colour, Gobo and 

s the most used intensity features : 

fixtures. I
Beam without swapping panels. The same controls plus any advanced ones are 
available on the individual feature panels. See page xxx 

Intensity  
In this view the Intensity panel show

 

In this view: 

• the 10 to 90 buttons sets the intensity of the selected 

ols the intensity of the selected 
fixtures in a percentile range. 

Position 
ives you control of the direction in which the selected 

fixtures to the corresponding percentage value 

• the Intensity slider contr

You’ll notice that as you change the intensity settings, the icons on the Fixture 
panel change to reflect this. 

The Position panel g
fixtures are aimed: 

 

, click on the round target symbTo adjust the position ol and drag it to the spot 
you want . 

You’ll notice that l icons 
change to reflect this. 

 as you change the position ‘compass’ on the Fixture pane
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Fine Mode 
Some parameters, such as position, can be difficult to control when the palette is 

ne’ button. Repeat this to turn 

you can choose the way you want to 

in normal mode. To switch to fine click on the ‘Fi
fine mode off. 

Setting colour 
The Colour palette provides four buttons so 
set your colours: 

 
• HSV – hue and saturation values 

• Sliders – Cyan, Magenta, Yellow or Red, Green, Blue or 
Hue, Saturation, Value sliders 

 name and number 

trum and a saturation slider: 

• Swatch – colours by Lee

• Colour wheel – for fixtures that have colour wheels. 

Hue and Saturation values 
The HSV tab provides a colour spec

 

To pick a hue and its saturation, just click on the shade you want in the spectrum 

een Blue 
ng your colour using either CMY or RGB or 

area, and drag the slider bar below the colour panel  to set the saturation level. 

Cyan, Magenta and Yellow/Red, Gr
This tab gives you the option of setti
HSV values: 

 

Click the relevant ‘slider mode’ button to choose the method you want, then 
adjust the sliders to set the colour. 
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Swatch 
This tab provides the actual gel colours, numbers and names from the Lee 
swatchbook so you can pick the exact colour you want: 

 

Click in the Colour, Number (#) or Name (N) button to sort the list by name 
number or colour. You can also search for a name or number by typing in the 
search box. 

Colour wheel 
When using fixtures with colour wheels, you can use this tab to select the colour 
slot (or position) you want this fixture to use: 

 

Fixtures that have more than one colour wheel will show a line of available 
splayed in the same order as they are 

 the colour swatch to select it. 

crements, to create slit colours, by 
usting the slider to rotate the wheel forwards 

 on the Rotate button and slider to spin 
the wheel forwards or backwards: 

colours for each wheel.  The colours are di
on the wheel. Just click on

You can move the colour wheel by small in
clicking on the Index button and adj
or backwards. 

You can also rotate or spin the by clicking

If the colour wheel is spinning you can reverse the spin direction by clicking on 

the  Reverse icon or stop it by clicking on the  Stop icon. 
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Setting gobo 
The Gobo summary panel displays icons of the gobos available on the selected 
fixtures: 

 

ype of fixture selected, the icons Vista displays represent all 
 fixture. Fixtures that have more than one gobo wheel w
le gobos for each

If you have only one t
the gobo types of that ill 
show a line of availab  wheel.  The gobos are displayed in the 
same order as the
leave the other set o . 

To choose a gobo, click on the icon re
have more than o ut 
because their gobos a

Rotation 
l by small increments, to create split patterns, by 

 

You can also rotate or spin the Gobo wheel by clicking on the Wheel and Rotate 
 and adjusting the slider to spin the wheel forwards or backwards. If the 

ndividual gobos. For these fixtures: 

ed gobo by small increments, to 
age, by clicking on the Gobo and Index buttons 

and adjusting the slider to rotate the gobo clockwise or 

e selected gobo by clicking on the Gobo 
and Rotate buttons and adjusting the slider to spin the 
gobo clockwise or anti-clockwise. 

y are on the wheel. You can select a gobo from one wheel and 
t open or a gobo from each wheel to combine the patterns

presenting the gobo shape you want.  If you 
ne type of fixture selected the gobo icons will be greyed o

re different.. 

You can move the gobo whee
clicking on the Wheel and Index buttons and adjusting the slider to rotate the
wheel forwards or backwards. 

buttons
gobo wheel is spinning you can reverse the spin direction by clicking on the 
[Reverse Icon] or stop it by clicking on the [Stop icon]  

On some fixtures you can rotate the i

• You can move the select
align the im

anti-clockwise. 

• You can also spin th

• If the gobo slot is spinning you can reverse the spin 

direction by clicking on clicking on the  Reverse icon or 

stop it by clicking on the  Stop icon. 
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Setting beam size and focus 
The summary Beam  panel has two tabs for controlling the most used beam 
attributes: 

and zoom of the selected fixtures: 
Focus 
The Focus tab controls the focus 

 

Use the focus slider to soften or sharpen the beam shape. U to 
make the beam spread softer or sharper. 

Iris 
The Iris tab controls the beam size (or diameter) of the sele
have an iris. 
Use the iris slider to make the beam size. Use the Zoom slid e beam 
size smaller or larger. 

se the Zoom slider 

cted fixtures, if they 

er to make th
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Using the detailed panels 

ls in the Intensity group: 

Intensity  
Click on the Intensity button to select the detailed settings panel for all fixture 
channe

 

In this view: 

• the 10 to 90 buttons 

• the end most 
percentage buttons set 

s 
increase or decrease it 
in 5% or 10% 
increments. 

nsity 

 

tures 

e 

speed of the strobe 

• if the selected fixtures 
have blackout 
shutters, the Opened 
and Closed buttons 
set the shutter 
position. 

 

lues 
 a 

for more details on using the custom control 
panels. 

set the intensity of the 
selected fixtures to the 
corresponding 
percentage value. 

the level to 0% or 
100% while the other

• the Intensity slider 
controls the inte
of the selected fixtures 
in a percentile range

• if the selected fix
have a strobe 
capability, the Strob
slider controls the 

Custom va
Some fixtures have effects and other special features that can be used by setting
channel to a particular value. These features vary from fixture to fixture so they 
aren’t included in Vista’s ‘generic’ controls. 

See About Custom values on page 5-35 
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Position 
The detailed Position panel provides a larger version of the position target panel. 

You’ll notice that ust just the pan or just the tilt by 
using the Pan and Tilt sliders located on 
panel. 

 on this panel you can also adj
the bottom and left side of the target 

Fine mode 
Position, can be difficult to control when the 
palette is in normal mode. To switch to fin
mode click the ‘Fine button’. 

Flip 

 

e 

Click this button to rotate and invert the 

Custom values 
Some fixtures have effects and other special 
features that can be used by setting a 
channel to a particular value. These features 
vary from fixture to fixture so they aren’t 
included in Vista’s ‘generic’ controls. 

See About Custom values on page 5-35 for 
more details on using the custom control 
panels. 

 

 

Colour 
The detailed Colour palette let’s you choose how to control the colour mixing 
mechanism and the colour wheel(s) in your fixtures: 

fixture(s) so that it is pointing at the same 
position. 
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The buttons, in the middle of the colour panel select the colour mechanism. There 

 – hue and saturation values. 

ur s

• Wheel – pick a col

If a fixture only has a colour mixing mec n choose a 
colour from the HSV or Lee swatch sect
mechanism. The colour wheel section w

If a fixture has a colour mixing mechani
you can choose a colour from the HSV o
applied to the mixer mechanism. You ca lour from the Wheel 
section of the colour panel it will be applied to the colour wheel. This means you 
can set different colours for the mix mechanism and the wheel. 

If a fixture only has a Colour wheel(s) you can choose a colour from the HSV, Lee 
or Wheel section of the colour panel it will be applied to the colour wheel. If you 
choose colours from the HSV or Lee section the nearest colour on the wheel is 
selected.  

are three options. 

• HSV

• Lee – Lee colo watch. 

our from the fixture’s colour wheel 

hanism (CMY / RGB) you ca
ion and  it will be applied to the mixer 
ill not be available. 

sm (CMY / RGB) and a Colour wheel 
r Lee swatch section and it will be 
n also choose a co
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Hue and Saturation values 
ker 

iders: 
When you select the HSV colour option the colour panel provides a colour pic
panel and a set of sl

 

To pick a hue and its saturation, just click 
on the shade you want in the spectrum 
area, and drag around to select a colour 
and set the saturation level. 

You can also adjust the colour using the 
three sliders. Click the HSV, CMY or 
RGB ‘slider mode’ button to choose the 
method you want, then adjust the sliders 
to set the colour. 
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Lee Swatch 
This option provides a list of Lee filters so you can pick a colour by it’s name, 
number or swatch. 

Click in the Colour, Number (#) or Name (N) 
our 

swatch. You can also search for a name or 
number by typing in the search box. 

 

button to sort the list by name number or col

 

 

Wheel 
When using fixtures with a colour wh
representation of the colour wheel so
available and where they are on the w

eel(s), this option provides a graphic 
 you can see exactly what colours are 
heel: 

 

 the colour 

wheel forwards or backwards. 

You can also rotate or spin the colour 
wheel by clicking on the Rotate buttons 
and adjusting the slider to spin the 
wheel forwards or backwards: 

If the colour wheel is spinning you can 
reverse the spin direction by clicking 
on the [Reverse Icon] or stop it by 
clicking on the [Stop icon]  

If you have more than one type of 
fixture selected, Vista displays a tab for 
each fixture type at the top of the 
panel. . To choose the fixture type you 
want to work with click on the 
corresponding tab. 

If a fixture has more than one colour 
wheel the buttons above
wheel will be available. To choose the 
colour wheel you want to work with 
click on the corresponding button. 

You can move the colour wheel by 
small increments, to create split 
colours, by clicking on the Index button 
and adjusting the slider to turn the 
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Custom values 
Some fixtures hav f  a 
channel to a particula
aren’t included in Vis

See About Custom value
panels. 

Gobo 
The detailed Gobo pa so 
you can see exactly w d where they are on the wheel: 

e e fects and other special features that can be used by setting
r value. These features vary from fixture to fixture so they 
ta’s ‘generic’ controls. 

s on page 5-35 for more details on using the custom control 

nel provides a graphic representation of the gobo wheel 
hat patterns are available an

If a fixture has more than one gobo wheel 
the buttons above the gobo wheel will be 
available. To choose the wheel you want to 
work with click on the corresponding 
button. 

 move the gobo wheel by small 
increments, to create split patterns, by 
clicking on the Wheel and Index button and 
adjusting the slider to turn the wheel 
forwards or backwards. 

You can also rotate or spin the wheel by 
clicking on the Wheel and Rotate buttons 
and adjusting the slider to spin the wheel 
forwards or backwards. If the colour wheel 
is spinning you can reverse the spin 
direction by clicking on the [Reverse Icon] 
or stop it by clicking on the [Stop icon]  

 

Rotation 

You can
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On some fixtures you can rotate the individual gobos. For these fixtures: 

ttons 

spi lected gobo by clicking on the Gobo 
and Rotate butto
gobo clockwise 

• If the gobo slot is spinning you can reverse the spin 
direction by clic  the [Reverse Icon] or stop it by 
clicking on the [

If you have more than one type of fixture selected, Vista displays a tab for each 
fixture type at the top of the panel. . To choose the fixture type you want to work 
with click on the corresponding tab. 

Custom DMX 
Some fixtures have effects and other special features that can be used by setting a 
channel to a particular value. These features vary from fixture to fixture so they 
aren’t included in Vista’s ‘generic’ controls. 

• You can move the selected gobo by small increments, to 
align the image, by clicking on the Gobo and Index bu
and adjusting the slider to rotate the gobo clockwise or 
anti-clockwise. 

• You can also n the se
ns and adjusting the slider to spin the 

or anti-clockwise. 

king on
Stop icon]  

5‐32  Vista User Guide, Version 2 



The Chooser window  Using the detailed panels 
 

Beam 
The detailed Beam panel provides sliders for all the beam features and a graphic
representation of frame (shaping s

 
hutters) , if the fixtures have this feature: 

 

Focus 
Use the focus slider to soften or sharpen 

Use the Zoom sl r
angle narrower or w

Iris 
The Iris tab controls  
diameter) of the selected fixtures. 

 

the beam shape.  

Zoom 
ide  to make the beam 

ider. 

the beam size (or
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Framing 
The Frame tab is specifically for fixtures that have beam shaping frames, so yo
can shutter-off parts of the beam: 

u 

To set the posit

 

ions you want the frames to 
 drag 

 can also set the rotation angle of the 
he whole 

• Index – to turn the 
framing shutters to 
the preferred angle 
click the Index button 
and move the slider to 
set the position. 

• Rotate – to 
continuously rotate 
the whole shutter 
assembly click the 

move the slider to set 

 by setting a 
channel to a particular value. These features 

ure to fixture so they aren’t 

The detailed Custom panel provides a separate mini setting panel for every 
e selected fixture. The mini panels are arranged in sections 

– Intensity, Position, Colour, Gobo, Beam and 
Miscellaneous. The ‘Misc’ section contains all the mini control panels for all 

 don’t belong in the IPCGB feature groups. 

Click on any of the Feature type headings to open that section. 

be in on the selected fixtures, click and
each frame to the position you want, as 
shown in this example: 
You
shape or continuously rotate t
shape using the slider: 

Rotate button and 

the speed and 
direction. 

Custom values 
Some fixtures have effects and other special 
features that can be used

vary from fixt
included in Vista’s ‘generic’ controls. 

See About Custom values on page 5-35 for 
more details on using the custom control 
panels. 

 

Custom 

channel of th
according to their feature type 

channels that
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About Custom values 
Some fixtures have effects and other special features that can only be used by 
setting a channel to a particular value. These features vary from fixture to fix
so they aren’t incl

ture 
uded in Vista’s ‘generic’ controls. 

 have special settings for the Strobe channel that 

e small Custom control panels 

For example some fixtures
provide a random strobe effect. Moving the Vista strobe slider to the left or right 
will never set the effect running because the slider only operates in the (generic) 
range that sets the strobe to fast or slow. 

To access the special channel features you use th

Custom panels 
The small custom panels are divided into 3 sections: 

 

• the top section shows the name of the channel in a colour 
coded bar. 

• the centre section shows the channel range. This will 
normally be the same as the channel name but will change 
if a s

• the bottom section shows the channel value. Normally this 
is shown 
valu

You can set 

 click on the up and down buttons, in the bottom section, to 
adjust the value by + or – 1 each time you click a button 

• click 
valu

• click while 
hold r 
chan
curso  

pecial range is selected – see below. 

as a DMX value (0-255) but can be changed to a % 
e by de-selecting the DMX button. 

a custom channel value in three way

•

s: 

in on the value display to highlight it and type a new 
e with the keyboard 

in on the value display to highlight it and 
ing the pen or mouse button down, not that the curso
ges to an up/down arrow. Now move the pen or 
r up or down as though you were adjusting a slider.
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F res the Vista des information about the value channels 
n o for a parti ck on the custom 
p r double-
feature window: 

Custom feature window 
The custom feature window  
range that is in the Vista lib

or many fixtu
eed to be set t

 library inclu
cular effect. In this case you can cli

anel’s title bar o click anywhere on the panel to open the Custom 

 lets you select any special values or a value within a
rary for the selected fixture: 

 

does this… 

 

This field… 

Name Shows the name of the channel or selected chann
range. 

el 

Range Fader (to d range if p) Adjusts the channel value within the selecte
such a range exists. 

Channel Fader (lowe  DMX r) Adjusts the channel value to any value in the
range – 0-255. 

Search  (for 
 to 

special value or range by name. 

For fixtures with large numbers of custom values
example media servers) you can type in this field
locate a 

Sort For fixtures with large numbers of custom channels 
(for example media servers) you can sort the values 
by ID# (usually as the values appear in the fixtures 

 channel chart) or by Name. DMX

Icon Size  Adjusts the size of the custom value/range selector
buttons in the right hand column. 
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This field… does this… 

Range buttons  
entire channel range (i.e. 0-255). 

h 
value ranges. Clicking on the 

 

In this column there will always be one button that
selects the 

If the Vista library includes information about the 
fixtures custom values there will be a button for eac
of the special values or 
button will set the channel to that value or range. If
it’s a range you can adjust the value, within that 
range, using the top slider. 

DMX / Units This button selects between DMX values (0-255) and 
units (normally 0-100) 

Associated feature 
panels 

If there are other features that are associated with the
selected feature,they can be selected and adjusted 
from within the window. 

 

The Components tab 
If it’s not already selected, click on the Components tab at the top of the sidebar: 

 

This is where you store, select and organize your Groups, presets, Extracts, 

ent you want to work with – 
Groups, Presets, Effects, Extracts and  Snapshots 

p components into 
custom sets. 

ccess to all the elements used for programming and 
p 

Effects, Cuelists and Snapshots. The window is divided into different areas that 
allow you to: 

• choose how you want to view the components 

• choose the type of compon

• choose a component and either activate it or modify it in 
some way 

• create new pages that let you grou

This screen provides quick a
playback of a show. To choose the component type you use the buttons at the to
of the left column: 

This button… does this… 

QP1 displays  a multi-panel ‘Quick picker’. The Quick pickers 
provide an easy way to arrange and select Presets, Groups, 
Extracts SmartFX and more. 

QP2 displays a second multi-panel ‘Quick picker’.  
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This button… does this… 

Groups elect or modify the groups you’ve 
saved. 
displays and let’s you s

Presets displays and let’s you select or modify the presets you’ve 
saved. 

FX displays and let’s you select any of Vista’s built in effects  

Extracts ct or modify the Extracts. you’ve 
saved. 
displays and let’s you sele

The parameter Filter 
If you are working with Presets, Effects or Extracts the Parameter Filter bar can 
be used to filter the items that are displayed or the features that are stored: 

bar 

 

If you are recording a Preset the filter bar shows which parameters are being 
recorded and which are not. You can click on any of the icons to either include it 
or exclude it. Included parameters are highlighted.  

For more information about presets and filters see Presets on page 5-45. 

If you are applying a item that includes more than one parameter type you can 
use the filter bar to filter out any parameters you don’t want to use. For example 
you might have a Preset that includes Intensity, Position and Colour but you 
only want to use the Colour part. In this case you would click on all the filter bar 
icons except Colour before selecting the preset. 

When you are applying presets from the Components panel the Preset will fade 
in over  the ‘Live Time’ . For example you might be working in the Live 
programmer tab and want to fade some lights into a colour or position over 
several seconds. To do you use the Live Time window: 

Components window tools 
If you are working with Groups, Presets, Effects or Extracts there is a toolbar at 
the bottom of the panel that acts on the list of items 

This button… does this… 

[ + ] Creates a new component of the selected type. 

[ - ] Allows you to delete a component 

Search typing in the ‘Search’ box filters the list down to just the items 
that match what you’ve typed. 
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This button… does this… 

X Clears the search box. 

 

Quicker Picker panels 
The Quick Picker panels provide an e
you’ve created: 

• Groups 

• Presets 

• SmartFX (FX te

• Cuelists 

• Extracts 

• Favourites 

• Snapshots. 

asy way to select any of the following items 

mplates) 
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The Sidebar has two panels (QP1 and QP2) 
that normally display three quickpicker 

k 
 

ickpickers drag 
the divider(s) to the bottom of the panel. 

by 
n 

menu at the top left side of each column. 
ormation 

you want the column to display, you can 
also select what page you want to display 
within that column using the second drop-

 page to a quickpicker right click 
on the panel you want and select ‘add new 
page’ from the popup menu. 

To delete a page from a quickpicker right 
click on the panel you want and select 
‘remove page’ from the popup menu. 
Deleting a page does not delete the items on 
that page. 

To copy an item hold the ‘Alt’ key (or Green 
modifier) while dragging the item from one 
page to another. 

 

 You can also have Quickpickers at the bottom of the main programmer 
window and on external touchscreen monitors. 

T ickpick
The multi-quickp contains  
b re Cho
select the ‘Multi Quick Pick  
menu, Vista displays the M

panels. To adjust size of a Quick picker clic
on the divider bar and drag up or down. To
hide one or two of the Qu

You can set what a Quick picker displays 
choosing an option from the drop-dow

Once you’ve chosen the type of inf

down menu. 

To add a

he Multi Qu er 
icker 

ottom off the Fixtu
4 quickpicker panels and normally appears at the

oser and Timeline window. If it’s not already open 
er’ option from the View > Add Floating Window
ulti Quickpicker 
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T picker is a dow, it can either be docked inside the 
m  it can floa  beside the main window. 

T floating wind r and drag it off the main 
w e 
panel and d le

T er nor he 
w ker cli e 
one or two of the Quickpickers drag the divider(s) to the right of the panel. 

o have Qui l touchscreen monitors. 

Quickpicker  menu
Dep
Quick
component. Vista displays the context menu: 

he Multi Quick
ain window or

 floating win
t on top of or

o un-dock a ow, click on the header ba
indow. To dock a floatin

rop it on the 
g window drag it inside the fixture layout or timelin
ft, right. top or bottom of the panel. 

he Multi Quickpick
idth of a Quick pic

mally display four quickpicker panels. To adjust t
ck on the divider bar and drag left or right. To hid

 You can als ckpickers on externa

 popup  
ending on the component there are various options available on the 

picker context menu. To open this menu right-click on the label area of any 

 
 

This option… does this… 

Cuelist Properties Opens the Cuelist properties window – see below. 

Lock item Locks the se

new Pag

lected component. Components that 
have be locked will not be altered or replaced when a 

 or Snapshot is loaded. e

Clear item Clears the selected playback – the assigned 
component is removed from the control. 
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This option… does this… 

Clear page  
assigned components are removed and a blank page 
Clears all playbacks on the current page – the

is left. 

Delete page Deletes the current page. 

Set as default play
layout. defaults for all new cuelists. 

back Sets the selected cuelist’s buttons and faders as the 

Snapshot enabled ws the selected playback to be included in a 
snapshot. 
Allo

Set as default cuel
configuration 

the defaults 
for all new cuelists. 

ist Sets the selected cuelist’s properties as 

Adjust contrast Adjusts the contrast of the selected LCD window  

 You can also p g them (Alt + select to 
release) in a Quickpicker that has been configured this way – see below. 

Arranging the Quicker Picker panels 
W isp
buttons in a grid. Y rrange the items into a single or multi-column list 
and change the how

To do this click on t

lay and release cuelists by selectin

hen you first d lay a Quick picker panel you’ll see the items are laid out as 
ou can re-a
 each item is displayed.  

he  settings icon to open the Quickpicker settings window: 
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This button… does this… 

Icon size adjusts the size of the icons displayed in the Quickpicker.  

Text size adjusts the amount of space available for the label.  

Padding adjusts the amount of space between the icons. 

Icon click this button to display just an icon for each item. 

Label click this button to display just a text label for each item. 

Both click this button to displ
eac

ay both an icon and a text label for 
h item. 

Multi-list click this button to arrange the items in a multi column lis
The items are laid out across and then down. 

Single list click this bu

t. 

tton to arrange the items in a single column list. 

Touch screen click this bu
use on an ex

tton to arrange the items in a grid suitable for 
ternal touchscreen. 

Icon view 
icons without labels. 
click this button to arrange the items in a compact grid of 

Auto-arrange Arrange the icons by 
(number) 

Name (alphabetically) or by ID 

Cuelist 
Playback 

When the 
it. To release a cuelist hold th
and  select 

selection box is ticked, selecting a cuelist will play 
e green modifier (or press Alt) 

the cuelist. 

Apply to all click this button to appl
windows. 

y these settings to all Quickpicker 

 

Presets labels 
When you select some fixt
available: 

This label… indicates… 

ures, the preset labels change to indicate which are 

Greyed this preset do
fixtures. 

es not have any settings stored for the selected 

Normal this preset has set
fixtures. 

tings for some or all of the selected 

Ticked this preset is being used on the selected fixtures. 
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Groups 
If you have a big rig, the last thing you want to do is manipulate dozens of 

 
auto  type that you patch. You can also 
create your own groups.  

A gr
wha t in a group. Some typical groups might be all the even or odd 
fixtures of one type, all the fixtures on the back truss, or all the fixtures you’re 

Creating groups 
irst creating groups it’s easier to be in a layout that shows the 

individual fixtures. To make it easy to control all the fixtures in your rig Vista
matically creates groups for each fixture

oup can consist of any number of any type of fixtures; it’s entirely up to you 
t you pu

using on one particular part of the stage. 

When you are f
Groups panel in the sidebar. If you’re seeing something else, click on the 
Components tab and select the ‘Groups’ button: 
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To create a group: 
Select the fixtures you want in the group: 

Click the [+] Add Group button at the bottom of 
opens the Create New Group window: 

Type a name for the Group and click OK or press Enter. 
name the Group right away you can accept the 
it later. 

You can create as many groups as you want, an

1. 

2. the Group panel. Vista 

3. If you don’t want to 
suggested name and rename 

d you can also create any number 

Presets
Presets are the ‘building blocks’ that you use to create cuelists. They represent 
common sets of attributes that you know you’re going to want to use over and 
over again, such as a particular colour he 
d

Presets are useful for two reasons. ly assign  
I olour
f ithout having to  
you store your cues using  
without having to edit eve

Creating presets 
To create a preset: 
1. Select one or more fixt

2. Set any of the Intensity
the way you want them

3. Then either:  

• Click on any of the palette type button 

of ‘groups of groups’.  

 

 (e.g. Red) or position (e.g. on t
rummer). 

First with presets you can quick
ntensity, Position, C
ixtures w

, Gobo, Beam and other values to any number of 
adjust the settings individually for each one. Second if
presets you can quickly update all your programming
ry cue.  

ures. 

, Position, Colour, Gobo, Beam values on the palette 
. 

 and select the the ‘Preset’ > 
Preset’ op

• Select the ‘New > 

• Click on the ‘+ Preset’ button in the Components toolbar. (To open the 
Components toolbar choose the Toolbar > Components toolbar from the 

enu. 

• Right-click in a Pr . 
 Vista displays the Creat

‘Create tion from the popup menu or, 

+Preset’ option from the Components menu ,or 

View m

esets Quickpicker and select the Create preset option
e New Preset window: 
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4. Enter a name for the p

5. Click on the icon and sel

6. Set the Preset store options: 

Th

reset in the name box (beside the icon) 

ect and different image if required. 

is option… does this… 

Update options Only applicable if you are updating an existing 
Preset. See below 

Create default for 
fixtu

Tick ‘Same Fixture Type’ if you want to be able to 
re use this preset on any fixture, of the same type, even 

choose this option you’ll see a tick, in the ‘fixture 
type column’ beside the fixture that will be used as 

lick on a different 
fixture’s checkbox to use it as the reference. 

n any fixture, of any type, even if it is not 
f you choose this 

option you’ll see a tick, in the ‘global’ column beside 

preset. Click on a different fixture’s checkbox to use 
it as the reference. 

if it is not selected when you store the preset. If you 

the reference for the preset. C

Tick ‘Ay Fixture Type’ if you want to be able to use 
this preset o
selected when you store the preset. I

the fixture that will be used as the reference for the 

Filter Fixtures Normally only the selected fixtures are included in 

 

the Preset. If you want to include all fixtures, in the 
preset, click on the drop down box and select the 
‘All’ option

Filter Output 
are outputting, no matter whether they are coming 

r or fro any Cue that is playing. 

 the Current Cue 
[Alex] click on the drop down box and select the 

Normally presets store the values hat the fixture(s) 

the Programme

To only store values comig from

‘Current Cue’ option. 

Filter Features Presets are normally per-palette, i.e. you create 
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separate presets for intensity, colour, gobo, beam and 

clude or exclude 
any features. 

icon so that it is not 
highlighted. 

miscellaneous features. 

However the filter bar lets you in

To include a feature click on it’s icon so that it is 
highlighted. 

To exclude a feature click on it’s 

Preview panel The bottom panel of the New Preset window shows 
a preview of the fixtures you have selected and the 
features that will be stored in the preset. 

 

7. n. Vista creates a new Preset that appears in the Presets 
panel of the Component Sidebar and in Quickpickers set to show All presets 

feature type you’ve created. 

use the Programmer to update the information stored in a preset. To do 

2. 

3. a Quick Picker and select 

4. 

t’s being played 

The
fixtures when Highlight mode is on. 

• when you select a fixture it goes to the Highlight preset  

• wh

To edit either of these pr
1. Set the fixture(s) Intensity, Position, Colour, beam etc. 

2. Right click in the Sid  
Highlight Preset’ or

Click the OK butto

or ones of the 

Updating presets 
You can 
this: 
1. While a editing the cuelist, select the fixtures you want to change or add to 

the preset. 

Make the adjustments you want using the palettes. 

Right-Click on the preset in the Presets panel or 
Update from the popup menu. 

Vista displays the Update Preset window where you can . 

 You can also update Presets when you Update a cuelist, tha
back. 

The Highlight and Lowlight presets 
re are two special presets, Highlight and Lowlight, that set the behaviour of 

en you deselect a fixture it goes to the Lowlight preset. 

esets you do this: 

ebar, Components, Presets panel and select the ‘Update
 ‘Update Lowlight Preset’. 
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L
If you are working live w
‘Live Time’ window can

simply selecting a (non-linear) value in the 
de in. For 

example you might be working in the Li

To set the Live Time: 
1. Click the ‘Live’ button on the main toolbar. This button is normally mapped 

ey F10 on the keyboard. You can also select the ‘Live Time 
he Tools menu. 

e 
 time presets. 

u can save these as presets that appear on the drop down list. To 
do this: 

he ‘Live Time option from the Tools menu. 

pens select the ‘Custom Timing’ option from 
s the Custom Timing window. 

ive Time 
ith Presets, Palettes or any of the Sidebar panels the 

 be used to control crossfade time. 

When you are applying a presets or 
sidebar palettes you can set a time for the Preset or selected value to fa

ve programmer tab and want to fade 
some lights into a colour or position over several seconds.  

to Function K
option from t

2. Enter a time in seconds or click on the drop down box and select one of th
live

Live time presets 
Vista comes with 2 Live time presets: 2s and 5s. But if you regularly use other 
time settings yo

1. Click the ‘Live’ button or  select t

2. When the Live Time window o
the drop down box. Vista open

  

ade curve for each of the features: 
ur, Gobo, Beam and Miscellaneous. 

 

3. Set the Fade Time, Delay time and F
Intensity (Up and Down) Position, Colo

This field… Does this…

T e sets the fade time in seconds. You can also set the fade 
time by clicking on the timing bar and dragging the 
right handle forwards or

im

 backwards 

Delay sets the delay time in seconds. You can also set the 
delay time by clicking on the timing bar and when the 
cursor turns into a hand dragging the bar to the right. 
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Fade Curve sets the fade curve. To set the fade curve click on the 
icon and select an option from the popup list. See the 
glossary for more about fade curves 

 

4. Click on the ‘Save as’ button and give this Timing preset a name. 

5. Click OK to save. The new Timing preset will now be available on the Live 

oks including intensity pulses, position shapes, colour chases and 
more.  

n effects, click on the Components tab and select the ‘FX’ button. 
ly one of the built in  effects with just one click but you can also 

s 

See the SmartFX window on page 2-2

To apply an effect: 
er window, select the fixtures you want. 

on on the Components tab. Vista a list of the built in effects: 

Timing drop down box. 

SmartFX 
Vista comes with a number of built in effects that you can use to quickly create 
dynamic lo

To see the built i
This lets you app
use the SmartFX window to modify the built in effect or create your own effect
from scratch.  

Applying a built in effect 

1. In the Fixture choos

2. Click the FX butt

 

3. You can click on the filter bar icons to either include or exclude effects that 
include the corresponding parameter types. 
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4. Click the Stored (Canned) FX tab. Vista displays the list of available stored 
(canned) effects. The letters in the ‘content’ column each effect tell you which 

n, C-Colour, etc). 

6. To adjust the parameters of an effect, open the SmartFX window and use the 
controls to adjust it (see Effect controls on page 7-4). 

 
cle around a 

position). 

mming templates and can contain any of the attributes 
lettes: intensity, colour, beam, position, and so on. They also 

apply in other cu t
can save yourself a lot of time re-creating your favourite lighting effects. 

Creating extract
To create an extract: 

timeline that you want to use as 

2. To store an extract, either: 

en 

lt-F8 or 

ick in nel and select the Create extract option. 

3 Type a name for t

4 a adds the new item to the extract list. 

Applying extracts
To apply an extract: 
1 Select one or more  in the Fixture chooser window. 

parameters are in this effect (e.g. I-Intensity, P-Positio

5. To apply an effect, click on the effect you want. 

Effects that modulate or swing 
The built in effects are pre-set to either swing or modulate. Swinging means the 
fixtures move between two sets of attributes determined by the effect (e.g. 
moving from to left to right). Effects that are preset to modulate will apply their
own varying attributes about a particular setting (e.g. creating a cir

Extracts 
Extracts are like progra
you define on the pa
store the timing associated with the events. 

An extract is a section of a cuelist (or range of events) that you can save and re-
elis s. By re-using existing material to build new cuelists you 

s 

1. Select the part of the cuelist or events on the 
an extract. 

• Select the Extracts button on the Components tab, in the sidebar. Th
click on the + button or 

• click on the ‘New Extract button – normally A

• Right-cl  a Extracts pa

. he extract and click the OK button. 

. Vist

 

.  fixtures
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2 tracts  Components tab of the sidebar. 

3 Find the extract you want and click on it to select it. 

Set the mask buttons s es you want are applied. Any attribute 
that is masked, even if it is part of the extract, will not be applied.  

Using a keyp in the programmer window 
Vista V2 includes a CLI (Command Line Interface) window that provides 

ecting fixtures, setting intensities and storing cues. 

 or from a suitable USB keypad. The 
an be left open at all time and will only accept input when the 

keyboard or keyp  i

Using the CLI  
To open and clos e y 
pressing the Pause button on the keyboard. open the SmartFX window by either: 

on on the main toolbar – usually 

mand Line option from the View menu 

ause’ button on your keyboard 

. Click the Ex button on the

. 

o that the attribut

ad 

familiar keypad syntax for sel
The CLI appears at the bottom of the main editor window and is completely 
synchronized with the interface so that when you type a command you see the 
equivalent action happen on the fixture icons and control palettes 

The CLI accepts input from your keyboard
CLI window c

ad s not being used by another window. 

e th  command line by clicking View -> Command Line, or b

• clicking the SmartFX butt
F?, or 

• selecting the Com
(Ctrl + ?) 

• pressing the ‘P

 

Hardware Keypad 
e keyboard number keys or a separate keypad when the CLI 

window is showi . T
number keys the llo

This button… 

You can use th
ng he ‘Num lock’ key should be on and in addition to the 
fo wing special keys are available: 

does this… 

/ Through (also used in storing cues – see below) 

* or @ At 

** or @@ At +Full 

Backspace <- Backspace (Clear) 

F Fixture 
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This button… does this… 

G Group 

S Store All (Look) 

P Store Part 

T Time 

Selecting fixtures  t
For simple fixture sele
you can also select Groups and Fix numbers with a ‘G’ 
for Group or ‘F’ f fi

For example: 

• 1 + 5 + 10 Enter selects fixtures 1, 5 and 10 

 plus 

 the CLI 
You can also set levels with the keyboard. To simplify operation Vista 

s some entries. 

 digits are interpreted as tens (@5 is the same as @ 50).  

s. 

ns 

ts it to 5%. 

• 1  @ 5 Enter selects fixture 1 and sets it to 50%. 

 in he CLI. 
ctions you can just type the fixtures numbers. However 

tures by prefacing the ID 
or xture.  

• G1 + F20 Enter selects all the fixtures in group 1
fixture 20. 

• 1 / 10 – 4 / 6 Enter selects fixtures 1, 2, 3, 7, 8, 9 and 10 

Selecting fixtures and setting levels in

automatically complete

For fixture ‘through’ selections leaving off the second number means all higher 
numbered fixtures will be selected. 

For intensities single
Number. 

Setting ‘though’ levels can also fan intensitie

For example: 

• 1 / 10 @ 50 Enter selects fixtures 1 through 10 and sets 
them to 50% 

• 1 / 10 @ @ selects fixtures 1 through 10 and sets them to 
100% 

• 1 / 3 @ 20 / 100 Enter selects fixtures 1 through 3 and fa
their intensities between 20 and 100% (fixture 1=20%, 
fixture 2=60%, and fixture 3=100%) 

• 10 > @ 9 Enter selects all fixtures 10 and above and sets 
them to 90% 

• 1  @ 05 Enter selects fixture 1 and se
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Storing with the CLI 
The Command Line can also be used to store cues and set timing. For example: 

For example: 

• S 100 Enter 
Store Look Cue 100 to the open or the most recently used 
Cuelist. 

• S 2 / 10 Enter 
Store Look Cuelist 2 Cue 10 

• S 5 / 8 T 2/3 Enter 
Store Look Cuelist 5 Cue 8 with a 2 second Infade and 
second outfade time 

3 

• /3 Enter 
Cuelist 9 Cue 1 with a 2 second Infade and 3 

The Progra
With the encoder w
you can make more ex nts than the on-screen palettes. During 
p amming you c
G  and Miscellan

Programmer intens
The overall intensit  
the left side, below er wheels. 

Programmer mode
If the controls are n
‘Menu’ and then se

P 9 / 1 T 2
Store Part 
second outfade time. 

mmer hardware controls 
heels and associated LCD and buttons on the Vista consoles 

act adjustme
rogr
obo

an use them to adjust setting for Intensity, Position, Colour, 
eous parameters 

ity 
y from the Programmer is controlled by the fader located, on
the encod

 
ot already in Programming mode press the button labelled 
lect the ‘IPCGB’ button: 

 

Vista switches the controls to programming mode: 

Vista User Guide, Version 2  5‐53 



The Programmer hardware controls  The Chooser window 

 

This button… does this… 

I + P Press this button to put the encoders and lower 6 buttons in 
Intensity plus Position mode. Pressing it again cycles the 
controls through any available parameters or alternate 
modes (Angular position and Strobe & Shutter). Hold the 
red modifier (or the shift key) and click to cycle the controls 
in reverse.  

Col Press this button to put the encoders and lower 6 buttons in 
Colour mode (HSV). Pressing it again cycles the controls 
through any available parameters or alternate modes (CMY, 
RGB, Frame / Index and Colour swatch). Hold the red 
modifier (or the shift key) and click to cycle the controls in 
reverse. 

Gobo Press this button to put the encoders and lower 6 buttons in 
Gobo mode. Pressing it again cycles the controls through 
any available parameters or alternate modes. Hold the red 
modifier (or the shift key) and click to cycle the controls in 
reverse. 

Beam Press this button to put the encoders and lower 6 buttons in 
Beam mode. Pressing it again cycles the controls through 
any available parameters or alternate modes. Hold the red 
modifier (or the shift key) and click to cycle the controls in 
reverse. 

Home Sets the associated parameter to it’s default values. I.E. 
would set Intensity to 0.  

 Holding the Yellow modifier (or Ctrl key) changes this 
button to Clear 
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This button… does this… 

F um values. I.E. ull Sets the associated parameter to it’s maxim
would set Intensity to 100. 

 Press Home and Full together to set the parameter to it’s 
mid value. 

 Holding the Yellow modifier (or Ctrl key) changes this 
button to Half 

Encoders Rotate to set the associated parameter to the required value. 

<- Left arrow Selects the previous Fixture 

-> Right arrow Selects the next fixture 
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6. Working with cuelists 
Once you’ve set up your patch, arranged your fixtures, assigned them 
and created the presets you want, you’re ready to create a 

This is where the Vista differs in a big way from 
lighting consoles, because instead of telling 
of numbers, you do it all visually, on a large screen using the 
the hardware controls. 

to groups, 
Cuelist.  

traditional keypad-controlled 
it what you want by entering strings 

pen or mouse and 

Vista also offers three ways to start a new Cuelist, you can either: 

ue directly to one of the playback controls with as 
few as three button presses. With this method the cuelist is 

you’ve stored is ready to play.  Later you can add more 
cues to the same cuelist, change fade times and modify 

ettings by opening it in the editor 

 
 existing cuelist. Store 

pular 

itor and store one or 
u can store and edit as 

and every other aspect 
list you can switch to 
o one of the playback 

Whe in a 
cue. mple, if a fixture is set to 50% Intensity in cue 1 and is not changed 
unti e tensity events stored in cues 2-4 for that fixture.  
Tha e k 
of cu  2

The important difference in a tracking system is that if no level is stored no 

• Store a c

automatically given a name and number and the cue 

other s

• Use either  of the two Store buttons in the main toolbar to
store directly to a playback or to an
Look is easy to use and automatically sets the most po
options. Store Part provides access to more advanced 
options. 

• Open a new, empty, cuelist in the ed
more cues to it. With this method yo
you go refining the cue fade times 
of the cuelist. After you save the cue
the Console window and drag it ont
controls. 

Vista is a Tracking Console 
n you store a cue this way only the settings that are changing are saved 

 For exa
l cu  5, there won’t be any In
t m ans if you change the intensity for that fixture in cue 1 will affect the loo
es -4. 

change will happen. 

Store All 

 

There are several important features of ‘Store All’:  
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• all the settings that the console is sending to your fixtures 
are saved. The settings could be coming from the Live tab 
or any other Cuelist being edited, a playback or any other 

the console. 

 for Gobo, Position or any other 
e light. This means that if you play the cue 

back it’s possible that another cue will influence what you 

ore All the default operation is to append a 
e end of the last cuelist you saved to. 

e to store to an existing cue it will be replaced. 
ample if a have a Cuelist with 10 Cues, Store Look 

o 

• if you insert a cue before an existing one it’s settings will 
existing cue. 

hat any settings in the 
e in the following cue. 

ly to a Playback it will 
l of the cue and any setting coming 
cleared. Because Store All 

t where the control is 

Storing
If you have the Fixture Chooser window open and you are working in the Live 
tab you’ve probably already selected some lights, given them Intensity, Colour 
and so on. To create a new Cuelist fast, you do this: 
1.

u. Vista disp
but just leave everything as is for now. 

2 le-tap on th ou 
e PC version, switch to t

one the select button there. 

control on 

• Store All does not save settings for fixture features that are 
at their default. For example if a fixture has 100% intensity, 
and in colour blue, Store All saves those settings but 
doesn’t save anything
feature of th

see. 

• when you St
new cue at th

• if you choos
For ex
will default to saving to Cue 11. If you choose to save t
Cue 4 whatever was in that cue will be replaced when you 
store. 

not change the look you’ve have saved in the 
This is called ‘Cue only’ and means t
inserted cue are automatically undon

• when you Store All direct
immediately take contro
from the Live tab will be 
includes all output of the console, this won’t change 
anything the fixtures are doing – jus
coming from. 

 a look in 3 clicks 

 click on the ‘Store All’ button or select the Store All option on the Tools 
men lays the Store All window with all the store options preset 

. Doub
are using th

e select button of an empty playback on your console. If y
he Console window and double click 
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3. The new Cuelist 
level down and back up. 

When you Store All this way the console fader is automatically set to be a 
 

Storing a look with o  
hen you want to adjust the timing of a cue or give it a new name or number 

efore storing you use the Store All window. To do this: 

lays the Store All window: 

 

is ready to use and you can move the fader to bring the 

 
Submaster.

ptions
W
b
1. click on the ‘Store All’ button or select the StoreAll option on the Tools 

menu. Vista disp

 

2. t to 

• u 
ys all the cuelists that include 

 

Vista sets the ‘Store to’ cuelist to the cuelist you last saved. If you wan
store to a new cuelist or another cuelist you’ve already started you can 
either: 
• type a new number, or 

type a few numbers or letters from the name and select the cuelist yo
want from the popup window. Vista displa
the letters or numbers you type: 

 

Vista User Guide, Version 2  6‐3 



Store All  Working with cuelists 

3.  end of the cuelist you 
or store over an existing cue 

select the cue you want 
 cues that include the 

Vista sets the ‘Store to’ cue to a new cue number at the
last saved. If you want to a different cue number 
number can either: 

• type a new number or, 

• type a few numbers or letters from the name and 
from the popup window. Vista displays all the
letters or numbers you type: 

 

ick the ‘Open Cuelist’ button. Vista displays the Cuelist and Cues 
4. If you want to store to an existing cuelist but aren’t sure of it’s name or 

number. Cl
window where you can select from all your saved cuelists: 

 

This option… does this… 

All Filters the browser to show all the cuelists you’ve recorded 

Recent Filters the browser to show just the last few cuelists you’ve 
stored. 

Playing Filters the browser to show just the cuelists that you are 
playing back. 

Console Filters the browser to show just the cuelists that you are 
visible on the console – i.e. cuelists that are on the 
playback pages you can see. 

New Creates a New cuelist with the next available number. 
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This option… does this… 

Cuelist number 

field 

Displays the cuelist numb
number in this field.  

er to save. You can enter a new 

Search (cuelists) Typing a few letters or numbers in the se
the browser to show just the cuelists 
type. 

arch box filters 
that match what you 

Select Cue Displays all the cues already stored i
Normally the ‘New Cue’ line will be 
indicating that you will be storing to a new cue at the end 
of the cuelist. 

To store over an existing cue highlight the

n the selected cuelist. 
highlighted 

 one you want.  

 
Inserts a new cue before the line the icon is on. 

Search (cues) Typing a few letters or numbers in the search box filters 
st the cues that match what you the browser to show ju

type. 

 

5. click on the i  
the options are: 

• Halt - Press t

• Follow - Play s cue has ended. 

• Start - Play ‘n

• Timecode – P i.e. 01:02:03:04 would start 
s is 

6. If you’ve made the cue start mode ‘Follow’ or ‘Start’ enter the time, in 
r the previous cue has ended or started to start this cue. 

7 et the fade time

set the in and out fade time by ty

outfade time, for Intensity to 3 seconds or, 

lick on the  
For more inf ming see page xxx or, 

•

con in the ‘Cue Start Mode’ section to set how the cue will start, 

he Go button to play the cue 

 ‘n’ seconds after the previou

’ seconds after the previous cue has started. 

lay at the specified Timecode (
the cue when timecode 1 Hour, 2 Minutes, 3 Seconds and 4 Frame
received) 

seconds, afte

. S s for the cue. To do this you can either:  

• 
typing 2/3 s

ping in the time box. For example 
ets the Infade time, for all features to 2 seconds and the 

• c timing drop down and select from the list of preset times.
ormation on Ti

 click on the timing bars and drag th

• click on the 

em to the fade times you want or, 

 expand icon to reveal the detailed timing panel: 
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8. title, in the Cuelist 
Name box 

9. If you’re are storing to a New Cue, you can give it a title, in the Cue Name 

10. le-tap on a playback 
k. 

11. Check the buttons for the classes or types of events you want Vista to 

12. 

13. ilter list. 

 
the 

St

In the detailed view you can set a fade time, delay time and fade curve for each 
of the six feature types – Intensity (in and out), Position, Colour, Gobo, Beam and 
Miscellaneous channels. To set times either type in the boxes or click on the 
timing bars and adjust them. To change the fade curve click on the icon and 
select from the popup list 

If you’re are storing to a New Cuelist, you can give it a 

box. 

Click OK to complete the Store Look operation or doub
‘Select’ button to Store the cuelist to that playbac

display. 

Type a name for the filter. 

Click the ‘Close’ button. Vista adds this filter to the drop-down f

Hold down the Yellow modifier (Ctrl on a keyboard) on the console and 
press the Select button on an empty playback to Store your look and open 

cuelist in the Editor window. 

ore Part 

 

Stor a ptions, not 

If you’ve created information in the Live tab of the Editor (or another cuelist), 
you can add it or merge it into an existing cuelist, or use it to replace a cue 
altogether. You can also start a new cuelist using the Store Part method.  

e P rt is Vista’s advanced recording method. It provides several o
available with Store Look. 
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To store this way you do this click on the ‘Store Part’ button or select the Store 
P e To ta displays the Store Part window: art option on th ols menu. Vis

 

Selecting the Cuelist to Store to 
’ cuelist to the last cuelist you saved. If you 

 another cuelist you’ve already started you can 
either: 

• New’ button in the cuelist panel to start a new 

• 
at playback or, 

 click on the Cuelist you want in cuelist panel, which 
displays all your saved items. 

To help find a particular cuelist you can filter using the source and search 
o

 

 
Vista automatically sets the ‘Store to
want to store to a new cuelist or

click on the ‘
cuelist. 

tap on a console playback ‘Select’ button to select the 
Cuelist on th

•

ptions: 

This option… does this… 

All Filters the browser to show all the cuelists you’ve recorded 

Recent Filters the browser to show just the last few cuelists you’ve 
stored. 

Playing Filters the browser to show just the cuelists that you are 
playing back. 

Console Filters the browser to show just the cu
visible on the console – i.e. cuelists th

elists that you are 
at are on the 

playback pages you can see. 

New Creates a New cuelist with the next available number. 
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This option… does this… 

Search (cuelists) Typing a few letters or numbers in the search box filters 
the browser to show just the cuelists that match what you 
type. 

 

ions 

e selected 
 you 

Selecting the Cue and store opt
You can add a new cue, or merge to or replace the contents of an existing cue. 
When you first open the Store Part window the Cue ‘Add’ button will b
automatically. The Merge and Replace options will not be available unless
select an existing cue first. 
1. If you are adding a new cue you can either accept the cue number Vista 

suggests or type a number in the Cue Number box or click on one of the 
insert icons in the list of cues to set the insert location. 

 - insert cue icon 

2. If you are Merging or Replacing you can either type a number in the Cue 
Number box or click on any cue in the cue list panel.  

3. For a new cue enter the cue number and name. 

4. click on the icon in the ‘Cue Start Mode’ section to set how the cue will start, 
the options are: 

• Halt - Press the Go button to play the cue 

• Follow - Play ‘n’ seconds after the previous cue has ended. 

• Start - Play ‘n’ seconds after the previous cue has started. 

• Timecode – Play at the specified Timecode (i.e. 01:02:03:04 would start 
the cue when timecode 1 Hour, 2 Minutes, 3 Seconds and 4 Frames is 
received) 

w’ or ‘Start’ enter the time, in 
seconds, afte

6. Select the timing 
• Destination -

• Custom se

7. Select the fixtures

This option… 

5. If you’ve made the cue start mode ‘Follo
r the previous cue has ended or started to start this cue. 

option to apply to the cue, the options are: 
 use the timing of the cue you are saving to 

- u  the timing from the Editor or set it manually. 

 to include when storing: 

does this… 

All  Fixtures 
 any other cue that’s open in the editor [TBC] 

Includes settings for all fixtures with output coming from 
the Live tab, or
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This option… does this… 

Selected Fixtures Only includes fixtures that are selected in the Live tab or 
cue being edited. 

 

8. Select the parameters to store using the filter bar. Click on any of the 
Intensity, Position, Colour, Gobo, Beam or Miscellaneous icons to mask or 
un-mask that parameter. 

9. Select the Store Source options. 

This option… does this… 

Current 

Editor tab 

Automatically set to ‘Live’ or the Cuelist being edited 

All Output Select this button to store all information, from both the 
editor and any active playbacks. 

 

10. Select the tracking options 

This option… does this… 

Cue only Click this checkbox to undo any changes in the following 
tion will not have any effect if you are storing to cue. This op

the last cue. 

 

1

This option… 

1. Select the Blocking options. 

does this… 

No Blocking The cue is stored normally 

Normal Blocking 
being stored will not be changed even if they are modified 

). 

Ensures that events that are tracking through to the cue 

in the earlier cue(s

Super Blocking Not implemented 

Opening a Cuelist in the Editor 

 
T
n

he ‘Store Look’ and ‘Store Part’ methods let you store cues to an existing (or 
ew) cuelist, without first opening the cuelist in the editor. 
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You can also start a new cuelist from scratch or open an existing one in the editor. 
To do this click on the New Cuelist button (normally F2) or select the ‘New 
Cuelist option from the Components menu. 

Whichever method you choose, Vista creates a new Cuelist tab and displays the 
Editor window. 

The Timeline window 
When you select fixtures in the Chooser window and apply intensity, position, 
colour and other features ‘events’ are created in the Timeline window. 

 

in your cuelist, make selections, add and delete cues, and 
manage how your edits affect output when you are editing 
a cue that’s playing back 

• The Timeline section where you can view and manipulate 
the fade times for all the features that are being applied to 
your fixtures. 

This screen consists of three main elements: 

• The Editor control section where you can select to work 
with the Live editor tab or any Cuelist you have open. If 
you have a Cuelist open this section expands to include the 
Cue navigation controls. 

• The Cue navigation section, where you can see all the cues 
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Cuelist tabs 
When you first op  
Live tab – this is the equivalent of want other consoles call the ‘Programmer’ or 
‘Editor” . If you o n
tab labelled with the c

You can have sev l licking 
on the tab you w  t

To close and save a C from the Cuelist menu or 
click the close icon (X) on the cuelist tab. 

lt 

en the Editor’s Chooser or Timeline windows you’ll see the 

pe  a cuelist or start a new one from scratch, Vista adds a new 
uelist name. 

era  cuelists open at once and switch between them by c
ant o work on.  

uelist tab, choose ‘Close Cuelist’ 

 To save a cuelist at any time select the ‘Save Changes to Cuelist’ option (A
+ S) from the Components menu. 

 

 

 When there is information in the Li
clear icon is added to the tab. Click 

Playing and moving aroun
At the top of the editor timeline and 
controls: 

ve tab that is affecting the output, a red 
on it to clear the Live tab output. 

d a cuelist  
chooser screens there is a set of player 

 

D or DVD player: The buttons work in a similar way to the controls on a C

This button… does this... 

 
Jumps to the first cue in a cuelist. 

 
Steps backwards to the previous Cue in a cuelist. 

 
Pauses playback. 

 
Starts playback of the next cue in the cuelist. 

 
Steps forwards to the next Cue in a cuelist. 

 
Jumps to the end of last Cue in a cuelist. 
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Cuelist Navigator 
The cuelist navig n es in a cuelist.  

Each cue is represe te
cues you’ve stored. As you add more cues  scrollbar 
and if there are m e t) view the 
scrollabar becom h
areas of the cuelist in 

atio  section shows you an overview of all the cu

n d by a mini cue icon in a scrollbar so you can see all the 
 more icons are added to the

or cues than can fit in the cue tile (or table or layou
es s aded and you can drag the shaded area to show different 

the list, table and layout views. 

 

The cue scrollbar incl d to add or 
delete cues. 

This icon… … 

udes buttons to switch the navigator view an

does this

 
Tiles view 

a series of tiles. If there are more cues 
area 

n drag it to show other cues.  

Shows the cues as 
than can fit in this area the scrollbar highlights the 
you are viewing and you ca

 
Table view 

name, 
e, follow time, blocking status, included 

features, fixture count and SmartFX 

Shows the cues as a table with columns for the cue’s 
number, fade tim

 
Layout view 

Shows the cues on a timeline. This view is useful if have 
cues with follow times that mean they overlap other cues. 
You can move cues and set follow times by dragging cues 
on the timeline. 

Zooms the layout view to fit all the cues in available space. 
 

Tiles View 
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In the ‘Tiles’ view: 

• each cue tile shows the number, name, duration and start 
of cue action 

the cue or cues that are vis• ible in the, in the timeline section 

• 
• the selected cue shows with a blue outline and with white 

. 

cue number, name or duration label and 
cannot be changed to a value that would 

 the blank area to the right of the cue 
list to open a pop  m

shows with a green underline 

cues that have played show with a blue fill colour. 

text. Click on a tab to select it, shift-click or ctrl-click to 
select a range or group of cues

You can click on a tile’s start action, 
enter a new value. The cue number 
mean changing the order of the cue tiles. 

You can right-click on a selected cue or in
up enu: 
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With these options you can: 

• open the cue or cuelist properties window 

 Cue start action) for the 
selected cue(s) 

unblock the selected cue 

 

• delete or renumber the selected cue(s) 

• revert (or undo) changes to the selected cue(s) 

d cue(s) 

• remove any alias cue links (without deleting any cues or 

 
options).the selected cues 

Table View 

• set the Cue Follow mode (aka

• block, superblock  or 

• append a cue at the end of the cuelist or insert a new cue 
before or after the selected cue or at the playhead position.

• change the start time of the selecte

events) 

• add an audio file 

• cut or copy and paste or paste special (paste with

• change the appearance of the cue tiles by adding or 
removing fields 

 

In the ‘Table’ view: 

• each cue shows as a row in a spreadsheet style view 

• the selected cue shows with a blue fill and white text. Click 
on a row to select a cue, shift-click or ctrl-click to select a 

up of cues. 

Y lick a 
n lue. The cue n
changing the order of the cue tiles. 

L iew 

range or gro

ou can double-c
ew va

 on a tile’s cue number, name or duration label and enter 
umber cannot be changed to a value that would mean 

ayout V
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In the ‘Layout’ view: 

• the cues are laid out end to end, in timeline view. Cues that 
are set to start before the previous cue finishes overlap and 
appear on a separate line. 

 
and agging the cue to the left or right. 

an contain as many cues as you like. To add a new cue at the end of the 
cuelist you are working on you: 

• the selected cue shows with an outline and white text. Click 
on a row to select a cue, shift-click or ctrl-click to select a 
range or group of cues. 

You can double-click on a tile’s name and enter a new value. To move a cue click
 hold while dr

Adding and deleting cues 
A cuelist c

• click on the  ‘New cue’ icon at the end of the cuelist 
scrollbar, or 

s > Append at end’ option from the 

u isting cue by first selecting a cue 

then clicking and holding the 

• choose the ‘Tools > Cue
Cuelist menu. 

Yo  can also insert cues before or after an ex

 ‘New cue’ icon until the insert popup appears.  

The

• insert a new cue before the selected cue 

• click on the 

 popup provides option to: 

• insert a new cue after the selected cue 

• append a new cue at the end of the cuelist. 

These options are also available on the ‘Tools > Cues submenu on the Cuelist 
menu. 

Deleting cues 
To delete a cue, first select it then: 

 ‘Delete cue’ icon at the end of the cuelist 

Me
Sometimes it’s useful to merge the contents of two or more cues. To do this: 
1. Select the cues with the pen or mouse. Shift-click or ctrl-click to extend the 

selection. 

scrollbar, or 
choose the ‘Delete Cue’ option Tools > Cues submenu on the Cuelist menu. 

• . 

rging cues 
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2. Choose the ‘Merge cues’ option from the Tools > Cues submenu on the 

d copying cues 
 have an effect in one of more cues of a cuelist that you’d like to use 

n

To do this: 

2. 
 cue or Cut cue from the popup menu 

3. Click on the cue before the location you want to move or copy to 

ck on the cue(s) and select 

ion.  

 You can also copy cues by dragging and dropping cue tiles in the cuelist 

in the original cue, without releasing 
 you can use the ‘paste special’ 

option on the edit menu.  

The cue scrollbar includes buttons to switch the navigator view and to add or 
delete cues. 

This option… does this… 

Cuelist menu. 

 Cues always merge to the lowest cue number. 

Moving an
Often you’ll
in another place or another cuelist. You can do this using the cuelist navigator 
pa el. 

1. Select one or more cues by clicking on the cue tiles. 

Choose the Copy or Cut option from the Edit menu or right-click on the 
cue(s) and select Copy

Choose the Paste option from the Edit menu or right-cli
Paste from the popup menu. The default paste action will restore the look of the 
copied cue by inserting release events for any features added in the intervening 
cues. To paste just the events or an alias of the cue, use the ‘paste special’ opt

navigator. 

Paste options 
If you want to move or copy just the events 
any other events that occur in previous cues

Paste the entire 
look. 

Restores the look of the original cue by inserting release 
events for any features added in the intervening cues..  

Paste only the 
events 

Pastes the events in the original cue, without adding and 
release events 

Alias cue Pastes an alias of the original cue. 
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Alias cues 
u want to use thIf yo e same cue, in a cuelist, several times you can make an 

 the associated alias cues they will all 

1. osing the copy option from the edit 

2.  the new cue to appear. 

3. menu. Vista opens the Paste 

4. OK. Vista pastes an Alias cue after the 

‘Alias’ icon and you can view the cues 
that liased cues’ section of the Cue properties 

o each other any one can be changed 
here is no ‘master’ cue in an alias set. 

1. Select the Cue tile to be changed. 

2. Select the ‘Remove Cue Alias’ option from the edit menu, or, right-click’ on 
Remove C

Making changes to a
It’s often useful to make ch h 
to the following cue. For example, you might have a cuelist where the lights 
c  blue in cu
1 cide you 
that change but since there s 6-9 the lights will stay 
yellow when you really want t

For this situation Vista pro o 
t
1. ak

2. In the timeline select the events – they will normally be highlighted already. 

‘Alias’. This way if you update any one of
update.  

To create an alias cue 
Copy the cue by selecting it and cho
menu. 

Navigate to the cue before the position you want

Choose the Paste special option from the edit 
Special window. 

Select the Alias cue option and click 
selected cue. 

Alias cue tiles are marked with a small 
are aliased to each other in the ‘A

window. 

 When two or more cues are aliased t
and all the other will also change. T

Removing the link to an Alias Cue 
An Alias cue can be changed to normal cue. To do this: 

the cue tile ‘ ue Alias’ option from the popup menu 

 cue without affecting the next cue 
anges to cue without those changes tracking throug

hange to colour
0. If you then de

e 1 and stay that way until they change to red in cue 
want them to be yellow in just cue 5 you could make 
 are no colour events in cue

hem to revert back to blue in cue 6. 

vides a method to make changes to a cue only. To d
his: 

Edit a cuelist and m e the changes. 
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3  ‘Untrack’ oolbar or select the ‘Un-track events 
ption from the Tools menu. Vista inserts events in the following 

 the lights ba ere 
hat ty d. 

Blocking a cue 
Vista is a tracking console,  
in any cue and that any inf y 
a new event or cleared. Som s 
that are subsequently made to previous cues will not affect the final look of the 
c

To do this: 
1 ith the

ile or playing the cuelist until you reach 

2 ock’ but
‘Block cue ’ option from or right-click on the cue tile and 

all tracked information 

Black’ events: 
1. Select the cue you want to work with.  

. Click on the
(cue only)’ o

button on the t

cue to set
were no events of t

ck to the state they were in before the change. If th
pe originally, Vista inserts release events instea

which means that only changed information is stored
ormation in a cue tracks forward until it is replaced b

etimes it’s useful to ‘block’ a cue so that any change

hosen cue.  

. Select the cue w  events you want to keep exactly as they are. You can 
select the cue by clicking on the cue t
it.  

. Choose the ‘Bl ton on the toolbar (normally Ctrl F9) or select the 
 the Cuelist menu 

select Block from the popup menu. Vista duplicates 
into the selected cue. 

Creating a Move in Black cue 
Sometimes you will want fixtures to move to a position, change to a colour, add a 
gobo or get set up in some other way while their intensities are at zero. You 
could do this by programming the necessary events, but you can also do it 
quickly using the ‘Mark Cue’ option on the Tools menu. 

When you create a Mark cue your original programming is preserved and will be 
restored if you delete the Move in Black (MIB) later. 

To Mark a cue and add  ‘Move in 
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2. Choose the ‘Mark Cue’ option on the Tools menu. Vista opens the Move in 
Black window: 

  

tions available; you use it to set the way Vista stores the This screen shows the op
Move in Black event: 

This option… does this… 

Move in Black 
destination cue 

If the ‘Select
can click it t

select the ‘I

 existing cue’ button is not greyed out you 
o select any cue, earlier in the Cuelist, for 

the Move in Black events. 

If you prefer to create a new cue for the MIB events 
nsert a new move in black cue’ option. 

Move in Black 
destination cue 

If the ‘Select existing cue’ button is not greyed out you 
can click it to select any cue, earlier in the Cuelist, for 
the Move in Black events. 

If you prefer to create a new cue for the MIB events 
select the ‘Insert a new move in black cue’ option. 

Cue Details – Name 

 

Sets the name for the new cue that will be created. The 
default name is MIB. 

Cue Details – Duration Sets the duration for the new cue. 
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This option… does this… 

Start action Sets how the MIB cue is started. the options are: 

Auto Follow - the cue plays automatically after the 

 w cally 
t to finish at the same time as the previous 

cue. 

Halt - Press the Go button to play this cue. 

previous cue. 

Finish ith preceding – the cue plays automati
and is se

Disable Move in Black Removes the Move in Black events from the MIB cue 
but does not delete it. 

Marked Features move in 
black.  - Feature filter 

Only the selected features will be marked for 

Marked Fixtures es Lets you choose to mark all fixtures or just the on
currently selected. 

3  crea. Click OK to te the Move in Black cue: 

 

n as 'ghosted' events in the Move in Black cue 
Black cues show ‘MIB’ in the tiled cue 

Marked cues display ‘MARK’ logo in the tiled cue display and ‘[m]’ in other 
v

ent
To do this, select eline view and select the  ‘Ignore Move 

u or right-click menu. 
vents s running through it. 

Intensity cannot 

 

The move in black events are show
and display the "MIB" icon. Move In 
display and ‘[M]’ in other views. 

iews. 

 Individual ev s in a marked cue can also be excluded from move in black.  
 the events in the tim

In Black’ option from the  from th
Ignored e

e Timeline’ men
how a MIB icon with a red cross 

 be marked. 
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C ies 
Each cue has a number, name and fade time that you can set by clicking on the 
c ing other 
advanced options mo in

To do this: 
1. Select the cue yo a

2. Choose the Cue P p  
cue tile and select the m the popup menu. 

Mod
The number and how it starts are set in the properties section of the 
window: 

ue Propert

ue tiles and edit the fields. You can also set these properties and 
re  the Cue Properties window.  

u w nt in the Cuelist navigator. 

ro erties option from the edit menu or right-click on the
 Cue properties option fro

ifying cue name, duration, and end of cue action 
 cue’s name, 

 

This option… does this… 

Cue name Sets the name that appears in all windows for this cue  

Cue number Sets the number that appears in all windows for this cue 
 The cue number cannot be changed to a value that would

mean changing the order of the cue tiles. 
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This option… does this… 

Follow Time 

(Cue Start Mode) 

sets how the cue will start, the options are: 

 (Halt) Press the Go button to play this cue 

 (Follow) Play ‘n’ seconds after the previous cue ends 

 (Start) 
previous cue. 

Play ‘n’ seconds after the start of the 

 (Timecode) Play when the timecode is received. 

Follow time 

(Timecode) 

g after the start or end of the previous cue 
starts. This field can only be edited when the 

w, Start or Timecode. 

Sets how lon
that this cue 
cue start mode is set to Follo

Default timing  Sets the timing for all events that have not been manually
adjusted. The popup window lets you select from the 
saved timing sets or customise a new one. 

Ignore Learn 
Timing 

Tick this checkbox to ignore this cue when using the 
‘Learn Timing’ feature. 

Making a cue loop back  cues 
A cue can be set to lo y 
number of times. ‘Lo : 

 and repeat previous
op back to a previous cue and to repeat the loop an
oping’ is set in the loop section of the window

 

This option… does this… 

Loop iterations Sets how many times the loop will repeat before the cuelist 
proceeds normally  

Loop to cue Sets the cue that will play next. 

Loop tracking Sets whether the events stored in the cues after the ‘Loop 
ack through to the loop cue to cue’ will tr
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This option… does this… 

Loop direction Sets the direction of the loop. The options are: 

• Forwards - loops from last to first 

• Backwards - loops from last to previous. 

• Bounce - loops backwards then forwards. 

• Random -  loops to a random cue between the first 
and last cue in the loops 

 loop don’t play automatically, like a chase. If you want 
f the cues in a loo cue 

start mode. 

A es 
lias cue tiles are marked with a small ‘Alias’ icon and you can view the cues 

that are aliased to each other in the ‘Aliased cues’ section of the Cue properties 

 Cues that are set to
any o p to play without pressing Go you have to set the 

lias cu
A

window: 

 

Tracking 
Normally features that are stored in any cue track forward until they are replaced 
by a new event or cleared. If you only want some events to play in one cue and 
not track forward you can turn tracking off for one or more cues. To do this open 
the Blocking / Tracking section of the Cue properties window and tick the ‘Non-
T ox: racking’ checkb

 

B
N only chang tures are stored in any cue and information tracks 
forward until it is replaced by a new event or cleared. Sometimes it’s useful to 
‘block’ a cue so that any changes that are subsequently made to previous cues 

hosen cue. 

locking 
ormally ed fea

will not affect the final look of the c
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To view or modify the blocking for a cue open the ‘Blocking’ section of the Cue 
properties window: 

 

This option… does this… 

None The cue is stored normally 

Blocking Ensures that events th

modified in the earlier cue(s). 

at are tracking through to the cue 
being stored will not be changed even if they are 

Super Blocking Ensures that events th

this cue being played. 

at are tracking through to the cue 
being stored will not be changed even if other cuelists, 
that include the same feature types are played prior to 

Block Features Sets which fe
Intensity, Po
Miscellaneous icons to turn 

ature types are blocked. Click on the 
sition, Colour, Gobo, Beam and 

that feature on or off. 

Block Fixtures Sets which fixtures are blocked. You can choose either 
‘All Fixtures’ or the ones you have selected in the editor. 

Free Effects mode 
In Vista effects can either h gned 
to run on top of a feature setting. For example a free circle effect will cause 
f  move in a circle e 
o from the console

To view or modify the Eve he 
Cue properties window: 

ave a ‘basepoint’ or be ‘free’. A Free effect is desi

ixtures to
r setting 

 around whatever position has been set by another cu
. 

nt mode for a cue open the ‘Free effects’ section of t

 

This option… does this… 

Events provide 
Basepoint 

Even sed as a base point for any  
basel ning. 

ts in the cue will be u
ess effects that are run
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This option… does this… 

Events stop Free 
effects 

If the
act on the effect will be stopped. 

 cue includes an event that a baseless effect would 

Audio Playback 
To add and 
Playback’ heading to open

y… 

play an audio file, when the selected cue plays  click on the ‘Audio 
 that section. 

This propert does this… 

Browse Opens the ‘Select Audio’ window where you can 
choose an audio file. 

Clear Removes the audio file from the cuelist 

 

 To add an audio file th roperties 
window. 

Cue Defaults 
If you have a set of Cue pr  
your ‘Show’ default and th
quickly reset a Cue’s prope ory defaults or to your show defaults. 

at plays through all cues use the Cuelist P

operties that you use frequently you can save them as
ey will be used for all future cues. You can also 
rties to the fact

 

This option… does this… 

Reset to show 
defaults 

Reset all cue properties to the se
t

ttings you have saved as 
ow defaults (see below).  he sh

Reset to factory 
defaults 

Reset all cue properties to their standard (factory) 
settings. 

Save as show Saves the current cue settings as a default for all new 
defaults cues. 

C rties 
Each cuelist has a  properties that control how it plays
with other cuelists. You ca rties 
window.  

uelist Prope
 set of  back and interacts 

n also set these properties  in the Cuelist Prope
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To do this: 
1. Open the cuelist in the editor. 

2  Propert  the Edit menu. 

 

. Select the Cue ies option on

 

This property… does this… 

Name Sets the name for this cuelist. 

ID Sets the number for this cuelist. This field is not 
editable. 

Priority Sets the priority for the cuelist. A cuelist set to Hi
pri

gh 
ority can’t be overridden by normal or low 

priority cuelists. Only a cuelist set to Programmer 
verride the Editor priority can o

Play at end option ter the last cue is 
played and fully over-ridden. The options are: 

ue. 

Release – the Cuelist is released. 

Determines what happens af

Restart – the Cuelist starts again at the first c

Ignore – do nothing 

Ignore Release All The cuelist will ignore the release all command. 
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This property… does this… 

Ignore Snapshots The cuelist will not be affected by a snapshot being 
loaded. 

Release in Black Releases cuelists when they are no longer 
contributing to intensity  output 

HTP Enabled Causes the intensities of a cuelist to activate as soon 
as you move the playback fader from 0.  

Fader Type Normally the fader on a playback set will adjust the 
Intensity of a cue list. To fade all features (Intensity, 
Position, Colour, Gobo, Beam and Custom) in or 
out with the slider set this property to “All 
Features” 

Fader Auto Play Sets the fade
are: 

r play and release actions. The options 

e 0% also plays 

 & Release – raising the fader above 0% 
also plays the cue. (aka ‘Go on fader up’). Lowering 

n’). 

Auto Release – lowering the fader to 0% releases 
the cue (aka ‘Release on fader down’). 

None – the fader only controls intensity. 

Auto Play – raising the fader abov
the cue. (aka ‘Go on fader up’). 

Auto Play

the fader to 0% releases the cue (aka ‘Release on 
fader dow

Fader Intensity mode Sets the fader precedence and actions.  

Normal – the fader is in normal LTP mode. 

Submaster – the fader is HTP and will go on fader 
if there is only one cue. up and release on down 

Release on Override Releases a cuelist that is completely over-ridden. 
(i.e. is not contributing to the console output.)  

Cuelist Timing 
ies click on the ‘Timing’ heading to open that section. 

Th

To set timing propert

is property… does this… 

Release Timing Sets the fade time when the cuelist is released. 

Playback rate % Playback rate for the cuelist. Normally 100% 
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Cuelist Timecode 
To set timecode properties click on the ‘Timecode’ heading to open that section. 

This property… does this… 

Mode Sets how the cuelist responds to timecode input. 

Disabled – timecode is ignored. 

Enabled – timecode will be followed if the cuelist is 
‘Armed’ (see the next property. 

Locked – timecode will always be followed 

Armed If the cuelist is set to timecode ‘Enabled’ it will
respond to timecode until it is armed. To

 not 
 arm the 

cuelist either set this property to ‘Armed’ or press 
the play button on the cuellist. 

Offset Add the offset time to
example if the offset is 01

 the cue trigger times. For 
0:00:00 (1hr) and a cue :0

trigger time is 00:00:10:00 (10 secs) the cue will go at 
01:00:10:00 (1hr 10secs) 

Cuelist Audio Playback 
To add and play an audio file click on the ‘Audio Playback’ heading to open that 

ion. sect

This property… does this… 

Browse Opens the ‘Select Audio’ window where you can 
ose an audio file. cho

Clear Removes the audio file from the cuelist 

Chase properties 

d
To set a cuelist to chase and adjust the chase properties click on the ‘Chase’ 
hea ing to open that section. 

This property… does this… 

Chase Enabled Turns chase mode on or off. 

Chase direction Sets the step order for chases. Can be set to 
forward, backward, bounce or random. 

Chase Tracking Turns tracking, within the cuelist on or off. For a 
chase tracking is normally set to ‘Not Tracking’. 
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This property… does this… 

Ch expressed as steps-ase rate Chase rate when in chase mode, 
per-minute. 

Chase crossfade % Proportion of time spent fading vs. time spent at 
each step of a chase. 

Playback rate BPM Playback rate for the cuelist. 

C ty defa
roperties you se w 

cueli s. You can also  
own show defaults. T
s

This property… does this… 

uelist proper ults 
The p t for a cuelist can be used as the default settings for all ne

 reset a cuelist to the (factory) standard properties or your
o do this click on the ‘Defaults’ heading to open that 

st

ection. 

Reset to show defaults Reset all properties to the settings you have saved 
as the show defaults (see below).  

Reset to factory 
defaults 

Reset all properties to their standard (factory) 
settings. 

Save as show defau nt settings as a default for all new 
cuelists. 

lts Saves the curre

Cuelist Notes 
You can add notes about a cuelist and these will display in the Playback window. 
To do this click on the ‘Notes’ heading to open that section. 

T anel 
ain section of t s for all the 

features that you app  you can 
only see these times as numbers, in Vista you can see everything laid out on a 
timelines so you know exactly how when changes will occur in relation to each 

This panel includes: 
1. The default timing section where you set ‘master’ fade times for all feature 

types (Intensity, Position, Colour, Gobo, Beam, Misc). 

2 led timing section where you can set individual fade times for 
every feature being used on your fixtures. 

3. The Filter bar that you use to limit the timeline display to just the fixtures or 
features or events that you want to work with. 

he Timeline p
The m he timeline is used to control the crossfade time

ly to your fixtures. Unlike other consoles where

other. 

. The detai
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Default times 
At the top of the timing section there’s a timeline ruler that controls the over all 

or all events in a cue – except the ones you explicitly set elsewhere as 
explained below. When you first open the Timeline (or Chooser) window the 
r ll be in it’s collapsed form, as shown here: 

fade times f

uler wi

 

The ‘up’ time determines how long it will take for all feature types to fade from 

 value to the value in this cue. 

down fade time click on the on the end point of the bar and 
 double arrow drag to increase or decrease the time: 

their previous value to the value in this cue. 

The ‘down’ time is only used for Intensity events where fixtures are fading out 
(i.e. getting darker or turning off). It determines how long it will take for 
Intensity to fade from their previous

To adjust the up or 
when the cursor changes to a

 

To set a delay time click on the bar an
to move the bar so that it starts after th

d when the cursor changes to a hand drag 
e 0s mark of the cue: 

 

 You can also set the up and down f de time by typing in the Timing box. For 
example typing 3 / 4 sets the Up (or infade) time to 3 seconds and the Down 

To expand the default times ruler, click on the arrow icon. 

 fade curves for the 
am, Misc) in the 

1. Vista displays the 

 

a

(or outfade) time to 4 seconds. 

Expanded Default time view 
You can set individual  default fade times, delay times and
different feature types (Intensity, Position, Colour, Gobo, Be
expanded default time view.  

To do this: 
Click on the expand arrow at the left end of the ruler bar. 
expanded view: 
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2. To adjust a feature type fade time click on the on the end point of the bar and 
 a double arrow drag to increase or decrease the 

)s mark. Or 

4.  and select from the 
drop down list 

when the cursor changes to
time. Or type a value in the corresponding ‘Time’ box. 

3. To adjust a feature type delay time click on the bar and when the cursor 
changes to a hand drag to move the bar so that it starts after the 
type a value in the corresponding ‘Delay’ box. 

To adjust a feature type fade curve click on the fade icon

This icon… does this… 

 
Sets the curve to a normal linear fade. The feature fades 
evenly from the old setting to the new setting over time. 

Linear 

 
The fade is slower at the start 

Damp 

 
The feature goes to the end state very quickly. 

Snap start 

 
Snap end 

time. 
The feature doesn’t change until the very end of the fade 

 
Square law 

The feature starts with a delay, then slides up to the end 
state. 

The feature starts quickly and the finishs slowly. 
 

Inverse square la 

 
Switch 

The feature goes to the end state very quickly. 

 
The feature

Hot power 

 goes to the end state very quickly. 

 
Flourescent 
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This icon… does this… 

 
 

Sinus 

 If you make any adjustment the default time for Position, Colour, Gobo, 
Beam or Miscellaneous that feature type will no longer be changed when 
you adjust the ‘Up’ fade time in the condensed timeline ruler.  

Saving and re‐applying timing configurations 
When you’ve set up a set of default fade times that you like, you can save it so 
you can apply it to other cues.  

n box: 

Saving timing sets 
To save a default timing set: 
1. Click on the arrow in the timing drop dow

  

2. Click on the ‘Custom Timing’ option. Vista opens the Custom timing 

 

window: 

 

5. Enter a name for the timing set in the popup box and click OK. 

6. Click OK to close the Custom Timing window. 

3. Adjust the feature type fade times using the timing bars or by entering 
values in the time and delay boxes. 

4. Click on the ‘Save as’ button 
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Applying saved timing configurations 

 

t 

To apply a timing set to a cue: 
1. Select the cue. 

2. Select the timing set you want from the Timing drop-down list. 

3. Vista applies the thing set to the cue. This will not change the timing of any 
event in the cue that has already adjusted in some way. 

Modifying the cue number, name and duration 
To change cue name, duration, and end of cue action of a cue, in the tiles or 
layout view: 
1. Select the cue with the pen or mouse. Shift-click or ctrl-click to extend the

selection. 

2. Double click on number, name or duration field. The field switches to edi
mode: 

 

 
sta you can move back and forth 

 of an 

The default timing section lets you set the timing for all the fixtures in a cue but 
when you want to make timing changes for individual fixtures or events you 
work in the timeline panel. When you select a fixture, in the editor and set 
Intnsity, Colour or any other feature Vista creates a horizontal ‘event’ bar on the 
timeline. These are the commands Vista is sending to your  fixtures. 

3. Enter a new value and press Enter on the keyboard. 

About the timeline 
The Vista uses a ‘timeline’ concept that will be familiar to you if you’ve used any 
modern sound or video editing software on a personal computer. When you 
store into a cue Vista creates an ‘event’ for each feature of each fixture that you 
use in the cue. The events are placed, on the timeline, in the cue you working on 
and when you add more cues they strung together in a cuelist. 

The idea is simple: you create a series of lighting ‘events’ that occur in sequence
when you hit the ‘Play’ button. With the Vi
through this piece of time and edit any aspect of the events that occur, in much 
the same way as you could drag a tape back and forth across the play head
analogue tape deck. 

Events on the Timeline 
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The event bars represent the activities of those fixtures over time. As you can see 
in this example, the bars go from the ‘0s’ point on the timeline scale to the ‘2s’ 
point. This means that these fixtures are moving to a new setting over two 
seconds: 

 

The settings you’ve applied to these fixtures on the palettes (e.g. intensity, colour 

nds, and the event bar represents the length of time it 

Once the fixtures get to that state they will stay like that until they receive 
mething else (e.g. change to another 

on the timeline you’re giving 
how long a parameter will take to fade 

meline only controls when the fade 

sity, position and colour 

sity, Position, Colour etc) or 

• filtered by fade path, event type and event timing 

Y  vie ilter view drop-down menu at the left hand 
e er bar. Y inimised/maximized 
s h summ  beside the feature or 
fixture names in the left column. 

and position) control the fixtures themselves. The timeline simply tells those 
fixtures to accept those comma
will take those fixtures to get to the desired state.  

another command telling them to do so
colour or fade out). 

By placing the event bars where you want them 
commands to those fixtures that tell them 
in. The parameter is determined by the palettes; the ti
starts and ends. 

Using the summary views 
You can view the events on the timeline in several ways: 

• summarised by feature, i.e. inten

• summarised by fixture type 

• filtered by feature type (Inten
Fixture type 

• filtered by fixture selection 

ou choose these ws from the F
nd of the rul
etting of eac

ou can also switch between the m
ary view using the + and – buttons
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Summary by feature 
This view shows a set of fixtures by their attributes: 

 

ws each bar minimised. To expand each attribute and seBy default, t e 
t , click the ‘ a 
displays the details o

he view sho
he details +’ symbol beside the attribute name (e.g. ‘colour’). Vist

f that attribute: 

 

Summary by fixtures
The fixture type view shows the same information but sorted by fixture rather 
t

 

han attribute: 

 

the features minimised. To expand each fixture 
bar and see 
The default fixture view has all 

the details, click the ‘+’ symbol beside the fixture you want to see. 
Vista displays the details of that attribute: 
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Filtering the All Events view 
As well as displaying the Feature and Fixture views, you can also choose to filter 
out different classes of information on the timeline. To do this, choose an option 
from the list below the line in the View drop-down menu: 

 

When you choose a filter, Vista displays only those types of 

You can create your own filters to show 
want to see. To create a filter: 
1. Choose the ‘Custom View Filter’ option from the

Custom Filter window: 

events. 

only those combinations of events you 

 menu. Vista displays the 

 

With this window you can filter by fixtures, event features and advanced 

This option… does this… 

options: 

View Type Shows fixtures in the left column 
Fixtures 

View Type 
Features 

Shows feature types in the left column 

All Filters the timeline to show All fixtures 
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This option… does this… 

Selected Fixtures  the fixtures that are 
selected in the Chooser window 
Filters the timeline to show only

In the Current the fixtures that have 
programming in the current cue. cue 
Filters the timeline to show only 

With New 
Programming 

e new 
saved. 

Filters the timeline to show only fixtures that hav
have been edited since the cue was last 

Groups Shows just the fixtures, in the groups that are ticked. 
This filter is applied after the other Fixture filters. 

Event Types Filters the timeline to show only the feature types that 
ed. Click on the ‘+’ sign beside a feature type to are tick

select just a subset of that feature. 

Fade Path Filters the timeline to show only events that are (or are 
to a particlular fade path (i.e. Linear, Snap, etc) not) set 

Event type Filters the timeline to show only events that are (or are 
ular type (i.e. Preset, Release, Move in not) a particl

Black, etc) 

Event Timing s that are (or are 
not) set to: 

• A Zero fade time 

Filters the timeline to show only event

• Follow the default times 

 
Click on the ‘Save As’ button. Vista 

3. Type a name for the filter. 

4. s filter to the drop-down filter list. 

2. shows the ‘Save As’ window 

Click the ‘OK’ button. Vista adds thi
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Managing your saved Filters 
You can rename, p Manage 
View Filters’ option fr sta opens the Manage View 
Filters window: 

du licate or modify a saved filter. To do this select the ‘
om the Filter drop down list. Vi

 

 built in filters or a custoTo modify one of the m sort you’ve saved: 
1. Select the Filter n

2. Modify the View type, Fixture selection, Event types and advanced event 
options. 

3. Click the ‘Save’ b

Renaming a Filter 
so

typing a new name. 

Duplicating a Filter 
To make a copy of a filter, select it and click on the ‘Duplicate’ button. 

At the bottom of the timeline screen there is a set of filter buttons that provide 
quick access to four popular filters. 

ame in the left-hand panel. 

utton. 

You can rename a rt by double clicking on the name, in the left column, and 

Deleting a Filter 
To delete a filter, select it and click on the ‘Delete’ button. 

One click filters 

    

This icon… does this… 
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This icon… does this… 

 All 
Shows all fixtures in the cuelist 

 Selected 
Shows just the selected fixtures. 

 Cue 
Shows the fixtures in the current cue. Useful for 
removing ‘white space’ in the timeline 

 New 
Shows just the fixtures with new programming. 

Zoo t 

nt

ming in and ou
At the bottom of the timeline screen there is a set of zoom buttons that let you 
co rol the size of the events in the timeline. 

 

This icon… does this… 

 All Zoom out to show more of the cuelist 

Zoom in to show more detail  Selected 

 Cue w a single cue Zoom to sho

Zoom out to show all cues in the cuelist  

 New Zoom to show the selected cue(s) 

Auto Toggles auto zoom on or off. This means that whatever 
e is elected is automatically zoomed to fit the window. cu

 

 The zoom op n ble on the View menu. 

’s a status bar that shows details about the 

tio s are also availa

The Editor Status bar 
Below the cuelist navigator there
cuelist you are working on and the cue that’s being edited and played: 
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In the status bar the three fields show: 

• being edited, this field will correspond to 
u have selected in the Cue navigator bar. 

• the cue, in the cuelist you are working on, that is playing 
and contributing to the console’s output. 

• the Cuelist that is open in the editor, this field will 
correspond to the selected tab. 

the Cue that is 
the cue that yo

The buttons on the status bar control how the editor interacts with the console’s 
output and playback: 

This button… does this... 

Link joins the editor and and any playback (of the cue 
being edited) to the cue you're editing. 

 

This means that when you select a cue, in the editor it 
will play. Likewise if you play a cue, from the cuelist 

If you want to edit a cue without seeing it on stage ‘Link’ 

in the status bar to inform you that you are: “Not editing 
e” 

being edited it will change the cue selection in the editor. 

should be de-selected. 

When you turn Link off and select a cue an alert appears 

the stage cu

Clicking on ‘Sync’ sets the cue showing in the editor to 
match the cue being played. Then, as you play other cues
the editor will automat

 
ically follow the cue that’s 

playing. 

However if you select a different cue, in the editor, 
playback will not be affected and Sync will automatically 
turn off. This means you can make a change to an 
upcoming cue without changing the look on stage then

 

 
click Sync again to bring the editor in line with the 
playback. 

The progress indicator 
When you hit Play, the blue line starts moving from left to right across the eve
bars in the ti

nt 
meline panel. This line shows where you are up to in this cue. If you 

hit Pause, the line stops wherever it is on the timeline; if you hit Play it starts 

Timeline 
You can create an mber 
of individual lighting events. You can th
them interactivel  

from the same spot. 

events 
y number of cuelists, each of which can consist of any nu

en combine these cuelists and ‘play’ 
y to produce your overall lightshow. 

6‐40  Vista User Guide, Version 2 



Working with cuelists  Timeline events 
 

Adding events to the timeline 
Whenever you store a cue, using ‘Store Look’ or ‘Store Part’ you create events on 
the Cuelist’s timeline. To work with those events and make timing adjustments
you open the cuelist in the editor and select the ‘Timeline’ window. 
You can als

 

o create a new Cuelist, from scratch, in the editor and work with the 
events straight away. To do this: 

1. Click the ‘New’ cuelist  icon or select the ‘New’ option on the Cuelist 
menu. 

2. Select the  icon on the main toolbar to display the Fixture Chooser 
window. 

3. Choose the fixtures you want (or select a group of fixtures by clicking on o
of the Group icons). 

ne 

n 4. On the Intensity palette, turn up their intensity to a level above zero. You ca
also set any of the other features, such as position and colour on the other 
palettes if you like.  

5. Select the Timeline  icon on the main toolbar at the top of the screen. Vista 
displays the timeline window with the features you used shown in the l
column and the timing events for those features to the right. 

About the Event bars 

eft 

summary event 
Feature events are coloured to indicate their type (Intensity, Position, Colour, 

The timeline event bars are labelled and include graphics to identify their 
function and edit status. 

Feature 

Gobo, Beam or Miscellaneous). 

 

The event label shows: 

• the number of fixtures the event applies to 

. 

• the fade time. 

Feature detail event 
You can open a feature summary event by clicking on the ‘+’ button, beside the 
feature name in the left column
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The event label shows: 

• the event sett
CMY settings and 
include icons. 

• the fade time. 

Snap events 
Events that are set to a zero second (0s)
an arrow at the left end: 

ing. In the example above the event shows the 
an icon of the colour. Not all event types 

 fade time are shaped like a banner with 

 

When you select a snap event there is only one selection handle (the aqua 
coloured square). When you click on the handle you can drag in either direction 
and once the event has a length a second handle will appear. 

C events 
Events that you’ve edited, since the cue was last saved, show with a hatched 
pattern: 

hanged 

 

around Moving events 
Each event has three attributes: a start point, duration and a finish point. The 
event bars on the tim
how long it will take 

eline show you where each event starts and finishes and 
to reach its end point: 

 

To adjust the start or end point of an event, select the event and drag it along the 
te that the grid has an automatic ‘snap-to’ feature 

 on the right-hand end and drag it left to shorten the event, or right to 

 example shown above three separate attributes of the event have 
different timings: 

plete at 2s 

the Beam event starts at 0s and is complete at 1.75s. 

timeline to the left or right. No
that makes it easy to align start and end points. 

To change the duration of an event, click on it and select the ‘handle’ (aqua 
square)
lengthen it. 

Note that in the

• the Intensity event starts at 0s and is com

• the Position event starts at 0s and is complete by 1s 

• the Colour event starts at 0s and is complete at 1.5s 

• 
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Working with selection handles 
A quick and easy way to create dynamic lighting effects is to ‘skew’ the events on 
the timeline. When you select a group of events, Vista displays a selection box 

on the corners and sides known as around them with aqua /black squares 
‘handles’: 

 

events. In this 
are selected. By selecting a 
 or finish point of the selected 

he lower edge of the 
over 2 seconds, offsetting the 

nd fade time for the individual 

You use these handles to change the duration of the selected 
example, the Intensity events of a set of fixtures 
handle and dragging it you can change the start
events.  In the example above the fixtures will fade in over 1s 

In the next example, we’ve selected the middle handle on t
selection and dragged it right to fade the events 
start and end fade times while retaining the 1 seco
fixtures: 

 

Using the selection h s of 
the selected events w
intensity, colour and beam attributes at any time while adjusting the timeline 
events. 

Making precise timing adjustments 
If you want to set the start and end a precise 
point on the timeline isually, or 
enter the ual time values. 

the set timing 
You can set event timing and optionally scale events using the ‘Event timing’ 
window. To do this select the event(s) and select ‘Set Event Timing’ option from 
the Timeline menu. You can also right-click 

 from the popu

andles in this way you can utterly transform the attribute
ith just a few quick clicks. You can also adjust any of the 

times and durations of events to 
 you can either zoom right in and line them up v

act

Using  window 

on select the event(s) and select this 
p menu.  option
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V  this scista displays reen: 

 

This option… oes this… d

Start Select to set the start time of an event 

Middle Select to set the mid point of an event 

End Select to set the end time of an event. 

TIme 

Start / Mid / End 

Enter a time to set the start mid or end of an event to that
position on the timeline. If you enter a number with no 
units Vista assumes seconds. Use h for hours, m for 
minutes, e.g. 1h2m3.5s 

 

Duration Enter a time to set the duration (or length) of an event(s). If 

Use h for hours, m for minutes, e.g. 1m2s. 
you enter a number with no units Vista assumes seconds. 

Scale Events Select
scaled

 this option if you want all selected events to be 
 when the duration is increased or decreased. 

ticked all events will be set to the same duration 
Scaling is based on the longest event. If this box is not 

Aligning start and end points 
 the 

You can also right-click on select the event(s) and select these options from the 

vents to follow the default times 
When you adjust the time of an individual event it no longer follows the cue’s 
‘default times’. To reset an event so that it follows the default, select the event 
and choose the ‘Reset to default timing’ option from the Timeline menu. 

You can also align the start and end times of selected events. To do this, select
events and then select the ‘Align Start’ or ‘Align End’ option from the Timeline 
menu. 

popup menu.  

Resetting e
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You can also right-click on select the event(s) and select these options from the 

 type but 
you can choose from a set of pre-defined fade path shapes to set how an event 

popup menu.  

Setting the event fade curve 
Vista automatically selects the most suitable fade curve for each feature

will progress.  

Select the ‘Fade Curves’ option from the Timeline menu or right-click on the 
event(s) and choose the Fade Curves option to display the fade path options: 

 

The shapes in this menu depict the fade paths you can choose: 

This icon… does this… 

 eve
Sets the curve to a normal linear fade. The feature fades 

nly from the old setting to the new setting over time. 
Linear 

 
 

Damp 

 
art Snap st

The feature goes to the end state very quickly. 

 
Snap end 

time. 
The feature doesn’t change until the very end of the fade 

 
n slides up to the end 

state. 
The feature starts with a delay, the

Square law 

 
Inverse square 

The feature starts quickly and the finishs slowly. 
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This icon… does this… 

 
The feature goes to the end state very quickly. 

Switch 

 
The feature goes to the end state very quickly. 

Hot power 

 
 

Flourescent 

 
Sinus 

 

Snap at Start.  

l of a feature. For example a 
ue but in the second 

were in previously. 
r the fixtures and features you 

se options from the 

Un
se options from the 

opup menu.  

I mpo t an event from being played back you can 
‘mute’ it. To do this sele s) and choose the ‘Mute event option from 
t e  played the 
e d

To un-mute an event choose the ‘Unmute’ event option from the Events menu. 

Y  also right-cli  the 
popup menu.  

 Instead of making an event very short, you can just set it to 

Creating Release events 
Sometimes it’s useful to have a cue release contro
cuelist might set some lights to point downstage in the first c
cue you want the lights to revert to whatever position they 
To do this you need to store a ‘Release’ event(s) fo
want to the cue to relinquish control of. 

You can also right-click on select the event(s) and select the
popup menu.  

‐tracking events 
You can also right-click on select the event(s) and select the
p

Muting events 
f you want to te rarily preven

ct the event(
he Events menu. Th
vent will be ignore

 event bar will be greyed and when the cue is
. 

ou can ck on select the event(s) and select these options from
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Stopping effects overriding an event 
 ‘Baseless’ effects are designed to run on top of a feature setting. For example a 
b ircle effect w
position is been set in ct running on an 
event, right click on the event and 

Creating an
Extracts are like prog  the attributes 
y  pal n, and so on. They also 
s ssoc

A on n save and re-
a  other cuelist u 
can save yourself a lo

E
Extracts are like progra plates and can contain any of the attributes 

ou define on the palettes: intensity, colour, beam, position, and so on. They also 
store the timing associated with the events. 

An 
app
can save yourself a lot of time re-creating your favourite lighting effects. 

Cre
 c

1. as 
act. 

• Select the Extracts button on the Components tab, in the sidebar. Then 

3. 

4. Vista adds the new item to the extract list. 

Applying extracts 
To apply an extract: 
5. Select one or more fixtures in the Fixture chooser window. 

6. Click the Extracts button on the Components tab of the sidebar. 

aseless c ill cause fixtures to move in a circle around whatever 
 a cue. If you want to stop a baseless effe

select the ‘Stop free effects’ option.  

d applying extracts 
ramming templates and can contain any of

ou define on the
tore the timing a

ettes: intensity, colour, beam, positio
iated with the events. 

n extract is a secti  of a cuelist (or range of events) that you ca
pply in s. By re-using existing material to build new cuelists yo

t of time re-creating your favourite lighting effects. 

xtracts 
mming tem

y

extract is a section of a cuelist (or range of events) that you can save and re-
ly in other cuelists. By re-using existing material to build new cuelists you 

ating extracts 
To reate an extract: 

Select the part of the cuelist or events on the timeline that you want to use 
an extr

2. To adjust a slider setting, either: 

click on the + button or 

• click on the ‘New Extract button – normally Alt-F8. 

Type a name for the extract and click the OK button. 
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7. Find the extract you want and click on it to select it. 

Set the mask butto
that is masked, ev

ns so that the attributes you want are applied. Any attribute 
en if it is part of the extract, will not be applied.  

cuel

To insert commands 
1. Open a cuelist in the programmer and choose the Insert Commands... option 

nu. Vista opens the Insert Command window: 

 

Using commands within cuelists 
Commands let you use a Cuelist to control the playback of one or more other 

ists. 

within a cuelist: 

from the Tools me

  

Select the command to insert from the Action column: 

This option… does this… 

2. 

Play, Back, Pause, 
Assert, Skip Fwd, 
Skip Back, 
Release,  

Acts on the cuelist as if you had pressed the 
corresponding button on the playback controls for that 
cuelist. 

Flash Equivalent to pressing the flash button on a cuelist’s 
playback controls. You must also enter either ‘on’ to flash 
or ‘’off’ to flash in the Parameter box. 
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This option… does this… 

Inh linds) or un-inhibits the cuelist. You must enter ibit Inhibits (b
either ‘on’ or ‘off’ in the Parameter box. 

Rate The Parameter field is a text field and only allows valid 
input (e.g. numerical BPM value). 

R lease All Releases All active cuelists. No other options are 
available when this command is selected. 

e

Timecode reset Resets the timecode to 00:00:00:00. 

Timecode enable Sets a cuelist to be activated by Timecode. 

Jum ecific cue within a cuelist. p Allows you to Jump to a sp

Snapshot Activates the snapshot selected in the parameter field. 

Release others Releases all active cuelists except the one containing this 
command. 

 

3. Select the Cuelist to be triggered from the Cuelist column  or click on the 
‘Browse’ button to open the mini components window. Open this window to 
select a cuelist, from the components window cuelists layout, and click OK.  

4. Enter an on or off command or cue number, if applicable, in the Parameter 
field. You can also click on a spot in the timeline ruler and tick the ‘Insert at 
cursor’ box to put the command at that position. 

5. The command will normally be placed in the cuelist at the current playhead 
position. If you want to put it at a different position enter a time in the At 
field. 

6. Enter a descriptive label in the Label/Description field if required. This text 
will appear alongside the command, in the timeline. 

7. Normally Vista creates a new end cue if you place the command beyond the 
end of the cuelist. If you prefer to extend the last cue of the cuelist tick the 
'Expand existing cue' checkbox. 

8. Click ‘Insert’ to insert the command and close the window. 
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Updating Presets and Cuelists during 
playback 
When you make changes in the Programmer Live tab while a cuelist is being 
played back, you can make those changes apply to the presets from which you 
constructed the cuelist, or just make the changes to the cuelist itself.  

 Update is designed to change settings that are already in a Cuelist and does 
not automatically add new events or fixtures to a Cuelist, but you can open a 
Cuelist and add new information in the programmer window on the Update 
window. 

Existing information 
To update existing information: 
1. While a cuelist is playing, go to the Live tab in the Programmer window and 

select the fixtures you want to change. 

2. Make the adjustments you want using the palettes or hardware controls. 

3. Click the Update icon , or choose the Update option from the Tools 
menu. 

4. Vista displays the Update window: 

  

Here you can choose whether to apply the changes to Cuelists or Presets if they 
are in use. You can also filter the changes by fixtures and parameter. By default, 
Vista selects the presets. 
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5. To make the changes to all Fixtures in the Cuelist or Preset, click the ‘All 
e changes to just the selected fixtures click 

6. You can use the parameter filter icons to select or de-select the features you 
want to include in the preset - Intensity, Position, Colour, Gobo, Beam and 

rmation about the parameter filter bar refer to Presets on 

7. To apply the an s 
in the Presets n
Cuelists pane to a
presets.  

8. When you’ve def  apply your changes, click the OK 
button to ret  t

fixtures’ button. To make th
‘Selected fixtures’ button. 

Misc. For more info
page 5-45. 

 ch ges to presets, click the checkboxes beside the preset name
 pa e or, click the checkboxes beside the cuelist names in the 

pply the changes to one or more cuelist rather than to the 

ined how you want to
urn o the Programmer screen. 
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7. SmartFX 

Effect types 
Vista provides several effect types: 

• Wave effects where Intensity or Colour or Position or any 
other feature of your lights fo
sort of effect you can create In
shapes such as a circle and Colour 
rainbows and more. 

• Swing effects where Intensity or
other feature of your lights crossfad
other IPCGBM settings. 

• Video effects that use an animated
Intensity and Colour of a group of fi

llows a waveform. With this 
tensity chases, Position 

mix effects including 

 Colour or Position or any 
e between presets or 

 gif to control the 
xtures – usually 

 

ista’s built in template effect or  

• modify a template effect or  

• create your from scratch, using the SmartFX 
win

Applying a stored t m
To apply an effect: 
1. In the Fixture Choose

2. Click the Components tab in the sidebar and select the FX button. Vista 
displays the list of av a

arranged in a matrix. 

Using effects
To run an effect on your fixtures you can either: 

• apply one of V

own effects 
dow. 

e plate effect 

r window, select the fixtures you want to use. 

ail ble template effects: 
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The icon indicate e  
features are in thi ff

This icon / letter… 

s th  effect type and letters in the ‘Content’ column show which
s e ect: 

indicates this… 

 I 
. An Intensity effect

A Position effect.  
 P 

A Colour effect.  
 C 

 Matrix / 
Multi-element 

matrix on page [TBC]) or multi-element fixture (a 
fixture with more th

An effect designed to run on a matrix (See creating a 

an one light source – for example 
a 4 cell ColourBlock.  

Multi-feature 
(i.e. IPC---) 

ne feature. For 
example the ‘BallyColour’ effect . 
An effect that includes more than o

 If a template effect is greyed out it means that the template cannot be applied 
re type(s) 

3 To apply an effect, click 
r  the select

4 peed a open the SmartFX 
window and use the 

Using the SmartFX
To adjust the speed and o ndow 
by either: 

• clic artFX button on the main toolbar – usually 
F11, or 

• selecting the SmartFX Editor  option from the Tools menu 
(Ctrl + K). 

to the fixtu you have selected. 

. on the one you want. The effect you’ve chosen starts 
ed fixtures. 

nd other settings of an effect, 

unning on

. To adjust the s
controls to adjust it. See the following section 

 window to modify an effect  
ther parameters of an effect, open the SmartFX wi

king the Sm
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The SmartFX has two panes: the effects list, on the left and effect controls on the 
right: 

 

The ‘Show effects from…’ pane normally shows the effects that are active (i.e. 
running in the Live tab or in a Cuelist). 

The
You can filte  the 
fixtures they are being ap

This option… 

 Effects list 
r the list of effects by their source, whether they are active and

plied to.  

does this… 

Source 

Popup selector 

 

cts running 
on the Selected Playback 

 

The source popup filters the effects list by source:

• Anywhere includes all effects 

• Selected Cuelist includes just the effe

• Editor Cuelist includes effects running in the 
Live tab and any Cuelists (tabs) that are open in
the Editor 

• Editor Current Cue includes effects running in 
the selected cue in the Cuelist being edited. 

Active only  are 
tage.  

Filters the effects list to only show effects that
being played – that is the ones you can see on s

Selected Fixtures Filters the effects list to only show effects that are 
being run on the selected fixtures.  

New Effect Creates a new effect with your own settings.  See 
Creating an effect from scratch on page 7-12
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This option… does this… 

Save as template Click this button to save the effect as a template th
will appear in the Components list and Quickpickers.

at 
 

W  click on an effe ntrols 
for this effect in the right 

Effect controls
The SmartFX Control Panel co

• Rate c ffect. 

• Feature ntrols for the effect 
waveform, size, rate multiplier, and direction 

• A S
spr

• An ects 
and his tab is 
also th other cues and 
effe

Rate control 
Effects can include one or more feature types (IPCGBG). The rate controls apply 

a

hen you ct in this list, Vista displays the settings and co
hand pane. 

 
ntains: 

ontrols that apply to all feature types in your e

type  tab(s) (IPCGBM) with co

equence tab with controls for fixture overlap, sorting, 
ead and ganging. 

 Advanced tab, where you can add additional eff
 synchronise or offset the effect waveforms. T
 used to set how the effect interacts wi
cts during playback 

and are common to all fe tures in the effect.  

does this… This option… 

Rate BPM Sets the base rate at which the effect runs, expressed 
in beats-per-minute (BPM).  

Rate popup: This control affects whe

• per cycle 

• per item 

cycles-per-minute or fixtures-per-minute: 

Per-cycle - if the effect is an intensity chase at a Rate 
of 20 BPM Per-c

ther the Rate is based on 

ycle, then the whole sequence will 
repeat 20 times each minute. 

Per-item - if the chase is at a Rate of 80BPM Per-item, 
then the chase will cover 80 fixtures each minute. The 
loop time of a Per-item effect varies with the quantity 
of fixtures used, and is slower with more fixtures. 
This means the fixture-to-fixture rate (e.g. a flash 
rate) will be constant no matter now many fixtures 
are used. 

(was per-fixture) 

Disable / Enable This button disables or enables the selected effect. 
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T (s) for ‘W
Effects can include one or more feature types (IPCGBG). Vista creates a feature 
tab for each type with con d 
direction. 

he Feature tab ave’ effects 

trols for the effect waveform, size, rate multiplier, an

 

Click on the feature tab (i he controls: 

ure tab(s) wi e. 

This option… 

.e. Intensity) to see t

 The feat ll not appear unless the effect is selected in the left pan

does this… 

Size 

(was Amplitude) 
 to size 50%, on a set of 

fixtures they will modulate between 0 and 50% 
intensity. 

For effects that run on more than one channel (i.e. 
Position and Colour mix) there is a separate size 
control for each channel 

For swing effects there is no size controls since only a 
value of 100% will reach the endpoints.  

Size affects how much of the effect waveform is 
added to the feature. For example if you run an 
Intensity wave effect, set

Rate 

(was Rate Multiplier) 

To maintain synchronization between the features of 
an effect you can scale the rate for each feature as a 
multiple of the base rate.  

To make a feature run slower than the base rate set 
the feature rate to lower value (e.g. x½ or x¼ ).To 
make a feature run faster than the base rate set the 
feature rate to a higher value (e.g. x2 or x4 )  

Direction Mainly useful for chasing effects, this controls 
whether fixtures are sequenced in ascending 
(forward), descending (backward) or both directions 
(bounce). 
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This option… does this… 

This tab shows the available effect waveforms, in 
graphical form. To select a waveform click on one of 
the buttons. 

When multiple waveforms are being used the 
buttons show the effect that will be created. For 
example 

• Position – shows buttons for creating shapes 
including a Circle, Square, Can-can, Triangle, 
Figure 8, Spiral, Bally Hoo and Spread circle. 

• Colour Mix – shows buttons for a Rainbow 
wave, RGB, CMY and more 

 
Base tab 

Waveform buttons 

Base tab 

Visual editor 

Below the waveform buttons, Vista displays a 
preview of the waveform(s) in the effect. For position 
and colour effects this section also provides size 
controls for each of the feature waveforms. For 
example a position effect has one waveform 
operating on Pan and another on Tilt. 

You can change the offset of the waveform(s) by 
clicking in the preview window and dragging the 
waveform to the left or right. 

 

On this tab you can select the waveform type and the 
phase offset of the waveform. For position and 

t operate on more than one channel 
a waveform, rate multiplier and phase Customise tab 

colour effects, tha
there is also 
offset control for each channel. 

 

The Feature tab(s) for ‘Swing’
For swing effects there are n
the endpoints. Likewise the  ts are 
designed to bounce between endpo

 effects 
o size controls since only a value of 100% will reach 

re is no direction control because ‘swing’ effec
ints. 
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 The feature tab(s) will not appear unless the effect is selected in the left pane. 

ion… This opt does this… 

Stop 

win

Clicking on a ‘Stop’ icon pauses the swing effect so 
that you can set a value for the feature. To set a value 
choose a preset or set a value in the sidebar palette 

dows. 

Beats Sets the number of beats the effect will remain on 
each point before fading to the next point. 

Feature shows the type of features included in the swing 
points 

Value shows a value or graphical representation of the 
setting for the swing point. 

Curve ade 
curves’ on page xxx 
Sets the fade curve to the swing point. See ‘F

Run effect Click the ‘Run effect’ button to start the swing effect 
running if it has been stopped. 

Click the + (Plus) button to add a swing point.  

 Click the - (Minus) button to delete the selected 
swing point. 
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The Sequence tab 
When you apply an effect to a number of fixtures you can use the controls on the 
sequence tab to set how the effect is applied to those fixtures. 

 

does this… This option… 

Overlap 

ially – 

ach fixture executes the effect 

orks in conjunction with Spread to 
achieve synchronized chases & wave effects. 

affects how much each fixture overlaps the next 
when the effect is running:  

• At 0% each fixture runs the effect sequent
there is no overlap 

• At 100% e
simultaneously. 

This control w
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This option… does this… 

Spread Vista dyna
value for ea

• 

• 

Overlap con

nothing. 

Overlap & 

mically calculates a waveform offset 
ch fixture depending upon this control: 

Spread = 0% - all fixtures have a uniform offset  

Spread = 100% each fixture has a unique offset 
ranging from 0% to 100%. 

Normally this control will be left at 100% unless the 
trol is at 100%, otherwise there will be 

periods when all fixtures will appear to be doing 

See below for a simple SmartFX tutorial using 
Spread. 

Sort Fixtures when an effect runs you can sort the fixtures in a 
number of ways: 

• ID sorts the fixtures by number order. 

 sorts based on the order in which you 
selected them in the Chooser. 

 

n 
’ 

• Selection

• Random sorts the fixtures in a random order.

• Position sorts the fixtures by their position on 
the Fixture Chooser layout. Fixtures are sorted 
from top left to bottom right. 

To reverse the sort order click on the drop dow
box and choose either ‘Ascending’ or ‘Descending

Spread Shape 

 

es 

st to last. The effect starts on the first fixture 

• Pairs, outside to inside. The effect starts on the 

the spread shape buttons control how the effect 
runs across the fixtures. There are 4 spread shap
available: 

• Fir
and runs to the last. 

2 end fixtures and into the centre. 

• Last to first. The opposite of 1. 

• Pairs, inside to outside. The opposite of 3. 

Curve 
this 

xtures are evenly distributed. Other 

others out. 

sets the distribution of fixtures, along the effect 
waveform. The normal setting is ‘Linear’and in 
case the fi
curves, such as square and inverse square will 
bunch some of the fixtures together and spread 
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This option… does this… 

Fixture Ganging 

Blocking t the effect runs across 

so that two or more fixtures 

s are 
effect. 

• when set to 2/1/3 for a set of 12 fixtures they’d 
be ganged in a pair, then a single, then threes. 

sets how the set of fixtures are grouped together. 
‘No Blocking’ indicates tha
the fixtures one at a time.  

Fixtures can be ganged 
are doing the same thing. For example:  

• when set to 2, adjacent pairs of fixture
ganged together in the 

Fixture Ganging 

Repeats 

allows non-adjacent fixtures to be ganged together. 

• a repeat of 2 sets every third fixture to be doing 

a repeat of 3 sets every fourth fixture to be 

The ‘Preview’ panel shows how the fixtures will be 

the same thing. 

• 
doing the same thing. 

ganged together. 

Change Fixture click this button to 
Selection [TBC] 

 

The
This tab

more than one feature in an effect – for example an effect 

ve an effect you’ve modified or created to the list of 
template effects. 

 Advanced tab 
 is used to: 

• synchronise or offset the effect waveforms when there is 

that includes both Intensity and Colour features. 

• set how the effect interacts with other cues and effects 
during playback 

• sa
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This option… 

 

does this… 

O fset 

ase offset) 

adjusting the Offset value, rolls the waveshape 
within its own window. For example a 0% Phase 
offset for a sine waveform would start and end at 

f

(Ph

You can adjust the offset of a feature by either 
or entering a 

een 0 and 360 in the offset field 

the midpoint while a 25% Phase offset would have 
the sinusoid start & end at the high point. 

dragging in the waveform window 
value betw

+ Add Click the + icon to add a new effect type that is 
synchronised with the other features(s) in this 
effect. 

- Delete  effect feature. Click the - icon to delete the selected

Basepoint sets what happens when fixtures that are running 
an effect receive a new setting for the same feature 
type. For example if a circle position effect is 

 cue runs that sets 
those fixtures to a different position. 

tops 

If the basepoint is set to Free the effect continues to 
t will take it’s basepoint from the new event. 

 - Bound 

 - Free running on a set of fixture and a

If the basepoint is set to Bound the effect s
running. 

run bu
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Creating an effect from scratch  SmartFX 

This option… does this… 

S c at Start sets what happens as this effect star
effect is already running. 

yn ts when another 

nc the effect starts on the same phase as the 
already running effect 

ffect always starts at it’s 0 point and so 

No-sync . [TBC] 

Auto-sy

Restart the e
will always look the same when it starts. 

  

 

Cr

1. , select the fixtures you want. 

2.  main toolbar or choose the ‘SmartFX Editor’ 
menu. Vista displays the Smart Effects window. 

3.  the bottom of the left pane, to display the Create 

4. Click on one of the effect type buttons. Vista provides several effect types: 
lour or Position or any 

other feature follows a waveform. 

• Swing effects that that move between two or more presets or IPCGBM 
settings 

• Video effects that use an animated gif to control the Intensity and 
Colour of a group of fixtures – usually arranged in a matrix. 

5. Choose the Feature type you want to use in the effect  (e.g. intensity, or 
position or colour) 

6. ‘Type a name for your effect in the ‘Name’ box 

7. Click OK display your effect in the SmartFX window: 

8. Adjust the controls in the right hand panel of the window to apply the effects 
you want. 

Making your effect swing 
If you chose the ‘Swing’ button in the Create effect window, you have to define 
the end points of the effect (i.e. where it starts and where it finishes).  

eating an effect from scratch 
To create your own effect: 

In the Programmer Fixture window

Click the SmartFX button on the
option from the Windows 

Click the New button, at
Effect window: 

• Wave effects where the setting for Intensity or Co
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SmartFX  Stopping an effect 
 

In this case, when you click OK, Vista adds two swing point  in the feature tab of 
the SmartFX window. 

T lu
1. Click the first  ‘Stop’ button. 

and define its settings in the same way. 

Swi te, 
poin plex effects. Click on the + button to add another point. 

as Template’ button. Vista 
 a name and location for the effect.  

ct and choose where to save the effect. You can save 
r or Show folder. Saving the effect in the 
er the effect between different consoles. 

our effect to the list of effects. Next time 
your effect will be in the list. 

Stopping an effect 
There are two ways to stop an effect and have the fixtures revert to their original 

• you can stop just a particular effect, or 

type. 

res.  

op the effect running on. 

To s

3. Select the fixtures that you want to stop the effect running on. 

o set va es for the two points: 

2. Use either the palettes or the controls to set a value for the feature type you 
are using . 

3. Click the second  ‘Stop’ button 

4. Click the ‘Run Effect’ button to start the effect swinging. 

ng effects always have two end points but you can add more, intermedia
ts to build more com

Saving your effect 
To save an effect you’ve created: 
1. Select the Advanced tab and click on the ‘Save 

displays a small window asking for

2. Type a name for the effe
the effect in either the Factory or Use
Show folder makes it easier to transf

3. Click on the OK button. Vista adds y
you click the FX tab on Sidebar, 

or default values for the feature(s) that were running in the effect: 

• you can stop all effects that are running, or 

• you ca stop just particular effect 

Stopping all effects 
To stop all the effects that are running on your fixtu

1. Select the fixtures that you want to st

2. Choose the ‘Stop SmartFX’ option from the Tools menu. 

Stopping a particular effect(s) 
top one or more of the the effects that are running on your fixtures.  
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Stopping an effect  SmartFX 

4. Click the SmartFX button on the main toolbar – usually F11, or select the 
SmartFX Editor  option from the Tools menu (Ctrl + K). 

To stop effects that are running on a feature type – i.e. Intensity, Postion, Colour 

1. top the effect running on. 

2. 

ou want to stop – Intensity, 
a popup menu: 

5. Select the effect you want to stop from the list of effects. 

6. Click on the Disable button. 

Stopping effect running on a feature 

etc.  

Select the fixtures that you want to s

Click on the Palettes tab, in the sidebar, if it’s not already selected. 

3. Click on the feature type icon for the effect type y
Position, Colour, Gobo or Beam. Vista opens 

  

4. From the popup menu select the ‘Stop Effect’ option. 
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Assigning Audio to a Cuelist  Stopping an effect 
 

8. Assigning Audio to a Cuelist 
You  and play it in Vista. This can be 
useful if you want to

To a
1. tion from 

the Edit menu or, right click on the Cuelist icon in a Quick picker and select 

 can assign an audio track to a cuelist or cue
 programme for a particular piece of music or dialogue. 

ssign an audio file to a Cuelist 
With the cuelist open in the editor select the ‘Cuelist properties’ op

the‘Properties’ option from the popup menu. Vista displays the Cuelist 
properties window: 

 

2. If it’s not already open click the arrow to open the Audio Playback’ section. 

Click the browse button and navigate to the folder containing your audio 
files, select a track and click the Open button. Vista copies the audio file to 
the ‘Audio’ folder inside your Vista Data showfile folder. 

3. 

he rack with it but will 
 

To assign an audio file to a specific Cue 
ou can also assign audio to a single cue in Vista. This can be useful to play  

. With the cuelist open in the editor select the Cue then select  ‘Cue properties’ 
option from the Edit menu or, right click on the Cue tile and select the ‘Cue 
Properties’ option from the popup menu. 

4. Click OK to close the Cuelist properties window. 

W n you play this cuelist Vista plays the selected audio t
only continue playing for the overall time of the Cuelist. To be able to hear the
entire track you may need to add or lengthen cues. 

Y
sound effects or or short pieces of audio. To do this 

1
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Using Learn Timing to adjust cue timing  Assigning Audio to a Cuelist 

2. Follow steps 2 – 4 as above. 

Using timing 
You can programme a Cuelist then use the ‘Learn timing’ window to adjust the 

nt to fine-tune 

ption from the Tools menu. Vista opens the 
w: 

 Learn Timing to adjust cue 

Cue start times based on your actions. This can be useful if you wa
Cue timing to an audio or video track. 

Using Learn Timing 
1. Open the Cuelist you want to use. 

2. Select the ‘Learn timing…’ o
Learn Timing windo

 

To keep the existing timing for cues tick the ‘maintain Cue Duration’ 
checkbox. If this box is not ticked all 

3. 
cues (and their events) will be stretched 

djusting cues to timecode 
4. If you want to learn timing based on a Timecode source tick the ‘Enable 

Timecode’ checkbox. Vista will then display the Timecode viewer (and 
controls if you are using internal timecode). If you are not using timecode 
leave this box unchecked. 

or shrunk to match the time between cue start times. 

A
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Assigning Audio to a Cuelist  Using Learn Timing to adjust cue timing 
 

Adjusting cues based on audio or video 
are listing You can adjust cue timing to match the audio in a cuelist or while you 

to or watching a recording. To do this: 

5. Click the skip to start button , in the Learn Timing window, twice to 
ensure you are at the start of your first cue 

utton 6. When you are ready click the play b , in the Learn Timing window to 
g 

r you want the next cue to start. 
All subsequent cues are automatically set to ‘Follow’ mode with their start 

ation to the previous cue. 

Vista automatically changes the cues start action to ‘Follow’ and adjusts the start 

 

set the start time of the first cue. If you have enabled timecode the timin
field of the first cue will be automatically changed to a timecode type. If you 
are not using timecode the start of the first cue will be set to Halt. 

7. Continue to press the play button wheneve

time adjusted in rel

8. When you are finished click the Done button to close the learn timing 
window. 

time in relation to the previous cue. To see how your cues will playback in 
relation to the timeline and each other, click the  ‘View cues in layout mode’
button 

 

 Tip: When you use ‘Learn timing’ with 
start at a Timecode and then uses Vista’
cues. If you want every cue to be se
the Follow cues convert their start times to Time

1. Select all the ‘follow’ cues by shift clicking in the 

2. Select the ‘cue properties’ option from the Edit 

Timecode, Vista sets the first cue to 
s internal clock to start the following 

t to timecode mode you can change all 
code. To do this: 

cue tile view 

menu 

3. If it’s not already open click the triangle button beside the Timing option 

4. Click on the green Follow  icon and change it to Timecode  
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9. Automating Playback 

Using Timecode
You can use Linear Time Time Code (MTC) to trigger cues. 
To do this see If you are going to be using timecode to running the Vista in 
c  a device ate the 
timecode so you can get y n time without needing the actual 
timecode from the other device. 
To set up the timecode: 
1. Choose the Timecode option from the File menu. Vista displays the timecode 

   to control Cuelists 
Code (LTC) or Midi 

onjunction with  that generates SMPTE timecode, you can simul
our show running i

properties window: 

 

rce. The2. Set the Timecode sou  options are Linear Time Code (LTC), MIDI 
Time Code (MTC) or Vista’s Internal clock 

3. Set the Frame rate from the drop down menu. 

4. Set the Timecode Offset if required. The offset time is added to the incoming 
timecode. For example if the offset is 01:00:00:00 (1hr) and the incoming 

e is 00:00:10:0 though 01:00:10:00 (1hr 
10secs) is received.  

5. Hit the Start button t  and the Stop button to stop 
it. The Time Code field shows the elapsed time, and hitting the Reset buttons 

eld. 

. To close the window, click the ‘X’ symbol in the top right corner. 

timecod 0 (10 secs) Vista will treat it as 

o start the timecode running

clears this fi

6
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Automating Playback  Using Date and Time to control cuelists 
 

Playback Lag Compensation 
The Lag compensation field is used to compensate for slow midi data 
transmission. If your cues are not running at the expected time you may need to
enter a value in this field. For example enter

 
ing 0.5s will mean that all your cues 

run half a second earlier than programmed. 

rnal device such as a Tape player. When Vista encounters a 
P  

simu s control. 

Disable option from the Timecode 
 you want temporarily to stop timecode 

 cuelists  
and more 

 and time events. To do this select 
 the Tools menu. Vista opens the Date 

Timecode dropouts 
The Freewheeling time field is used to cope with errors in the SMPTE code 
coming from an exte
SM TE error it will simulate timecode for a period before assuming the timecode
has ended. This field sets the number of seconds Vista will allow to pass while it 

lates SMPTE until it relinquishe

Disabling all timecode 
To disable timecode for all cues, choose the 
source drop down. This can be useful is
from triggering your cuelists. 

Using Date and Time to control
You can set Vista to automatically play cuelists, trigger snapshots 
based on the date and time. 

Managing date and time events 
You can add, delete, edit duplicate or test date
the ‘Date and Time events…’ option from
and Time Events window: 

 

T ndow displays a l

This option… 

his wi ist of all your Date and Time events.  

does this… 

New Opens the ‘New Date and Time Event’ window 
d where you can set up an event to be triggered base

on the date and time. 

Delete Deletes the selected event. 
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This option… does this… 

Edit Opens the selected event so that you can modify it’s
settings. 

 

Duplicate Duplicated the selected event 

Test Now Click this button to test the event, no matter what 
the current time is. 

Global Enable You can disable all date and time events by un-
checking this box.. 

Close Closes the window 

S p a new d
o set up events that will be triggered based on the date and time, choose the 

‘Date and Time events he Date and 

Th does this… 

etting u ate and time event 
T

…’ option from the Tools menu. Vista opens t
Time Events window 

is option… 

New Opens the ‘New Event’ window where you can set 
up an event to be triggered based on the date and 
time. 

+ Add Click the + icon to add a new effect type that is 
synchronised with the other features(s) in this 
effect. 

Delete Deletes the selected event. 

Mo Opens the selected event so that you can modify it’s 
settings. 

dify 

Duplicate Duplicated the selected event 

Checkbox If the checkbox, beside an event, is NOT ticked the 
event will not be activated. 

Global Enable You can disable all date and time events by un-
checking this box.. 
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Disabling all date and time events 
Y
T
te

Choose the New Event... option from the Date/Time Events window. Vista 
opens the New Event window: 

ou can also disable all date and time events by choosing the Disable All 
ime/Date Events option from the Vista menu. This can be useful is you want 
mporarily to stop events being triggered. 

Creating a New Event 
Date / Time events can automatically control playback and other actions. To 
create a new event: 
1. 

 

2. Select the command to insert from the Action column: 

This option… does this… 

Play, Back, Pause, 
Assert, Skip Fwd, 
Skip Back, Release,  

Acts on the Cuelist as if you had pressed the 
corresponding button on the playback controls for 
that clip. Select the Cuelist from the Target column 

Flash Equivalent to pressing the flash button on a 
Cuelist’s playback controls. You must also enter 
either ‘on’  ‘off’ or ‘toggle’ in the Flash enabled box 
to set the flash button action. 

Inhibit Inhibits (blinds) or un-inhibits the clip. You must 
also enter either ‘on’  ‘off’ or ‘toggle’ in the Inhibit 
enabled box to set the flash button action. 
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Creating a New Event  Automating Playback 

This option… does this… 

Rate The Rate field is a percentage field and only allows 
valid input (e.g. numerical % value). 

Release All R
available when this command is selected. 

eleases All active Cuelists. No other options are 

Timecode reset R ode to 00:00:00:00. esets the timec

Timecode enable Sets a Cuelist to be activated by Timecode. 

Jump A
C rom the popup menu 
in the Cue field. 

llows you to Jump to a specific Cue within a 
uelist. You can select a cue f

Snapshot Loads the snapshot selected in the Target box 

 

3. Select the Cuelist to be triggered from the target column. 

4. Enter an on or off com licable, in 
the option field. 

5. Type a label for the Event in Name box. 

6. Set the time of day, to trigger the event, in the Time box. The time is 
ed as a 12 hour

7 u want an event t cify 
the number of times to een 
repetitions. 

e check 

art 

12. Click the OK button to save the event. 

mand or rate setting or cue number, if app

display  AM/PM clock. 

. If yo o repeat periodically, check the Repeat box and spe
 repeat and the Interval (in minutes), betw

8. Select the days of the week you want the event to run on by ticking th
boxes. 

9. If you want an event to only be activated after a certain date. Tick the St
Date box and specify the date when the event should first be triggered. 

10. If you want an event to stop running after a certain date. Tick the End Date 
box and specify the date when the event should last be triggered 

11. Tick the Enabled checkbox to activate the event. If this box is not ticked the 
event will not run. 
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10. The Pla rol Window yback Cont

Controlling an
 you’ve got a full sho e multiple Cuelists 

on the console and being played back.  

d monitoring playback 
When w going it’s likely that you’ll hav

 
To see what’s going on at any time, click the Playback Control button on the 
main toolbar at the top of the screen. Vista displays the Playback Control 
window: 

 

t can be 
ng line and dragging the divider to the 

left or right. 

 pane 
The left side of the screen displays a 
twelve columns that show playback status 

This screen lists all the cuelists that are playing and gives you a handy point from 
which to control and edit them. The window is made up of two panes tha
resized by clicking on the vertical dividi

Cuelist
list of all Cuelists and can display up to 

and some Cuelist properties.  
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This column… indicates… 

Cuelist Name The name of the Cuelist. 

Current Cue Shows the current Cue name and number. Cuelists 
that have not been run show the first Cue name. 

Status The Playback State of the cuelist 

 - HTP set o

- On Playback.  The Cuelist is on a playback control. 

- SMPTE timecode locked (not implemented) 

n  

- Audio (not implemented) 

- Inhibited 

Active Shows if the Cuelist is playing or has been played. 

Priority Shows the priority of the Cuelist. 

Programming Shows the features (Intensity, Position, Colour, 
Gobo, Beam) programmed in this cuelist. 

HTP Shows the ‘HTP Intensity’ property setting. 

Release Time Shows the Cuelist’s release time. 

Inhibited Shows if a Cuelist has been inhibited (made blind). 

Notes This column is for notes and comments. To add a 
note click, double click on the notes cell. 

 

You can change the setting of a cell by double click on the cel
selecting from a list of options or entering a new
on the cell to open an editing window for that c

You can sort the Cuelist list by clicking on any of 
example to show all the Cuelists that are on play
list, click on ‘On Playback’. Click the column heading again t

You can resize columns by clicking between th
column to suit. To show or hide columns 
‘Show/Hide fields’ from the popup menu. 

Cue pane 
The right column shows the Cues in the Cue
divided into six columns that show Cue detail an

l and either 
 value. You can also right-click 

ell. Not all cells are editable 

the column headings. For 
back controls, at the top of the 

o reverse the order. 

e headings and dragging the 
right-click in the Cuelist pane and select 

list selected in the left column and is 
d progress: 

This column… indicates… 
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This column… indicates… 

ID Shows the Cue number  

Cue Shows the Cue name. 

Programming Shows the features types programmed in this cue. 

 Click this button to play the cue 

Progress Provides a visual display of the Cue’s progress and 
Shows the progress of the Cue as a percentage 

 Click this button to skip to the end of the cue 

Time Shows the elapsed time, time remaining and total 

seconds 

fade time for the Cue. I.E. 
1/5 [6] 
Elapsed time is 1 second 
Time remaining is 5 
Total fade time is 6 seconds 

Follow Action 

ts ‘n’ seconds after the end of 
the previous cue 
Wait – the next Cue will play when Go is pressed 

Shows how the cue starts. 
Start – the Cuelist starts ‘n’ seconds after the start of 
the previous cue 
End – the Cuelist star

Follow delay Shows the delay time for the ‘follow action’ 
described above. 

Notes This column is for notes and comments. To add a 
note click, double click on the notes cell. 

 

Con ack buttons 

Too

his… 

trol and Playb
You can use  playback button toolbar to control one or more Cuelists. To show or 
hide the playback buttons choose the ‘Playback Control’ option from the 

lbars submenu on the View menu : 

This button… does t

 
Jumps to the start of the Cuelist 

 
Cues backwards to the previous Cue marker of the 
selected Cuelist 
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This button… does this… 

 
Pauses playback of the selected Cuelist(s) 

 
Commences (Go) Playback the selected Cuelist(s) 

 
Cues forwards to the next Cue of the Cuelist 

 
Jumps to the end of the selected Cuelist. 

 
Releases the selected Cuelist – fixtures return to their 
previous settings: 

Filtering the cuelists 
If the ‘Only show active cuelists’ button is highlighted only cuelists that are being 
played will be shown in the left pane. You can also set the this option on or off 
from the  View menu. 

Auto Scroll 
If the ‘Auto Scroll’ option is highlighted you the cue panel will scroll to keep the 
current cue visible. You can also set the this option on or off from the View menu. 

Dragable playhead 
If the ‘Dragable Playhead’ option is ticked you can control a Cuelist’s playback 
by clicking on the Cue progress indicator bars. You can also set the this option on 
or off from the View menu 
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Click on the > button on the left side, of the bar, to play the Cue, click on the >> 
button to go to the end of the Cue or click anywhere in the Cue bar to jump to 
th

If the ‘Dragable Playhead’ button is highlighted click on it (so it is de-selected) to 
prevent accidental triggering of Cue . 

 

2. Choose from the list of options or enter a new name, time etc. 

3. Press the Ent k

To use the Edit field w
1. Select one or r or 

control key. 

2. Right-click in e
Vista opens the Edit field window. 

3. Enter a new name, time etc. 

4. Click the OK button. 

at point. 

Search 
You can search for a cuelist or cue by clicking on the corresponding search 
button.  You can also do this by choosing the ‘Search’ option from the View 
menu. 

 

Editing in the Playback control window 
There are two ways you change Cue names, times and end-of-Cue actions from 
within the Playback control window. You can: 

• double-click on the Cue Name, Time, At End setting or 
Notes field and edit the field directly. 

• right-click on the Cue Name, Time, At End setting or Notes 
field and select the ‘Edit field of selected Cue(s)’ option 
from the popup window. 

To edit a field directly 
1. Double-click on the Cue Name, Time, At End setting or Notes field. 

er ey or click away from the field. 

indow 
 mo e Cues. You can select a range of Cues by using the shift 

 th  field that you want to change and select the edit option. 
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11. Using the console hardware 

Console layout 
Vista consoles and control surfaces provide the faders, encoders, switches and 
displays you’ll need to control your lighting rig. The layout of each product is 
slightly different and the quantity of playback controls varies. 

T4 Console 

 

es: The T4 console featur

 
on buttons, 2 sets of modifier buttons, a 

• dules with faders 

• LCD Pen/Tablet module that includes, the Grand Master &
DBO, 12 Functi
keyboard & trackpad 

4 Playback mo

• 2 Playback modules without faders 

• 2 Superplayback/Programming modules. 
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T2 Console 
The T2 console features: 

let module that includes, the Grand Master & 

 & trackpad 

• 2 Playback modules with faders 

ack modules without faders 

The I3 console fea re

 Grand Master & 

• 
• out faders 

S3 Contro S
The S3 control surface

• 2 Playback modules with faders 

• LCD Pen/Tab
DBO, 12 Function buttons, 2 sets of modifier buttons, a 
keyboard

• 1 Playb

• 1 Superplayback/Programming modules. 

I3 Console 
tu s: 

• 2 Playback modules with faders 

• 2 Playback modules without faders 

• 1 Superplayback/Programming modules. 

L5 Console 
The L53 console features: 

• LCD Pen/Tablet module that includes, the
DBO, 12 Function buttons, 2 sets of modifier buttons, a 
keyboard & trackpad 

2 Playback modules with faders 

2 Playback modules with

• 1 Superplayback/Programming modules. 

l  urface 
 features: 

• 2 Playback modules without faders 

• 1 Superplayback/Programming modules. 

S1 Control Surface 
The S1 control surface features: 

• 1 Playback modules with faders 

• 1 Superplayback/Programming modules. 
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M1 Control surface 
The M1 control surface features: 

• 1 Playback modules with faders. 

Grand Master and DBO 
The rotary Grand Master control scales the intensity of all output from the Vista 

 the 

• surfaces have 6 buttons located below the GM & 
DBO controls 

• 

Your keyboard Fun s. On 
the Vista PC version ed in place 
of these buttons. 

To assign a function
1. Click the Conso e 

at the top of the Console 

2. ht-click on a

system.  

The Dead Black Out (DBO) button takes all intensity to 0%, while it is held down.  

Function keys 
The function function buttons provide quick access to many commands and 
functions. The buttons are user configurable so you can assign functions you use 
frequently and have access to function at the press of a button rather than having 
to choose the option from a menu or icon.  

The number and location of the function buttons varies from console to console: 

• I-series consoles provide six function buttons located at
top centre of the unit 

• S-series consoles provide five function buttons located at 
the top centre of the unit 

• T4 and T2 consoles  have 12 buttons located above the main 
display 

• I3 consoles have 6 buttons located at the top centre of the 
console 

• S3 control surfaces have 5 buttons located at the top centre 
of the console 

S1 control 

M1 control surfaces do not have function buttons. 

ction keys ‘F1 – F12’ can be used in place of these button
, the Function keys ‘F1 – F5 or F1 – F12’ can be us

 to one of the buttons: 
le button to display the Console screen. The function keys ar

screen. 

Rig  button and select a command from the popup menu. 
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T ifier keys 

The LR key (T serie
The LR button chan k’ hold this 
b own then t

The coloured modi
The coloured (Red, Yellow, Green, Blue) modifier buttons provide alternate 
f s when you
during playback.  

You can also use keyboard equivalents in place of the modifiers: 

• 
• 
• 
• Control + Alt is the equivalent of the Blue button. 

The Super  back / Programmer controls 
T ntrols are u
press the ‘Menu’ bu

• m 

encoder wheels can be 

• o playback mode . In this mode 
the controls and buttons provide quick access to the regular 

playback options. 

• SFX – stands for Smart Effects . This mode let’s you use the 
buttons and encoders control the most frequently used 

he mod

s consoles only) 
ges a pen tablet tap to a right tap. To ‘right-clic

utton d ap the pen. 

fier keys 

unction  press a button on the console while programming and 

Shift is equivalent to the Red buttton 

Control is equivalent to the Yellow button 

Alt is the equivalent of the Green button 

Play
hese co sed during programming and playback. To switch functions 

tton and then select from the three options: 

IPCG – stands for Intensity, Position, Colour, Gobo, Bea
and puts the controls into editing (aka programming) 
mode. In this mode the buttons and 
used to set Intensity levels, Pan Tilt and all the other 
features of your fixtures 

Play – puts the controls int

and advanced cuelist 

effects settings. 
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Editor (aka Programmer) mode 

e on screen palettes to adjust setting for 
Intensity, Position, Colour, Gobo and Miscellaneous parameters 

n 

When you select fixtures in the Chooser or Timeline window the hardware 
controls can be used instead or th

Programmer mode 
If the controls are not already in Programming mode press the menu button the
the button labelled ‘IPCG’ to switch into to programmer mode: 

 

This button… does this… 

I /POS Press this 
Intensity p

button to put the encoders and lower 6 buttons in 
lus Position mode. Pressing it again cycles the 

controls through any available parameters or alternate 
odes (Angular position and Strobe & Shutter).  m

Col Press this button to put the encoders and lower 6 buttons in 
s the controls 

through any available parameters or alternate modes (CMY, 
RGB, Colour Wheel Colour ) 

Colour mode (HSV). Pressing it again cycle

Gobo Press this button to put the encoders and lower 6 buttons in 
gh Gobo mode. Pressing it again cycles the controls throu

any available parameters or alternate modes. 
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This button… does this… 

Beam Press this button to put the encoders and lower 6 buttons in 
e. Pressing it again cycles the controls through 

any available parameters or alternate modes. 
Beam mod

Menu Opens the Super Playback top level menu screen. Double tap 
the menu button to switch between Playback and 
Programming mode. 

Home Sets the associated feature to its default (or home) value.  

ier (or Ctrl key) to clear the feature (Clear) Hold the yellow modif
settings. 

Full Sets the associated featur

(Zero) 

e to its maximum values. I.E. this 
would set Intensity to 100. 

low modifier (or Ctrl key) to set the feature to its Hold the yel
minimum value. 

>> For Gobo (or Colour) wheel featu
between the fixtures wheels – i.e. Gobo wheel 1, 

res this button toggles 
Gobo wheel 

2, etc 

Mode For Gobo wheels that have rotating gobos this button toggle
the rotation encoder between Index and Spin mode. 

s 

< > This button reverses the direction of a spinning colour or 
gobo wheel or individual gobo. 

Encoders r to the required value. Rotate to set the associated paramete

<- Left arrow Selects the previous Fixture 

-> Right arrow  Selects the next fixture

Super Fine Mode 
Hold down the Green modifier button or the Alt (Option) button, on your 
keyboard, to put the encoders into super-fine mode. 

Fixture Selection butto
The left and right a
used to select the P

If there’s no fixture
patched fixtures. 

ns 
rrow buttons located just above the encoder wheels can be 
revious or Next fixture in a selection. 

s selected pressing the buttons will cycle through all te 
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E
The overall intensity from the Editor is controlled by the fader located, on the left 
s low the enco

Editor ‘Live’ time 
The fader located, on t coder wheels can be used to 
adjust the Live time e Intensity, Position, Colour 
and other feature setting
A ttom (o%)
snap to the new val

S laybac
In playback mode t ction controls and buttons automatically 
l he selected  the ‘Select’ (*) 
button on any cuelist playback you can control that cuelist with the faders, 
buttons and encoders in this section. 

the encoders provide quick access to all the cuelist 
play function. 

… 

ditor intensity 

ide, be der wheels. 

he right side, below the en
. At the top (100%) position th

s fade in over the ‘Live time’ set in the Editor window. 
 position the feature settings fade in over 0 seconds – i..e they 
ue. 

t the bo

uper P k mode 
he Super Playback se

ink to t playback. This means that when you press

Play controls 
The faders and buttons, below 

This button does this… 

Jumps to the start of the Cuelist 
 

 
revious Cue marker of the selected 

Cuelist 
Cues backwards to the p

 
Cues forwards to the next Cue of the Cuelist 

 
Jumps to the end of the selected Cuelist. 

 
Not used 

 upper 

Pauses playback of the selected Cuelist(s) 
 

lower Commences (Go) Playback the selected cuelist(s) 

 (Left flash) 
Flashes intensity of the super playback cuelist to the 
maximum value.  

Vista User Guide, Version 2  11‐7 



The Super Playback / Programmer controls  Using the console hardware 

This button… does this… 

 (Right) 

Crossfade  
Not used 

 

 can config ng a 
ponent to th

Super Playback mode extended controls 
I e n tton then the 
b elled ‘Pla ttons let 
y trol pages: 

This button… 

 You
com

ure these buttons in the Console window. See Assigni
e playback controls on page 11-13 

f the controls ar
utton lab

ot already in Playback mode press the menu bu
y’ to switch into to Playback mode. The top row of bu
 playback conou select from the

does this… 

Control Selects the normal cuelist play mode controls 

Chase Select the cuelist Chase  controls 

SmartFX Selects the cuelist SmartFX controls 

Load Press Load then any key on a normal playback to load that 
 Superplayback. cuelist into the

Lock Locks the current cuelist onto the Superplayback. When lock 
is selected pressing Select (*) on another playback will not 

e Superplayback cuelist. cjange th

Menu tap 
enu button to switch between Playback and 

Opens the Superplayback top level menu screen. Double 
the m
Programming mode. 

Cuelist Control (normal) mode 
rol the playback rate and select from 

m row of buttons: 
In the Cuelist ‘Control’ mode you can cont
several play options using the botto

This button… does this… 

Rate Enables the 
the encoder 
right to spee

left encoder for rate control of playback. Turn 
to the left to slow the playback rate and to the 
d it up. 

100% Resets th
back using the fade 

e playback rate to normal. At 100% the cuelist plays 
times set in the cues. 
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This button… does this… 

Jump Opens the cuelist jump window on the main screen. Used to
jump from one cue to another cue ou

 
t of sequence. Select the 

Cue you want to jump to in the Jump window.  See Using the 
Jump window on page 11-10

Press Go to fade to that cue. 

Shuttle Enables the middle encoder for manual co
Move the encoder clockwise to advance an

ntrol of playback. 
d anti-clockwise 

to go backwards. 

Release Releases the cuelist. Fixtures return to the previous settings 
or to their defaults. 

Select Selects the cuelist on the SuperPlayback. 

Cuelist Chase mode 
In the Cuelist ‘Ch sing. change the chase rate 
and select the cha  d

This button… does this… 

ase’ mode you can start a cuelist cha
se irection: 

Rate Enables the left encoder for rate control of playback. Turn 
the encoder to the left to slow the playback rate and to the 
right to speed it up. 

Sync Synchronises the chase 

Forward Turns the chase mode on and runs forwards. If the cuelist is 
already chasing forward pressing the button will turn chase 
mode off. 

Reverse Turns the chase mode on and runs backwards. If the cuelist 
is already chasing backward pressing the button will turn 
chase mode off. 

Bounce Turns the chase mode on in bounce mode (i.e. run from firs
to last cue then last to first cue). If the cuelist is already 
bouncing pressing the button will turn chase mode off. 

t 

Random Turns the chase mode on and runs in a random order. If the 
cuelist is already in random pressing the button will turn 
chase mode off. 
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Cuelist FX (effects) mode 
In the Cuelist ‘FX o at 
are running on th o

This button… do

’ m de you can control the size, rate and phase of effects th
e c nsole: 

es this… 

Encoders En
settings 

ables the encoders. To avoid accidentally changing FX 
turn the encoders off. 

Reset Resets the effect(s) Size to it’s programmed settings 

Reset Resets the effect(s) Rate to it’s programmed settings 

All /Cuelist / 
Active. 

All - selects all running effect

Cuelist - selects the effects in the 

s for adjustment 

selected cuelist for 
(press to toggle) adjustment 

Active - selects the active effects for adjustment 

Forward / 
Backward 

(press to toggle) 

Changes the direction of the selected effect(s) 

Sync Re-synchronises the selected effects. 

Using the Jump window 
During playback u f the 
normal sequence, nd
To open the Jump in

• press a  Selec
super pla a

• press the Jump button in the super playback 

Cue window: 

 yo  can use the jump window to quickly select a cue, out o
  a  fade it in.  
 w dow: 

t button on any playback to bring that cuelist onto the 
yb ck 

Vista displays the Jump to 
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This option… does this… 

Cuelist Selects the cuelist to jump to. This field is automatically set 
to the cuelist on the superplayback. 

Cue Selects the cue to jump to. To find the cue you want to jump 
to type the cue number or a part of the cue name in the 
search box, or select the cue from the list 

Cue Timing Crossfades using the new cues fade time 

Live Timing Crossfades using the Live time 

Arm & Close Closes the Jump window with the selected cue ready to play
Press the Play button to complete the jump. 

.  

To complete the Jump and fade in the selected cue, without using the Arm and 
Close option; 

• press the keyboard Enter key, or 

• use the Cuelist’s Go button, or 

• click the OK button. 

Playbacks with faders 
Depending on yo c fader’ 
sets consisting of l
include a display. 

ur onsole type you will have one of more ‘Playback with 
5 p aybacks. On the M1 console the playback set does not 
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These playbacks consist of: 

• a Select button – normally used to select the playback 

• a display – used to display the name of the cuelist or other 
component that’s being controlled 

• a Go button – normally used to play the the cuelist or other 

e intensity of a cuelist 

n – normally used to momentarily flash the 
a cuelist to full. 

 faders 
 available of the T4, T2, I3, and S3 consoles. 

component 

• a fader – used to control th

• a flash butto
intensity of 

Playbacks without
These button-only playback sets are

 

– used to display the name of the cuelist or other 
hat’s being controlled 

– normally used to play the cuelist or other 

• press the Page Down button to go back to the previous 
page number. 

These playbacks consist of: 

• a Select button – normally used to select the playback 

• a display 
component t

• a Go button 
component. 

Page controls 
Each playback module consists of 5 playbacks. Cuelists and other components 
can be assigned to these controls as pages. To change pages: 

• press the Page Up button to advance to the next page 
number 
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Configuring the console for Playback 
Once you’ve stored a number of Cuelists, Presets, Extracts, etc, you can a
those components to the playback

ssign 
 controls the way you want them using 

Console screen. 

ays the Console When you click the Console button on the toolbar Vista displ
screen: 

 

On this window the Sideba
filter the components you 

• choo
Extracts, Smart FX, Snapshots) from the top dropdown 

• filter
exam
inclu

A mpon
Once you’ve selected the component type you want you can drag and drop it 
onto the label area corresp indows: 

r shows a quickpicker where you can display and 
want to assign to the console. You can: 

se a component type (Cuelists, Groups, Presets, 

 the list by selecting a set from dropdown. For 
ple you can filter the list to show just Presets that 
de Colour. 

ssigning a co ent to the playback controls 

onding to the console’s LCD w
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an n of components to the playback controls 
– Cuelists, Groups, Presets, Extract, Effects, Favourites and Snapshots. 

Splitting playback controls
W onent is assig controls that are 
available – the Go and Choose button plus 
but you can split a playbac e 
placed on a page.  

T move the curso ointer 
changes to

 Tip: You can assign y combinatio

 
hen a comp ned to a playback it uses all the 

the fader and flash button if available, 
k set to increase the number of components that can b

o do this, r to the top of the white label area. When the p
 a split bar [=], click and drag down: 

 

P ers can e 
middle of the label area. W
drag down. 

 Tip: You don’t have to split all the playbacks on a page the same way, you 
two ways,

Expanding playbacks 
Playbacks can also be exten
playback of a cuelist. Up to t: 

laybacks with fad be split three ways. To do this move the cursor to th
hen the pointer changes to a split bar [=] click and 

can split on  another three ways and so on. 

ded to provide more physical button controls for 
 five playbacks in the group can control a cuelis

 

o expand a Playback move the cursor to the right side of the label area. When 
the pointer changes to a split bar [||] click and drag to the right. 

 assigned, 
not occupied by another 

T

 Tip: You can expand a Playback before or after a Cuelist has been
but you can only expand into an area that is 
component. 

11‐14  Vista User Guide, Version 2 



Using the console hardware  Configuring the console for Playback 
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C ay ons and faders 
Normal, split and expanded playbacks have their buttons and faders set up with 
the default configuration. T  
the Help key [!] on T series

Vista displays the button a
window: 
You can assign different actions to these buttons and faders to suit your 
r  or playback s

T n: 
1. Click the Console butt

2  the ‘Cuelist B ttons’ or ‘Cuelist Faders’ tab in sidebar. 

3  on the required b e button 
or fader you want to use for that function. 

Some buttons and faders must be used together. For example if you make a fader 
a ‘Cross fader’ you should
below the fader. Likewise if you make a fader a ‘Rate fader’ you should also 
assign a ‘Toggle rate fader

uelist buttons 
The following button actions are av

Th

onfiguring the pl back butt

o see how the buttons and faders are configured press
 consoles Ctrl + ? on a PC.  

nd fader functions on the LCDs and in the Console 

equirements tyle.  

o assign an actio
on to display the Console screen. 

. Click on u

. Click utton or fader action and drag it on top of th

 also assign a ‘Toggle Xfader’ button to the button 

’ button to the button below the fader.  

C
ailable: 

is button action … does this… 

Unassigned The button has no action. 

Play Plays (starts playback of) a cuelist. 

Jump Opens the Jump window. See Using the keyboard to 
Jump on page xxx. 

Inhibit yback, Intensity i
and all other parameters revert to the
setting. Press the button again to enable or re-assert 

ue

Stops the cuelist pla s reduced to 0 
ir previous 

the c list. 

Flash Sets the button to mome sh tensity to full. 
This is the default assignment for the square buttons 
below the faders. 

ntarily fla In

Flash Submaste e utton to mome tarily flash 
on a Submaster. 

r Sets th  b n Intensity to full 

Pause Pauses playback of a cuelist. 

Edit Opens a Cuelist, for editing, in the Editor window. 
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Guide, Version 2 

does thThis button action … is… 

Skip Forward Steps forwards to the next Cue of the cuelist. 

Release Releases a cuelist. 

Skip Back Steps backwards to the previous Cue marker of the
selected cuelist. 

 

Skip to End Jumps to the end of the cuelist. 

Select Selects the cuelist. This is the default assignment for 
all * buttons. 

Re-assert Re-asserts a cuelist that has been overridden. 

Chase Toggle Toggles between Chase on and Chase off. 

Chase Direction Cycles between the available chase directions in this 
order: Forward, Backward, Bounce, Random. 

Chase Forward Sets the Chase direction to forwards (the normal 
setting). N.B. if the chase is already running forwards 
the button will toggle between chase off and chase 
forwards. 

Chase Backward Sets the Chase direction to backwards (or reverse). 
N.B. if the chase is already running backwards the 
button will toggle between chase off and chase 
backwards. 

Chase Bounce Sets the Chase direction to bounce. N.B. if the chase is 
een already bouncing the button will toggle betw

chase off and chase bounce. 

Chase Random chase 

n chase off and chase random. 

Sets the Chase direction to random. N.B. if the 
is already set to random the button will toggle 
betwee

Skip to Start Jumps to the start of the cuelist. 

Exit Loop Stops a loop and goes to the next cue. 

Sync FX  

Sync Chase  
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Cuelist faders 
The following fader actions are available: 

This button action … does this… 

Blank fader has no action. 

Intensity Fader Set
is t

s the fader to control the Intensity of a cuelist. This 
he default assignment for all faders. 

Cross Fader Sets the fader to manually crossfade between cues. 
Must be used in conjunction with a ‘Toggle Xfader’ 
button. 

Rate Fader Adjusts the playback rate. 

Autoplay Fader Same as the Intensity fader but also plays the cue 
when the fader is raised. (equivalent to pressing Go) 

Submaster  

FX Size Controls the size of any effect in the cuelist. 

FX rate Controls the rate of any effect in the cuelist 

FX phase Controls the phase offset of any effect in the cuelist 

Auto Play & Release Must be used in conjunction with a Cross fader. Used 
enables the fader. 

 

e the b der configuration as a default to be used 
ever a cuelist is a

cuelist and choose the . 

Playback statu
F  L
s  

 Normal (2
back)  

 Tip: You can sav
when

utton / fa
ssigned to a playback. To do this right-click on a 

 ‘Save as default cuelist configuration’ option

s indication 
EDs inside the playback buttons indicate the current 

follows: 
or Cuelists the LCD and
tatus of each playback as

 Button Playback) Split (1 Button 
Play

 Lower Button Upper Button LCD Button 

Current   Inverted  

Active  Green   

Paused Green Flashing  Green Flashing  

Vista User Guide, Version 2  11‐17 



Playback popup menu  Using the console hardware 

Running Green   Green 

Completed Red   Red 

Overridden  Red Flashing  Red Flashing 

Playback popup menu 
You can make changes to Cuelists Pages and other components using the 

 menu right-click on the label area of any 
playback control. Vista displays the context menu: 
Playback context menu. To open this

 
 

… This option does this… 

Cuelist Properties Opens the Cuelist properties window – see below. 

Lock item Locks the selected component. Components that 
have be locked will not be altered or replaced when a 
new Page or Snapshot is loaded. 

Clear item Clears the selected playback – the assigned 
component is removed from the control. 

Clear page Clears all playbacks on t
assigned compo

he current page – the 
nents are removed and a blank page 

is left. 

Delete page Deletes the current page. 

Set as default play
layout. 

back Sets the selected cuelist’s buttons and faders as the 
defaults for all new cuelists. 

Snapshot enabled Allows the selected playback to be included in a 
snapshot. 
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This option… does this… 

Set as default cuelist 
configuration 

Sets the selected cuelist’s properties as the defaults 
for all new cuelists. 

Adjust contrast Adjusts the contrast of the selected LCD window  

Setting cuelist properties 
T t propertie s 
o  popup me  
6

Group Masters 
You can assign and Group to a playback. If you assign the group to a playback 
set, that includes a fader and flash button, you can use these controls as Group 

sity controls: 

o set the cuelis
ption from the
-25

s, right click on the Cuelist name and the Propertie
nu. For more information see Cuelist Properties on page

Master Inten

 

The intensity of t g

With this Group type you can do this… 

he roup can be controlled in three ways: 

Scale ( - ) 

also known as an 

Reduce the intensity of fixtures in the group. When a
Scale(-) fader is pulled down, while a cuelist is being 
played, the intensity of fiInhibitive or 

 

xtures in that group will be 

 to the level 
programmed in the active cuelist. 

Subtractive group 
master 

reduced. 

When a Scale(-) flash button is pressed the intensity 
of fixtures in that group will go
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Wi thth is Group type you can do this… 

Scale ( + ) 

ter 

Increase the intensity of fixtures in the group. When a 
Scale(+) fader is pushed up, while a cuelist is being 
played, the intensity of fixtures in that group will be 
increased. 

also known as an 
Additive group mas

When a Scale(+) flash button is pressed the intensity 
of fixtures in that group will go to 100%. 

HTP 

Highest takes 
precedence 

Control the the intensity of fixtures in the group on 
an HTP basis. If there’s no cuelist, containing the 
fixtures in the group, being played the fader will set 

or 

the level of the fixtures between 0 and 100%.  

This is the default fader and flash button setting f
groups. 

 

u

1. 

2. ebar. 

3. action and drag it on top of the button 
ction. 

Group

Yo  can assign different actions to these buttons and faders to suit your 
requirements or playback style.  

To assign an action: 
Click the Console button to display the Console screen. 

Click on the ‘Group Faders’ or ‘Group Buttons’ tab in the sid

Click on the required fader or button 
or fader you want to use for that fun

The following actions are available: 

 Buttons 
The following fader actions are available: 

This button action … does this… 

Blank The button has no action. 

Select Selects the group. 

Flash ( - ) ressed the intensity 
of fixtures in that group will go to the level 
When a Flash(-) flash button is p

programmed in the active cuelist. 

 

Flash ( + ) 

 

When a Flash(+) flash button is pressed the intensity 
of fixtures in that group will go to 100%. 
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This button action … does this… 

Flash HTP 

Highest takes 

p on 
ist, containing the 

fixtures in the group, being played the button will set 

Control the the intensity of fixtures in the grou
an HTP basis. If there’s no cuel

precedence 
the level of the fixtures between to 100%.  

 

The following fad  a

This button acti  …

Group Fader 
er ctions are available: 

on  does this… 

Scale ( - ) 

also known as an 

 
lled down, while a cue is being 

played, the intensity of fixtures in that group will be 

e intensity 
of fixtures in that group will go to the level 
programmed in the active cuelist. 

Reduce the intensity of fixtures in the group. When a
Scale(-) fader is pu

Inhibitive or 
Subtractive group reduced. 

master When a Scale(-) flash button is pressed th

Scale ( + ) Incr

also known as a
Additive group s

ease the intensity of fixtures in the group. When a 

n Scale(+) fader is pushed up, while a cue is being 

ma ter played, the intensity of fixtures in that group will be 
increased. 

When a Scale(+) flash button is pressed the intensity 
of fixtures in that group will go to 100%. 

HTP 

Highest takes 
precedence fixtures in the group, being played the fader will set 

the level of 

Control the the intensity of fixtures in the group on 
an HTP basis. If there’s no cuelist, containing the 

the fixtures between 0 and 100%.  

r 
groups. 
This is the default fader and flash button setting fo

 

Pages 
Each Playback Group can be paged independently of the others, allowing for a 
wide variety of console configurations. To change pages, press the Up or Down 
arrow buttons located to the right of each playback group. On the console screen 
you can also select a page from the popup page selector. 

Vista User Guide, Version 2  11‐21 



Snapshots  Using the console hardware 

The Page Up and Down buttons work in three ways: 

• press quickly to change the page immediately 

• press and hold, for less than two seconds to display the 
current page number, without changing it 

• press and hold, for more than two seconds to scroll the 
number. 

Locking a playback to prevent changing 
Playbacks can be Locked to prevent whatever is assigned to that location being 
changed when a new page or snapshot is selected. 

Components can be locked, so that they are not affected by Page changes or 
Snapshots being loaded. To do this right-click on LCD, in the Console window, 
and choose the ‘Lock item’ option from the popup menu. 

Page Holdover 
If a cuelist is playing when you change page it is held and that playback does not 
load the contents of the new page. The playback that is held will join the new 
page when: 

• The cuelist id released or fully over-ridden or 

• You press the page up and down buttons simultaneously 

Snapshots 
Snapshots allow you to store and recall the exact state of the console’s output, 
buttons, faders and other controls. They can be used to quickly re-configure the 
controls for playback, programming or a mixture of both. For example, you may 
have a snapshot set up for each song or part of a show. You might also have a 
snapshot for programming with the playback buttons assigned to provide quick 
access to Groups, Presets Extracts and Effects. 

Snapshots can not only recall Page and Cuelist settings but also the state of the 
Cuelist. For example if a Cuelist is active and in Cue 3 when the snapshot is 
recorded then the same state can be recalled. 

To record a snapshot 
1. Use the console window to assign components and configure the controls 

and pages the way you want them to be. 

2. Click the Create Snapshot button (normally Green + F9 or Alt+F9) on the 
main toolbar. Or select the ‘New Snapshot option from the Components 
menu. Vista displays the Create Snapshot window: 
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This option… does this… 

Name Sets the name for the snapshot 

Record Sets the options for the snapshot: 

Playback State The state of cuelists on the current pages will be 
included in the snapshot. For example if a Cuelist is 
active in Cue 2 when the snapshot is recorded it 
will also be active in Cue 2 when recalled. 

Fader Levels Includes the current fader levels in the snapshot. 

Workspace state Saves the contents (cuelists, groups and other 
components) of all playbacks. 

 Locked components are protected from any changes by snapshots. If a 
cuelist is part of a snapshot and it is also running on a module that will not 
be affected by the snapshot there can be a conflict.  

In this situation: 

• if the cuelist is active on the unaffected module, it is not 
changed 

• if the cuelist is inactive on the unaffected module, it is 
restored to the state stored in the incoming snapshot (i.e. 
activated or released). 
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Assigning a Snapshot to a Playback 
You assign Snapshot to a playback button in the Console window.  

Reca

 a snapshot, or 

from the popup menu, or 

windows 

 sure the snapshot is active. 

ate of components and pages as required. 

Console sidebar or any QuickPicker  and 
opup menu. Vista displays the ‘Update 

lling a Snapshot 
To recall a Snapshot, you can: 

• use a playback button that has been set up as

• right-click on a snapshot icon and select the ‘Apply’ option 

• click on the snapshot in one of the Quick picker 

Updating a Snapshot 
To update a Snapshot: 
1. Make

2. Change the assignment and st

Right-Click on the snapshot icon, in the 
select  the Update option from the p
snapshot’ window. 
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12. The Output window 

  

T e 
‘Output’ option from the Window menu. Vista displays the Output window in 
icon view: 

o open the Output window click on the icon on the main toolbar or select th

 

You use this screen to display the state of fixtures that are active – that is fixtures 
that have one or more parameters that are being controlled by the playbacks. The 
window is split vertically with multi-parameter fixtures displayed in the top 
pane and conventional fixtures (i.e. dimmers only) being shown in the lower 
pane. 

If you have a large main screen or external monitors attached, you can add a new 
Output window and drag it so that it is always in view. To do this select the ‘Add 
window > Output’ option from the Window menu. 

Adding output view tabs 
You can create as many different views of the output as you like, each arranged 
in its own away. To create a new output view: 
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You can create as many different views of your fixtures as you like, each 
arranged in its own away. To create a new layout view: 
1. Select the ‘Add view’ option from the View menu. Vista creates a new view 

tab at the bottom of the window. 

2. Type a name for the layout and click OK. Vista creates a new layout and 
adds a corresponding  ‘tab’ at the bottom of the layout panel. 

To switch between layouts click on the tab you want to use. 

Configuring the Output window 
The Output window has a popup menu that lets you configure how the Output 
information is displayed. Right-click on the screen to show the configuration 
options: 

 

This option… does this… 

Text Mode shows the actual values of the features. If a parameter is 
set to a preset value, the name of the preset will be 
displayed rather than the value. 

Graphic mode shows a graphic representation of the features.  

Source mode Shows where each feature is coming from. For example 
a fixture might have Intensity and Position coming from 
a Cuelist and Colour from the Editor Live tab. 

Follow Fixture 
selection 

Shows the selected fixtures at the top of the view 

Show all fixtures Shows all fixtures 
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This option… does this… 

A
f

to the dd selected 
ixtures 

Adds the fixtures, selected in the Fixture Chooser, 
output window 

Remove selected Removes the selected fixtures from the output window 
fixtures 

Show only selected 
fixtures 

Filters the window to only show the selected fixtures 

Clear view Clears all fixtures from the output window 

More detail Adds feature value information, in the graphic view 

Less detail Hides feature value information, in the graphic view 

Resize all columns Resizes all columns to their default size 

Rename view Opens the Rename Viw where you can type a new 
name for the selected layout view 

Remove view Deletes the selected layout view 

 

The Source view shows the source of co
example if a fixture’s colour settings hav
that name will be displayed in the Colour 

ntrol for each of the parameters. For 
e come from a cuelist named ‘Rainbow’, 

column for that fixture. 

e tracking view window, Vista 
Selecting fixtures 
If you click in the ID or name cell of a fixture in th
selects that fixture or adds it to the existing selection. 
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13. The Console control panel 

System settings (T & I series only) 
There are a number of system settings that configure and determine how the 

 
the Settings screen. 

Vista T and I series consoles operate. To set these preferences, choose the ‘Control
Panel’ option from the File menu. Vista displays 

Settings 

  

Calibrating the
Sometimes you may have uch screens. 
To begin calibration, choose the Calibration button from the settings window. 
Vista lists the pen tablets d configured. 

If you don’t see a screen, 
and Input devices’ window 

 Pen tablet 
 to re-calibrate the pen tablet or external to

 and touchscreens that are connected an

make sure that it has been configured in the ‘Display 
– see below. 

 

When you click on the button corresponding to the screen you want to calibrate 
Vista displays the calibration window on the monitor you selected: 
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Follow the on screen prompts to complete the cali

Display and Input Devices 
If you are using a S or M series contro
(mouse, pen tablet, etc) settings are controlled by

 Vista has been tested with Wacom pen tablet LCDs and 
model 1715 monitor.  ELO make many different 
including the ‘AccuTouch’ type which may no
for compatibility before

To set the Pen tablets and Touchscreens that are connected t
console click the Display and Input Devices button. Vista dis
and Input Devices window: 

bration process. 

l surface the display and  input device 
 the PC operating system. 

 ELO ‘Intellitouch’ 
touch screen monitors 

t be compatible. Please check 
 purchasing touch screen monitors for use with your 

o your T or I series 
plays the Display 

 

In this window: 

Scr

• Scr tor 
out 1 

• Screen #2 is the monitor you have connected to monitor 
out 2 

• een #0 is the built in Pen tablet on a T series console 

een #1 is the monitor you have connected to moni
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To configure the monitors cl
type connected to each outpu

ick on the drop down arrow and select the screen 
t. If your monitor does not appear it may not be 

, screensaver, settings 
are controlled by the PC operating system. 
To set a screensaver on a T or I series console click the Screen Saver button. Vista 
displays the screensaver window: 

supported. 

Using the screensaver 
If you are using a S or M series control surface the display

 

This option… does this… 

On / Off Turns the screensaver on or off 

Standby Sets the how long the console must be idle before the 
screensaver starts. 

Suspend Not required for LCD type monitors. 

Sets the how long the console must be idle before 
CRT type monitors go to suspend mode. 

Off Not required for LCD type monitors. 

Sets the how long the console must be idle before 
CRT type monitors turn off. 

Vista User Guide, Version 2  13‐3 



Network preferences  The Console control panel 

 

N
If you are using a S or M series control surface the network settings are controlled 
by the
To set the networking preferences, on a T or I series console click the Network 
settings button on the Settings screen: 

etwork preferences 

 PC operating system. 

 

does this… This option… 

Host name  used to identify the console when using tracking Is
backup. 

DHCP / Static IP Sets the console to either obtain an IP address from a 
DHCP server or use a Static IP as set below 

IP Address IP address of the Vista console, e.g. Sets the 
192.168.0.65 

IP Netmask P address, e.g. Sets the subnet mask for the I
255.255.255.0 

Default Gateway Sets default gateway for the console. Used when the 
destination address bis outside the local subnet. 
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D  time
Vista displays the time in the title bar of the main windows. If you are using a S 
or M series control surfac e PC 
o
T time, e click the date and time button 
o nd

ate and  

e the date and time settings are controlled by th
perating system. 
o set the date and on a T or I series consol
n the Settings screen a  follow the on screen prompts 
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14. Appendix 1 – menu & toolbar 
reference 

Menus 

F
 

n… does this… 

ile menu 

This optio

New Show Creates a new show file, opening the Patch window. 

Open Show Opens an existing Show file 

Save Show Saves the current show 

Save Show As Saves the current show with a new name. 

Autosave & Backup  window where you can setup the Opens the Backup
Autosave and Tracking backup. 

Export ort window wehere you can export a Opens the Exp
Show Archive File, the user added Fixture Library, the 
user created effects, or all show information. 

Import 

 - Show 

 - Effects 

 - User data 

o import a Vista show Archive (*.jvz) 

Opens a window to import a Vista effects file (*.jvfx) 

indow to import a User Data archive 
(*.jvud) 

 

Open a window t

Opens a w

User Preferences ttings window where you can 
configure naming formats. 
Opens the system Se

Timecode  properties window where you 
can enable or disable timecode and set thetimecode 
source, framerate and offset. 

Opens the Timecode
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This option… does this… 

Lock 

 - Entire console 

 - Disable editing 

 - Lock current show show file. 

 

Prevents any operation of the console. 

Only allows playback 

Prevents any changes being made to the 

Control panel 

(consoles only) 

Ope ou can 
calibrate the screens, configure displays, network and 

ns the system properties window where y

date settings on a T or I series console. 

Quit Application Close the Vista application and exit. 

 

Edit menu 
 

This option… does this… 

Select All (Ctrl+A) Selects every event on the timeline. 

Undo (Ctrl+Z) your last action. Cancels 

Redo (Ctrl+Y) Repeats your last action. 

Cut (Ctrl+X) Cuts the selected objects. 

Copy (Ctrl+C) Copies the selected objects. 

Paste (Ctrl+V) Pastes the selected objects. 

Paste Special 

V) 

so you can choose 

(Ctrl+Shift+

Opens the Paste Special window 
which attributes of the objects you copied to paste. 

Remove Cue Alias Removes the alias link from the selected cue. 

Delete (Del) Removes the selected event(s) from the timeline. 

Live Properties Displays the Properties window so you can make 
adjustments to the Priority and Stop Effects mode of 
the Live tab. (see  

Cuelist Properties Displays the Properties window so you can make 
adjustments to the selected cuelist. 

Cue Properties 
s to the selected cue. 

Displays the Properties window so you can make 
adjustment
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Components menu
 

This option… 

 

does this… 

New Cuelist ooser 
op 

Opens a new empty cuelist. Switches to the Ch
window if the Chooser or Timeline is not the t
window. 

Open Cuelist dow where you can open Opens the Select Cuelist win
an existing cuelist. 

Close Cuelist 
(Ctrl+W) 

Closes the selected cuelist. 

Save changes to 
Cuelist. (Alt+S) 

Saves all changes made to the selected cuelist. 

Discard chan
Cuelist 

ges to Removes all changes made since the cuelist was 
opened or ‘Save changes’ was selected. 

Duplicate Cuelist Opens the Copy Cuelist As window where you can 
save a copy of the selected cuelist with a new name 
and number (ID) 

New Preset Opens the Create New Preset window where you can 
save a preset. 

New Extract  Opens the Create Extract window where you can save
a extract 

New Snapshot Opens the Create Snapshot window where you can 
save a snapshot. 

New SmartFX here you can save Opens the Create Effect window w
an effect. 

New Group Opens the Create Group w
a group of fixtures. 

indow where you can save 

Update Group Opens the Update Group window where you can sav
changes to a group. 

e 

 

Tools menu 

This option… does this… 
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This option… does this… 

Cue only editing  

Move in Black 
they’re 

nd. 

Opens the Move in Black window. This enables you to 
move fixtures when their intensity is at zero so 
in the right position when they turn on. 

 The fixtures you want to pre-position must be 
selected before choosing this comma

Insert Commands 
t’s timeline to activate 

Opens the Macro Properties window. This lets you 
add commands, in the cuelis
other cuelists or actions. 

Date & Time events Opens the Date and Time Events window where you 
can configure actions (for example to play a cuelist) 
based on the date and time. 

Edit Command Macro Properties window for the selected Opens the 
command.  

Block cue (Ctrl + B) Copies all tracked information to the current cue and 
adds release events for other feature types in this 
cuelist. 

Unblock cue ed when a cue is blocked. Removes all events add

Superblock cue 
(Ctrl + Shift + B) 

, 

Copies all tracked information to the current cue and 
adds release events for other feature types. When a 
super-blocked cue is run any other cues being playing
that would affect the look of this cue are released. 

Store All Opens the Store Look window where the contents of 
the editor can be saved as a cue. 

Store Part 
(Shift + Return) 

Opens the Store Current Events window where the 
contents of the editor can be saved as a cue with 
options for tracking, blocking and more. 

Update (Ctrl + U)  
r preset. 

Opens the Update Dialog window where the contents
of the editor can be used to update a cue o

Clear All C
Live tab. 

lears all events from the selected cue or the editor’s 

Clear / Close  

nges can be committed or 
discarded. 

Clears the Live tab or closes the selected Cuelist. If the
cuelist has unsaved changes opens the CloseCuelist 
window where any cha
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This option… does this… 

Clear selected Clears all events from the selected fixtures. 

Home selected 
fixtures to their home values. i.e. Intensity to 0%, 
Inserts events to send all features of the selected 

position to 50/50, colour to clear, etc. 

Cues 
 
 - (Ctrl + Shift + I) 
- (Ctrl + I) 
 

 

- (Ctrl + Right arrow) 

 to: 

 - Renumber the selected cue(s) 

 - Set the cue follow mode to Auto,  From Start (of 
previous), From End (of previous) or Halt (the default) 

 - Move Start times of the selected cues. 

 

 - (Ctrl + Left arrow) 

Opens the cues submenu with commands
 - Append a new cue at the end of the cuelist. 
 - Insert a new cue before the selected cue. 
 - Insert a new cue after the selected cue. 
 - Delete the selected cue(s) 
 - Merge the selected cues 

 - Select the Previous cue 
 - Select the Next cue 

Live timing Opens the Live Timing window where you can set the 
fade time for the Live tab of the editor 

Fan mode a submenu where you can set the fan mode for 
fixture selections 
Opens 

Jump (Ctrl+ J) Opens the cue JumpDialog window.  

Highlight (Ctrl + H) Turns highlight on or off. When on the selected 

lly 100% intensity, open white) 
fixture(s) are set to the values stored in the highlight 
preset (norma

Stop SmartFX Stops any effects running on the selected fixtures 

Smart FX editor 
(Ctrl + K) 

 where you can creat a 
new effect or edit a running effect 
Opens the SmartFX window

Blind Turns off all output from the editor 

Release All Releases all active cuelists 

Arm Timecode 
Cuelists 

Sets all cuelists, that include timecode cues, to listen 
for incoming timecode. 

Learn timing Opens the Learn Timing window where you can set 

ing the Go button at the time you want 
the cue to start. 

cue timecode values by playing the cuelist, in the 
editor, and hitt
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P  atch menu

This option… does this… 

Show Patch Switches to the Patch window, if it is not already open. 

Delete fixtures the patch. Removes the selected fixtures from 

Rename fixtures Opens the Rename window where you can enter a 
custom name for the selected fixture(s). 

Renumber fixtures 
fixture(s). The number 

Opens the Renumber window where you can change 
the ID number for the selected 
must not be in use already. 

Multi-patch fixtures Creates a copy of the selected fixture, with the same ID 
and places it in the dock. The new fixture can then be 

e 
 treat 2 or more fixtures as 

one. 

dragged to an available address on one of the univers
tabs. Multi patching lets you

Change Fixture type  
a different type.  

Opens the Change Fixture type window where you
can change a fixture to 

Change Fixture type 
(All of selected type) can change all fixtures of the selected type to a 

Opens the Change Fixture type window where you 

different type.  

Clone Fixtures  of the selected fixture(s) and places it in 
the Fixture pool at the bottom of the Patch window. 
Makes a copy

Import Fixture 
Library 

t a Vista 2 
fixture type library archive (.jvft) 
Opens a file browser where you can impor

Fixture Editor Opens the Fixture Editor where you can create a new 
fixture file or edit an existing one 

Import Patch file  Patch file window where you can 
ed (.csv) patch file to import. 

Opens the Import
select a suitably formatt

Import Media Server 
thumbnails. 

indow where you can select a media 
patible support for CITP and import 

 fixtures media thumbnails. 

Open the Citp w
server with com
copies of the

Use default media  

Connect Universes Opens the Connect Universes window where you can 
connect the Vista universes to DMX outputs, Artnet, 
and Pathport devices and the Jands UD512 USB to 
DMX cable. 

Vista User Guide, Version 2  14‐11 



Menus  Appendix 1 – menu & toolbar reference 

This option… does this… 

Strike Sends a strike command to the selected fixture(s). 

Douse Sends a douse command to the selected fixture(s). 

Reset Sends a reset command to the selected fixture(s). 

Park Fixtures Holds the fixture in it’s current settings.  

stage. 
l 

For example to provide fixed lighting for back
Once you’ve parked a fixture it will ignore al
instructions until it is un-parked. 

UnPark Fixtures Sets a parked fixture to operate normally. 

Show Parked Fixtures ist of Opens the Parked Fixtures window to display a l
parked fixtures and their settings. 

Console   menu

This option… does this… 

Show Console Switches to the Console window, if it is not already 
open. 

Desklights Opens the desklights window where you can adjust 
the brightness of the desklights connected to your 
console. 

Rescan for USB 
devices 

Scans the USB bus for Vista USB devices – S3, S1
E2 or UD512 

, M1, 

Add …. Console Adds the selected console or control surface type to 
the Console window. These windows can be dragged 
outside the main window. 

Add Virtual Super-
Playback 

dow. 
This window can be dragged outside the main 
Adds a Superplayback module to the console win

window. 

Chooser menu 

This option… does this… 

Show Fixture Switches to the Fixture Chooser window, if it is not 
already open. Chooser 

Select All Fixtures Selects all fixtures on the current fixture chooser tab. 
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This option… does this… 

Deselect All Fixtures ure chooser tabs Deselects all fixtures across fixt

Invert selection selects all other 
fixtures on the current layout 
Deselects all selected fixtures and 

Select Active Selects all fixtures whose intensity is above 0% 

Select Programmed rogramming. Selects all fixtures that have active p

Undo selection Deselects the selected fixtures and selects the fixtures 
that were previously selected. 

Redo selection Reselects the fixtures that were selected before an 
undo selection action. 

Selection Tool lect the Rubberband, Lasso 
or Dragover selection tool. 
Displays a submenu to se

Colours and 
Background 

 customise the appearance of 
the fixture chooser window and icons. See Layout 
Displays a submenu to

organisation on Page 5-7

Shrink to fit ace. Zooms the layout to fit the available window sp

Label Position 
p, bottom, 

left or right. 

Displays a submenu where you can set the label 
position, for the selected fixture(s) to the to

Manage Layouts  
ee Layouts on Page 5-3

Opens the Layouts window where you can customise
the current layout. S

Duplicate Layout  the current layout with a new name Create a copy of

Layout options Displays a submenu where you can choose display 
options that apply to all layouts: 
 - False Intensity 

 - Show names 

 - Auto add new fixtures 

 - Show selection order 
 - Show grid 
 - Snap to grid 

 - Show IDs 

 - Preview refresh rate 

T nu imeline me

This option… does this… 
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This option… does this… 

Show Timeline Switches to the Timeline window, if it is not already 
open. 

Show tracked events  tracking through from 
previous cues. Tracked events are shown as lighter 
Shows or hides features that are

bars that cannot be selected. 

Align start Aligns the start points of the selected events. 

Align end Aligns the end points of the selected events. 

Set Event Timing Opens the Event Timing window where you can edit 
 for the selected event. the timing information

Reset to default 
timing pe. 

Resets the selected event(s) so that it follows the 
default timing for its feature ty

Fade Curve Sets the fade type for the selected event(s). 

Convert to Release 
Event 

he selected event so that it releases the 
control of the feature. 
Converts t

UnTrack events 
(Cue only) 

f the selected events in the following 
Cue. 
Undo the effect o

Mute Events Prevents the selected event(s) from being played back. 
reyed and when the cue is 

played the event will be ignored. 
The event bar will be g

Unmute Events Removes the muting from the selected event(s) 

Stop Free Effects Sets the selected event(s) to stop any free effects for the 
same feature type. 

Snap to Grid Sets events to snap to the timeline gridlines 

Grid Size nts. The default is 0.25s Sets the gridline increme

Grid Origin timing: 
 - Start of cue, shows 0s at the start of each cue 
 - Start of Cuelist, shows a single continuous timeline 
 - Current Position, sets the 0s position to the current 
position of the playhead. 

 shows timecode values. (HH:MM:SS:Fs) 

Sets how the timeline ruler shows 

 - Timecode,

V

This option… does this… 

iew menu 
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This option… does this… 

Show Patch Switches to the Patch window 

Show Console Switches to the Console window 

Show Fixture 
Chooser 

Switches to the Fixture Chooser window  

Show Timeline Switches to the Timeline window. 

Show Playback Switches to the Playback window 

Show Output Switches to the Output window. 

Window Themes Opens the Vista ThemeDialog window where you can 
customise the colour of window elements or load one 
of the  alternate themes. 

Vista Toolbar Shows or hides the window selection toolbar, at the 
bottom of the screen. 

Add floating window Displays a submenu where you can select a window to 
open on the desktop or an external monitor. The 
available windows include the Patch, Chooser, 
Playback, Output and DMX windows as well as: 
 - Multi Quick Picker – to display presets ,groups, etc 
 - Quick Picker 1-4 – a single quickpicker. 

Sidebar 
 
 
 - (Ctrl + 1) 
 - (Ctrl + 2) 

Displays a submenu with options to show the sidebar 
on either the left or right side of the screen and to set 
which tab is active: 
 - Palettes 
 - Components 

Command Line Shows or hides the Command Line window at the 
bottom of the Fixture Chooser & Timeline windows 

Toolbars * Displays a submenu to show or hide optional toolbars 
including, Update, Edit, Undo and more. The available 
toolbars depend on the current window. 

 Playback window only 

Only show Active 
cuelists  

Only show cuelists that are being played back. 

Follow on Go Automatically select the last played cuelist. 

Follow on Select Automatically select the cuelist on the selected 
playback. 
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This option… does this… 

S e. earch cuelists Opens a search box so you can find a cuelist by nam

Auto tomatically scrolls the list of cues so that the cue 
ng played is always visible. 

 Scroll Au
bei

Dragable Playhead Allows the ‘position’ bar to be dragged to play the 
cuelist. 

Search Cues Opens a search box so you can find a cue by name. 

Toolbars Shows or Hides optional toolbars 

 Output window only 

Ad ab d View Creates a new output window and adds a selection t
at the bottom of the window. 

Add Intensity View Creates a new output window, that only shows 
Intensity and adds a selection tab at the bottom of the 
window. 

Load window layout Opens the Load Output Window to show a saved 
window layout. 

Save window layout Saves the current output window layout. 

 Patch Window Only 

Table view Switches the Patch window to the (default) table view  

List view Switches the Patch window to the list view  

DMX view Switches the Patch window to the DMX view  

Ab
numbers 

displays as channel 513 

solute Channel Displays channel numbers consecutively irrespective 
of the universe. For example Universe 2, Channel 1 

T olbars Shows or Hides optional toolbars o

He

This option… does this… 

lp menu 

About Vista Displays the Vista version and build information. 

View Recent Changes Opens a window that shows a log of recent changes to 
the software. 
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15. Appendix 2 – installing new 
software 

Installation (T2, T4, I3 & L5 Consoles) 
If installing Vista V2 software on a Vista T2, T4 and I3 console for the first time
the har

, 
d-drive in these consoles must be re-imaged from CD or USB stick, using 

the Vista V2 Console Image file.  

 ftware on a console will erase all saved shows and 
other data. You must manually backup or archive all your existing show 

 device. 

r the first time the inbuilt Tablet / 
LCD and a may not be configured 

pen, and an upside-
down display in some co

Afte e first time, subsequent Vista V2 
Console Ima pplied with a “Re-use” option, which retains the existing 

ns, screen configurations, and User Data files. Also, 

dua

To 
e and burn it to a CD, or 

create a bootable USB drive. Instructions for how to create a bootable USB 
drive can be found in Appendix 3 – creating a bootable USB device on Page 16-

 

d your bootable USB drive to your console, but the 
console still boots normally, please download the Vista T Series BIOS Restore 

m and verify the BIOS settings are 

ad. 

Installation of this so

data (the contents of the /data/ directory) to an external storage

When T2 and T4 consoles start in Vista V2 fo
ny additional monitors, touch screens or tablets 

automatically. This may result in incorrect operation of the 
nsoles. See the Known Issues section of these release 

notes for details on how to rectify this. 

r installing the Vista V2 Console Image for th
ges can be a

hard-drive partitio
application-only update packages can be applied using the Vista V2 Console 
Update files, and update package files for Vista 1.13 – if your console is setup for 

l boot. 

install the Vista V2 Console Image: 
1. Download the latest Vista V2 Console Image fil

22.  

2. Insert the CD or bootable USB drive and restart the console. Note the BIOS
settings in some older consoles may not have USB enabled as a boot device. 
If you have connecte

Instructions from www.jandsvista.co
correct. 

3. When the console is finished booting, the Console Software Installer will 
open. Note the Pen will not work during installation; use the touch pad or a 
mouse inste
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4. To install the dual boot software make sure that both the Vista1 and Vista2 

 

Partitions box, or if Vista V2 has been installed 
previously select ‘Re-use’, and click on the ‘Next’ button to start the 

letely erase the hard disk – be sure you have 
t data. 

8. Click the finish button to eject the CD (if present) and shutdown the console. 

When the console has fully shut down, press the Power button to restart the 

If Vista V2 has been previously installed on a console, it is possible to apply most 
 a smaller Vista V2 Console Update package. To install 
, first download the update file onto a USB flash drive, 

or FTP the file into the /Vista V2/UserData/Updates directory on the console. 

. If updating via USB stick, insert the USB stick into a console USB port. 

6. If updating by USB, click on the USB flash drive in the list. If the file has been 
transferred via ftp, navigate to /Vista V2/UserData/Updates. 

7. Select the desired update file and Click “Open”.  

8. The update package will appear on the left hand side of the dialogue. Click 
on the update package. The package contents are now inspected – wait until 
the cursor changes back from the hourglass. 

9. Click ‘Apply Update’. The software will now install the update package. 
When complete, a new dialogue will appear, warning that the console must 
be rebooted for the update to take effect. 

10. Click ‘OK’. 

check boxes are selected and click the Next button. The Confirm Installation 
window will open. 

5. Select a Hard Disk to install to in the Target Disk Device box and select ‘Yes’
in the Proceed with Installation box. 

6. Select ‘Initialise’ in the 

installation. Note this will comp
already backed up any importan

7. When the installation is complete, click the ‘Next‘ button 

Remove the USB drive or CD from the console. 

9. 
console. 

To install a Vista V2 Console Update package: 

new software updates via
a Vista V2 Console Update

1. Boot the console into Vista V2. 

2

3. Select File Quit Application. Wait for the System Settings dialogue to appear. 

4. Click on ‘Apply Update’. 

5. Click ‘Browse’. 
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11. Click ‘Quit’. T series consoles will now power down, while I3 consoles will 
reboot. 

U date. If it 
becom nsole must be re-imaged. 

Installation (Windows XP, Vista & 7) 

2 Windows Update files on a PC: 
1. Close all open applications on the PC.  

sta USB devices. 

to un-install it - simply install 
the new version over the top of the old one. 

4. 

5. 

6. 
all. 

7. 

You  files from a 
Mac or PC to the Vista or vice versa using FTP (File Transfer Protocol, a common 
method of file transfer). 

Hardware setup 
Connect the console and computer to an Ethernet hub or switch using a standard 
Ethernet cable, or connect the two devices to each other using a crossover 
Ethernet cable. 

nlike Vista 1.13, in Vista V2 there is no simple way to revert an up
es necessary to revert to a previous version the co

The Vista V2 software can be installed on a Windows PC running XP, Vista, or 
Windows 7. Both 32 and 64 bit versions of Windows are supported. The 
recommended PC specification is an Intel i3 CPU, 2GB RAM, and 500MB disk 
space. 

 If you want to run Vista 1.13 on the same machine, the 1.13 version must be 
Build 5295 or later.  

To install Vista V

2. Switch off and disconnect all Jands Vi

3. Launch the Vista V2 Windows Installer file. If an earlier version of Vista V2 
is already installed on the PC, there’s no need 

Click ‘Next’. 

A location for the installed files is selected automatically. If required you can 
change the location. Click ‘Next’. 

A location for the User Data folder (your show files etc) is selected 
automatically. If required you can change the location. Click Inst

When the installation is complete, click Finish. 

Connecting to the console via FTP 
 can take advantage of the Vista’s built-in FTP server to move
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Vista software setup 
Open the Network window from the Control panel option on the File me
check the ‘IP Address’ setting. If the IP address is already set, make note of the 
address and close the Control panel. If there’s no IP address or it’s set to 0.
you’ll need to assign one. The address is four groups of numbers from 0 to 255,
all connected by periods. Typically, you’ll use an IP addresses starting with 
192.168 (e.g., 192.168.0.65). 

Computer software setup 
Check that the computer’s TCP/IP properties are set to a different IP address in 
the same subnet (192.168.0.100, for example). The subnet mask should be, 
255.255.255.0.  

If necessary refer to your computers documentation for how to set the IP 

Using FTP 
On the computer start an FTP client such as Filezilla, FTP Commander or 
CuteFTP and open a connection to the consoles IP address (192.168.0.65). The 

nu,  and 

0.0.0, 
 

address. 

nd password as follows: 

ss

 
such as this:

File  the 
Vist

connection requires a username a

Username: byron 
Pa word byron 

If you use  a graphical FTP client such as those mentioned above the contents of 
the consoles Show Data directory and sub folders will be displayed in a window 

 
 

s can now be transferred to and from the Vista by dragging them between
a ( ‘remote site’ window) and the PC ( ‘local site’ window). 

 If the console is not booting properly it maybe possible to copy files using 
this method. 
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1
ble USB device 

6. Appendix 3 – creating a 
boota

Major upgrades, that require the console’s hard drive to be erased, can be 

rating system and Vista software on a T or I series 
console follow the steps below. 

 to boot the console and re-install the software, the drive 
rger and it has to be converted into a Linux system disk. 

Onc you have the original USB 
flashdrive supplied with your I3 you can use it for future updates. In this case 
please skip to step 4. 

Creating a bo ta

1. alled software to help users manage 
the files on the drive. Uninstall this software. 

2. Right-click on the USB Flash drive and selecting the “Format” option from 
the popup menu. Take care that you have selected the Flash drive. If you 
select your computer’s hard disk by mistake, you could erase it completely. 
Ensure the File System option is set to FAT32 before clicking the Start button. 

3. Download and install a ISO file extractor programme such as WinRAR. 
Winrar is available from  http://www.rarlab.com 

4. Download the latest console ISO installer. 

5. Open the console ISO image file with the ISO file extractor. 

6. Extract all of the files and directories within the ISO file to a temporary 
directory on your hard drive, for example to c:\temp\iso_extract. After the 
files have been extracted the directory should look like this: 

installed from a suitably formatted USB device. To create a USB FlashDrive that 
can be used to reinstall the ope

To use a USB flashdrive
needs to be 512MB or la
This procedure will erase all data on the FLASH drive and format it.  

e the FLASH drive has been converted, or if 

o ble USB drive 
To create the drive: 

Some FLASH drives come with pre-inst
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s, 
 navigate to c:\temp\iso_extract\isolinux.. 

9. Copy all of the fil ted 
files eg from c:\temp\iso_extract\isolinux to c:\temp\iso_extract. 

10. Copy all of th fil
c:\temp\iso_extr ep all files in the 
directories th  w f 
time. When the c like this: 

7. Close the ISO file extractor. 

8. Using a file manager, navigate to the isolinux directory of the extracted file
for example

es from the isolinux directory to the “root” of the extrac

e es and directories from the temporary directory eg 
act onto the root of the FLASH drive.  Ke

ey ere installed in. This step takes a significant amount o
opy is complete, the drive directory should look 
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11. Note the drive letter assigned to the Flash drive by Windows,  e.g. ‘E’. Open a 
command prompt and using this drive letter, type the following: 

 

t the drive using the 

ke sure you run the command line 

•  as Administrator 

S settin  
from th

 
[Flash Drive letter]:syslinux –ma [Flash Drive letter]: –f

 Example: 
e: <switch to the usb drive letter to run the syslinux program 

E:\syslinux –ma E: -f 

The FLASH Drive is now ready for use. Don’t forget to ejec
normal Windows procedure.  

Troubleshooting 

 If you are using Windows 7, please ma
actions as Administrator. To do this: 

• open the command prompt 

• right click on the ‘cmd’ icon 

select ‘Run

 The BIO
to boot 

gs on older consoles may need to be changed to allow them
e USB FLASH Drive. 
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17. Appendix 4 – tracking backup  
With Vista’s new tracking backup feature you can connect a computer, running 
the Vista application, or a second console that synchronises it’s show file and 
settings with your main console. If the main console fails for any reason, the 
backup system will automatically take control.  

The backup system automatically copies the show programming from the main 
console and you can start or stop them in any order and at any time. 

Setting up 
mputer(s) have to be physically 

ork settings must be configured 

Con
nsole or computer 

e Console(s) and 
n your 

e Console(s) and 

e Console(s) and 

nsole(s) and 

onfiguring the network settings 
 n IP 

address on 

you
usin
dev

To c
ttings 

To set up a backup system the console(s) and co
connected via their Ethernet ports and their netw
correctly. 

necting the backup 
To connect the main console or computer and the backup co
you can either: 

• connect from the Ethernet port of th
computer(s) to the Local Area Network (LAN) i
building, or 

• connect from the Ethernet port of th
computer(s) to a stand alone Router, or 

• connect from the Ethernet port of th
computer(s) to a stand alone Switch or Hub, or 

• connect the Ethernet port of the Co
computer(s) using a Crossover cable 

C
All consoles or computers being used in a tracking backup system need a

the same subnet as the others. If you are using a LAN or stand-alone 
Router a DHCP server will automatically assign Router IP addresses, provided 

r console’s or computer’s network interface is set to use DHCP. If you are 
g a Switch, Hub or Crossover cable you’ll need to set static IPs on all the 
ices in your backup system: 

Vista T & I series network settings 
onfigure the network on a T or I series console: 

1. Select the Settings option from the File menu. Vista opens the Se
window. 
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2. Click the Network button. Vista opens the Network window: 

  

This field… does this… 

Hostname Indicates the consoles network name. You can change this 
field to something more meaningful (i.e. ‘T4_main’)
two devices, on the network, can have the same hostname. 

 but no 

IP necting to a LAN or 
stand alone router that has a DHCP server. 

2.168.0.10’ 

 set 
s, in the same range. For example: 

‘192.168.0.11’ 

Address Set this field to DHCP if you are con

If there is no DHCP server set this field to a unique Private 
IP address. For example: ‘19

If your backup device is a second console it’s IP must be
to a different addres

IP Netmask Normally this field should be set to 2
connecting to a LAN consult your IT department. 

55.255.255.0. If 

Default 
gateway 

If you are connecting to 

If you are using a Router with a DH
should be set to the IP of the router itself. 

If you are connecting with a Switch or Crossover 

a LAN consult your IT department. 

CP server this field 

cable or 
d to [TBA]. there is no DHCP server set this fiel

 

3. Click OK to close the network window. 
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Computer network settings 
Configuration of the network settings on your PC will vary depending on the OS 

 are using but what you’ll need tyou o enter is similar to the information detailed 
above. 

The  or computer should have a unique 
IP and be on the same subnet. If you are using DHCP  this will be taken care of 

f the console or main computer’s IP is 192.168.0.10, your  backup device 
should be 192.168.0.11 (or any number between 1-254 but not 10). 

If yo
conf gs have taken effect. 

 Tracking Backup 

 computer select the ‘Autosave and Backup’ option 

 most important thing is that each console

automatically. If you are using static IPs make sure each one is different. For 
example i

u have changed your network settings restart the console or computer and 
irm that the new settin

 

Starting
To start Tracking Backup do this: 
1. On the main console or

on the File menu. Vista opens the Backup window: 

  

 the ‘Tracking Backup Config’ tab. 

 If 
ake a note of the name (i.e. Byron_625) or change 

kup console or computer. Remember the Node 
 the same all the devices in your backup system. 

2. If it’s not already selected click on

3.  All devices in a backup system must have the same ‘Node Group’ name.
this is the master console m
this field to a name of your choice (i.e. ‘MainStage’). If you change the Node 
Group name you will be prompted to restart Vista. If you need to restart’ re-
open the Backup window after the restart. 

4. Repeat steps 1 - 3 on the bac
Group name must be exactly

5. Restart the backup system if prompted. It is now ready for use. 
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6. On the main console or computer click on the ‘Network’ tab. Vista
list of any Vi

 displays a 
sta systems running on the same network. You should see your 

backup device and it should have the same Node Group name as the master: 

  

The console or computer  you are working on is marked with an asterisk (*). 

ckup a 
master but will not take over a show until you click on the ‘Failover Now’ 

e been set, click the  ‘Apply’ button. 

 

7. Click on the Network Role field of your master console. 

8. Click on the Network Role field of your backup console and select ‘Primary 
Slave’ from the popup list. A Primary Slave will take over a show 
automatically if the Master fails, whereas a Passive slave will still ba

button on the Failover tab of the Backup window. 

9. When both the master and slave role hav
Vista enables the Network Traffic buttons 

10. Click the Network Traffic Enabled ‘On’ button and click ‘Apply’. Vista 
transfers the show file to the slave: 

 

11. Click the OK button to close the Backup window 

What happens if the Master fails 
If the Master fails an alert window appears on the slave console: 
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On the slave console there are two options 
1. e 

2. C  console take over the 
sh

If neither  button is clicked the slave will take over when the countdown is 

e or control surface 
e backup console in 

the event of a failure. 

e backup console 
ow’ button on the 

Ba
 their respective backup 

windows. To do this select the status tab in the Backup window: 

 Click on the ‘Abort’ button to prevent the slave console from taking over th
show and beginning to output. 

lick on the Failover now button to have the slave
ow immediately and begin to output. 

finished. 

 If you are using the DMX outputs on your Vista consol
you must swap your DMX cables from the master to th

Manually switching to th
To manually switch to the slave device click on the ‘Failover N
Failover tab. 

ckup status 
You can check the status of the master and slave in

  

The master console or computer should show the Local Time Controller and 
Local DMX Output being On. 

The slave console or computer should show the Local Time Controller and Local 
DMX Output being Off – unless the master has failed. 

Vista User Guide, Version 2  17‐29 



Troubleshooting  Appendix 4 – tracking backup 

Troubleshooting 
If you cannot see your slave console on the Network tab of th

Check all your Ethernet cables and connections. 

If you are using a computer turn off any firewall or port blocking 
application. 

Check that the Group name is exactly the 
system. 

Check that both the master and slave have IP addr
subnet. An  IP address consists of four number
192.168.0.1) The numbers for the master and slav
same except for the last number, which must be different an
254. 

On your Vista T or I series you can check the IP 
Network window from the File menu.  

e backup window: 
1. 

2. 

3. same on all devices in your backup 

4. esses that are on the same 
s separated by dots (i.e. 

e should be exactly the 
d between 1 and 

5. by opening the Settings  

. On a Windows PC you can find the IP address from the command prompt 

7. ork Interface is active. Having both 

aster to the Slave and vice versa. 

and prompt 
xxx.xxx.xxx.xxx) – where 
er device in your system. 

ou are using. 

erved for use on private networks 
Ps on a small network it’s best to use 

10.0.

172.16.0.0 - 172.31.255.255 

. 5 

6
(Start > Run > type: cmd) and type: ipconfig). 

On a Mac make sure that only one Netw
the wired (Ethernet) and wireless (Airport) interface active may cause 
tracking backup to fail. 

8. Check that you can ‘Ping’  from the M

9. On a Windows PC you can Ping  another device from the comm
(Start > Run > type: cmd) and type: ping 
xxx.xxx.xxx.xxx is the IP number of anoth

10. Power down and re-start the console(s) and computer(s) y

Private IP addresses 
Three blocks of the IP address space are res
(local area networks). When setting static I
IPs from one of these ranges: 

0.0 - 10.255.255.255 

192 168.0.0 - 192.168.255.25
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18. Appendix 5 – using 
& I‐ series consoles  

VNC on T 

VNC password 
The default password for VNC connections is ‘password’. 

Starting VNC 
To start the VNC server on a Vista T series or I series console: 

ey 
to stop at this window. Then use keyboard  arrow keys to select a startup 

024x768’ to start 
VNC and set the screen resolution to 1024x768 pixels. 

2. Vista will automatically start the VNC server. 

3. Vista is now running the VNC server. 

Connecting to Vista using a Windows PC 
The following procedure is for the VNC Viewer application from Real VNC 
(http://www.realvnc.com/download.html). Other VNC clients for windows 
work in a similar way: 
1. Check that the Vista and your PC are on the same subnet. I.E. if the Vista’s IP 

is 192.168.0.68, your PC should be 192.168.0.xxx (where xxx is 1-254 but not 
68). 

2. Start the VNC client. 

1. Restart the console. When the red Boot Menu  screen appears press any k

option. Select ‘VNC’ to start VNC normally or select ‘VNC 1
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3. In the ‘Connections Details’ window click the Options button, then the Misc 
tab: 

  

tion (do not disconnect other viewers)’. 

ter the Vista IP (i.e. 192.168.0.65). 

 (leave the username blank). 

 using a Mac 
Mac VNCViewer v2.01. 

com/kedoin/VNC/VNCViewer/index.html).  

re on the same subnet. I.E. if the Vista’s 
ut 

2. Start the VNC client. 

4. Tick the box marked ‘Shared Connec
Click OK to close the options window. 

5. In the ‘Connections Details’ window en

6. Click OK to open the login window. 

7. Enter your password and click OK

You should now be able to control the Vista. 

Connecting to Vista
The following procedure is for the 
(http://homepage.mac.

Other VNC clients work in a similar way: 
1. Check that the Vista and your Mac a

IP is 192.168.0.68, your PC should be 192.168.0.xxx (where xxx is 1-254 b
not 68). 
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3 is shared desktop’: 

 

. In the ‘Open D play’ window tick the box marked ‘Allow 

 

: display’ window enter the Vista IP (i.e. 192.168.0.68).  4. In the ‘Hostname

5. Clear the entry in the box to the right of the IP (or enter 0). 

6 OK.. VNC 

7. Enter your passw

You should now be a

. Click will open the login window. 

ord and click OK (leave the username blank). 

ble to control the Vista. 
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19. Appe
contro  to control cues  

ndix 6, Using midi show 
l (MSC)

You can activate and g Midi Show Control (MSC) 
m via the mid
i n on using
Cuelists on page 9-4

onfiguring the midi port 
et a ‘device ID’ that Vista will listen on. This 
idi controller is sending on. To set the device 

 control cues by sendin
essages 

nformatio
i in port on the Vista L, T, I and S series consoles. For 
 Midi Time Code (MTC) see Using Timecode to control 

C
Before you use midi you have to s
should correspond to the ID the M
ID select ‘User preferences’ from the File menu and click on the ‘External 
Control’ tab. 

 

Set the Midi Show Control Device ID
midi software packag

 Tip: Tick the ‘Use
settings as defaults for new shows. 

 to correspond with your controller or the 
e you are using . 

 these settings for new shows’ checkbox to save these 
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M n ages 
 
Midi controllers use s

This MSC term onent… 

SC lighti g mess

tandard terminolgy for lighting cues and cuelists 

is equivalent to this Vista comp

Q_number Cue Number 

<Q_list> Cuelist Number 

<Q_path> Not used 

 

Vista supports all the

This message… 

 most commonly used MSC lighting messages. 

does this… 

Go 

entically and which are in Open Cue 
Lists GO. If a Q_number is sent without a Q_list, all cues 
with a number identical to Q_number and which are in 

If a Q_number is specified, that cue plays. If no 
Q_number is specified, the next cues in numerical order 
and numbered id

Open Cue Lists GO.  

Go e simultaneous with 
forcing the Vista’s internal timecode clock to the 'Go 
Time' if the cue is a 'Timecode' cue. If no Cue Number is 
specified, the next cue in numerical sequence GOes and 
the clock of the appropriate Cue List Jams to that cue's 
time. If the next cue in numerical sequence is a 'Manual' 
cue (i.e. if it has not been stored with a particular 'Go 
Time,' the Go/Jam_Clock command is ignored. 

_Jam Starts a transition or fade to a cu

Go_Off Starts a transition or fade of a cue to the off state. The 
fade time is determined by cuelist’s release time. 

If no Cue Number is specified, the current cue GOes Off. 
If a Cue Number is specified, that cue GOes Off. 

Timed_Go Starts a timed transition or fade to a cue. If no Cue 
Number is specified, the next cue in numerical sequence 
GOes. Time is a standard time specification with 
subframes (type {ff}), providing anything from "instant" 
to 24 hour transitions.  

Stop Halts currently running transition(s). If no Cue Number 
is specified, all running transitions STOP. If a Cue 
Number is specified, only that single, specific transition 
STOPs, leaving all others unchanged. 
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This message… does this… 

R ng. If no 
s 
t 
d. 

esume Causes Stopped transition(s) to continue runni
Cue Number is specified, all Stopped transition
Resume. If a Cue Number is specified, only tha
transition Resumes, leaving all others unchange

All_O  all cuelist intensity output to 0% without changing 
ther features. Equivalent to fading the Grand 

Master to 0%. 

 

ff Turns
any o

The console status prior to All_Off can be re-established 
by using the Restore command. Equivalent to fading the
Grand Master to 0% 

Restore Re-establishes operating status to exactly as it was prior 
to ALL_OFF. 

Reset Releases all running cues..  

 

Advanced Midi options  
everal cuelists at once. To do this 
 cuelists. Vista supports the MSC 

You can send a message (for example Go) to s
you first send an Open message to each of the
messages to open and close cuelists. 

This message… does this… 

Open_cuelist OPEN_CUE_LIST 

Makes a Cu

When OPEN
List becomes active and 
normal show
must be sent. 

If the 
exist, no change occurs. 

e List available to all other commands and 
includes any cues it may contain in the current show. 

_CUE_LIST is received, the specified Cue 
cues in it can be accessed by 

 requirements. Q_list in Standard Form 

specified Cue List is already Open or if it does not 
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This message… does this… 

Close_cuelist Makes a Cue List unavailable to all other command
excludes any cues it may contain from the current s

s and 
how. 

When CLOSE_CUE_LIST is received, the specified Cue 
List becomes inactive and cues in it cannot be accessed 

quirements, but the status of the cues 
 change. Q_list in Standard Form must 

If the specified Cue List is already Closed or if it does not 

by normal show re
in the list does not

be sent. 

exist, no change occurs. 

 

Midi Timecode options  
You can  also control Vista’s internal timecode clock with  midi commands. 

This message… does this… 

Start_Clock Starts Vista’s internal timecode clock. If the clock is 
ck is paused 

 Start 
eously. 

If Q_list is sent in Standard Form, only the clock in that 

already running, no change occurs. If the clo
it continues counting from the time value which it 
contained while it was paused. 

If Q_list is not sent, the clocks in all Open Cue Lists
simultan

Cue List Starts. 

Stop_Clock ista’s internal timecode clock. If the clock is 
already stopped, no change occurs. While the clock is 

t 

 not sent, the clocks in all Open Cue Lists Stop 

ard Form, only the clock in that 
tops.. 

Stops V

stopped, it retains the time value which it contained a
the instant it received the STOP command. 

If Q_list is
simultaneously. 

If Q_list is sent in Stand
Cue List S

 

nds: 
by_Minus, Sequence_Plus, 

 Vista does not support these comma
Load, Set, Fire, Standby_Plus, Stand
Sequence_Minus, Open_Q_Path, Close_Q_Path  
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20. Appendix 7, Using serial 
 control communication to

cuelists  
You can activate and control cues by sending text commands via the serial port 
on a Vista console or PC running the Vista application. Mac users will need a 

mands. 

 to the serial port 
evice to the Vista should be a 

standard serial cable (also called a null-modem cable, or serial printer cable), not 
 at one end needs 

t 
The computer or other device sending the commands and the Vista must have 

to match each other. To set the Vista serial port select ‘User 

e ‘User preferences’ window: 

Keyspan 19H USB to serial converter to receive serial com

Connecting
The cable that connects from the triggering d

a serial cable extension. The important feature is that that pin2
to be connected to pin 3 at the other end and vice-versa). 

Enabling the serial por

their serial ports set 
preferences’ from the File menu and click on the ‘External Control’ tab. Vista 
displays th

 

Vista T, I and L consoles should be set to Serial Port 1, Baud Rate 9600, Data Bits 
8, Stop Bits 1, Parity None and Flow Control Xon/Xoff. 

20‐38  Vista User Guide, Version 2 



Appendix 7, Using serial communication to control cuelists  Playback commands 
 

PC (Windows) systems should be set the same way but the Com port can be 
changed to suit your computer’s configuration 

O t 
dropd

Playback commands 
text followed by 

The syntax for sending commands is: 

This command… does this… 

n Mac systems the Keyspan 19HS device will appear in the Serial Por
own menu. 

All commands should be sent to the Vista as single lines of 
Return or Enter. 

With serial commands you can only play the next cue in a cuelist. It is not 
possible to play a play a cue out of order. 

Command {Cuelist ID} or {Name} or {Cuelist ID:Name} 

Command The supported commands to playback and load shows: 

Go Plays the next cue in the cuelist. Examples: 

Go 1, or  Go Dimmers,  or Go 1:Dimmers 

Pause {ID or 
Name or 
ID:Name} 

Halts playback of  the specified Cue

Pause 5 

list. Example: 

Rego {ID or 
Name or 
ID:Name} 

Resumes play of a paused Cuelist. Example: 

Rego 5 

Release Releases playback of  

Release 1 

the specified Cuelist. Example: 

Load {show 
filename} 

Loads a show
be specified. Example: 

Load C:\ 

 file. The full path to show showfile must 

Setting fixture levels 
You can also send commands to set Fixture levels in the Programmer . The 
Syntax is: 

• {fixture id(s)} @ {level}  

Where the fixture id is any combination of number, +, > and minus and level is a 
value between 0 and 100 or just f (or F) for full.  
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Examples: 

• 1@F  -  fixture 1 to full  

• 1>10-5@ 75  -  fixture's 1,2,3,4,6,7,8,9 & 10 to 75%  

t echo characters sent to the serial port but does send 
acknowledgements to confirm that commands have been received and either 

 
nded with “OK”. For 

executed. 
not known an error 

ist 100 

go 100” would return “100 Unknown”. 

 the message “ ILLEGAL COMMAND” is 

ere is an end of line character (return or enter) at the end of 

and cuelist names are *not* case sensitive. 

Spaces before or after commands and cuelist names do not affect the 
behaviour. 

• 1>10-3>7@f  –  fixtures 1,2,8,9&10 to 100%  

Serial command acknowledgements 
Vista does no

been accepted or have failed.  There are three response types: 

Commands that are understood and could be executed.
Successful  commands  return the complete command appe
example 

 “go 1:List” it would return “go List:1 OK”. 

Commands that are understood but could not be 
If the command is good but the object of that command is 
message will be returned. For example, if there was no Cuel

“

Invalid Commands 
If the command is not understand,
returned. 

 Make sure that th
each command. 

 Commands 
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21. App  Fixture 
tor

endix 8 – The
Edi  

The Fixture Type Library Editor 
The new Fixture Type Library Editor is a separate application to the console 
software. On a Win op 
and can be launched like any other Windows program. On a T-series console it is 
launched from the Patch window menu ‘Patch’ by selecting ‘Fixture Editor’. 

indow is presented with an expanded directory of all the 
rectories, this is the 

llapsed, another directory is 

 be modified, however, copies can be 
 Library and are fully editable. 

 

dows installation it can be found as an alias on the deskt

When launched a w
JANDS supplied fixtures, listed as manufacturer sub-di
factory default directory. Once this directory is co
visible, this is the User Fixture Library and will initially be empty. 

Fixtures in the Factory directory cannot
made and these will be placed in the User Fixture

 

It is recommended that the latest software library be installed and an exhaustive 
search of the fixture library be carried out to determine if the fixture required is 
n ng your own fixture profiles. ot already in the library before writi
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Creating a Fixt rofile 
T ill detail, ste
profile. The fixture being a VL1100D Iris (I) Model. 
W ure Type Ed
ex Ma
fixtures. The fixture library
installed to see if the fixture profile you before writing your 
o

For this tutorial, collapse the ‘Factory
L

ure P
his section w p by step, the process of creating a sample fixture 

hen the Fixt
panded, presenting a 

itor is opened, the inbuilt library is automatically 
nufacturers list containing all JANDS supplied 
 is updated regularly and the latest revision should be 

require is in the list 
wn fixture. 

’ directory and select the ‘User Fixture 
ibrary’ 

 
 

From the Fixture menu select ‘New Fixture…’ 

 

 

A new, blank fixture wind e tabs across the top: ow will open with fiv

 

 This tab… is for…
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This tab… is for… 

Main entering general fixture data. 

DMX Chart All DM  
entered

X channel assignments and channel range values are
 in this tab 

DMX Macros Control macros, including strike, douse and reset are 
entered here. 

Notes Personal notes relating to the fixture can be entered here. 

History A chronological history of the fixture can be kept here. 

Main tab: 

 

This window is used to enter general information values for your fixture. To add 
o   d  the field and either type directly in the field or 
select from the field’s popup menu. 

 is for… 

r edit a value ouble click in

This field…

Manufacturer The name of the company that makes the fixture. 
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This field… is for… 

Full Name The complete, unabbreviated name as supplied b
the manufacturer. 

y 

Short Name An abbreviated name, of your choice, for the Fixture. 
This name will be used in the Chooser window when 
‘show Short Name’ is selected. 

Fixture Status Choose from the popup menu to select the 
appropriate status of the fixture file. 

Beam Type Choose from the popup menu to select the 
appropriate beam type of the fixture. 

Frame Type Choose from the popup menu to select the 
appropriate frame type, choose No Frame if the 
fixture has no framing mechanism. 

Movement Type Choose from the popup menu to select the 
appropriate movement type. 

Physical Type Choose from
appropriate physical type. 

 the popup menu to select the 

Light Generation Choose from the popup menu to select the 
appropriate light source. 

Maximum Pan Degrees Enter the maximum pa
manufacturer. This value is 
flip function to work corr
generally not found in th
but, is usuall
specification sheet. 

n degrees as supplied by the 
required in order for the 

ectly. This information is 
e DMX charts for a fixture, 

y found in the manufacturers 

Maximum Tilt Degrees Enter the maximum tilt 
manufacturer. This value is 
flip function to work corr
generally not found in th
but, is usuall
specification sheet. 

degrees as supplied by the 
required in order for the 

ectly. This information is 
e DMX charts for a fixture, 

y found in the manufacturers 

Element Count 
Horizontally 

Enter the number of horizontal, individually 
controllable elements within the fixture. Used for 

tures with multiple elements such as LED single fix
fixtures. 

Element Count 
Vertically e. Used for 

single fixtures with multiple elements such as LED 
fixtures. 

Enter the number of vertical, individually 
controllable elements within the fixtur
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This field… is for… 

Is a Scroller Defines whether the fixture is a scroller mechanism. 

Patch Part Count 
e 

 One for the par and another for the 
scroller. 

determines how many patchable parts there are for 
the fixture. i.e. a par with a colour scoller will hav
two parts.

Uuid This is a unique identifying number assigned to 
fixture by the fixture editor and c

the 
annot be changed. 

Compatability Id 

programmed attributes of the original (such as 
Preset information etc.) so long as this number is not 

ecome an 
independent fixture and lose those programmed 
attributes. 

This number is for advanced use. When an existing 
Factory fixture is duplicated and modified it will 
retain 

altered. Once altered the fixture will b

Revision A revision number can be added here to keep track 
of multiple versions of the same fixture. 

Factory Version ry version tracking number. This is a factory libra

Carallon Version This version number is supplied by the Carallon 
database and is not relevant when writing fixture 
profiles. 

 

DMX Chart tab: 

 

This icon… does this… 

 

Opens the Add DMX Channel window 
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This icon… does this… 

 

Adds a DMX range to an existing channel. Inactive until a 
channel is created. 

 

Adds a Custom Mode to a channel, used when a feature range
is not mappable to a generic control. i.e. Iris Pulse or Gobo 
Shake 

 

 

Adds a slot to a colour or gobo wheel channel. . Inactive until a 
channel is created. 

 

Use this button to delete selected DMX channels, Ranges, 
Modes or Slots. 

 

Add DMX Channel window: 

 
 

This field… is for… 

Feature 
Class 

This determines which control palette the feature 
will reside in. Intensity Class reside in the Intensity 
palette, Beam in the Beam palette etc. 
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This field… is for… 

Feature 
Type 

This determines which controls on the palette cont
which feature. For example one Beam Type may be 
Iris and another Zoom. Both features appear o

rol 

n the 
Beam contol palette, mapped to their respective 
controls. 

Feature 
Name 

This value is

assigned 

 automatically set by the software unless 
a custom feature is created in which case a user 

name must be applied. 

DMX Channel 
Type Fine channe

here. 

this will detrmin if the feature is 8 bit or 16 bit. The 
l field becomes active if 16 bit is selected 

DMX Channel 
Channel 

Is the Hi byte channel for the feature. 

DMX Channel 
Fine Channel 

Is the Lo byte channel for the feature (if applicable) 

DMX Channel 
Default Value 

This is the default DMX value for home and clear, 
ranging from 0-255. 

 

The DMX Chart window is used to enter all channel information for your fixture. 

ngs for channels and any other 

0D (I) Iris Model fixture this 
DMX tab for it. 

Using the manufacturers DMX specification sheets, a channel list will be built in 
here, the channels can then have various attributes set. Addition of range 
mapping, slots for colours and gobos, mode setti
information required to operate the fixture. 

Using the sample DMX specification for a VL110
section will document how to enter data in the 
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DMX channel specification for a VL1100D (I) Iris Model 
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Channel 1: Intensity 
Click the DMX button to open the 
dialog opens for the first time as below, it
now on. Notice the values are correct for this feat

Add DMX Channel dialog. By default the 
 will open in the last opened state from 

ure. Click OK to create. 

 

The Intensity 8 bit channel 1 has been created in the DMX Chart window. 

 

Channel 2 and 3: Pan Hi and Pan Lo: 16b 
Click the DMX button to open the Add DMX Channel dialog. Select Position in 
Class and Pan in Type. In the DMX channel section select 16 bit and assign the 
correct channel numbers. The Default value should be set to 127 as it is a 
midpoint default feature and the Hi Byte value only need be set. Click OK to 
create. 
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The Pan 16 bit channels 2 and 3 have been created in the DMX Chart window. 

 

Channel 4 and 5: Tilt Hi and Tilt Lo: 16b 
n 

e only need be set. Click OK to 
create. 

Click the DMX button to open the Add DMX Channel dialog. Select Position i
Class and Tilt in Type. In the DMX channel section select 16 bit and assign the 
correct channel numbers. The Default value should be set to 127 as it is a 
midpoint default feature and the Hi Byte valu
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The Tilt 16 bit channels 4 and 5 have been created in the DMX Chart window. 

 

Channel 6: Edge 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Focus in Type. In the DMX channel section select Standard and assign 
the correct channel number. The Default value should be set to 127 as it is a 
midpoint default feature. Click OK to create. 
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The Intensity 8 bit channel 6 has been created in the DMX Chart window. 

 

Channel 7: Zoom 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Zoom in Type. In the DMX channel section select Standard and ass
the correct channel number. The Default value should be set to 127 as it is a 
midpoint default feature. Click OK to create. 

ign 
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The Zoom 8 bit channel 7 has been created in the DMX Chart window. 

 

Channel 8: Frost 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Zoom in Type. In the DMX channel section select Standard and assign 
the correct channel number. The Default value should be set to 0 as it is a 0 
default value feature. Click OK to create. 
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The Frost 8 bit channel 8 has been created in the DMX Chart window. 

 

Channel 9, 10 and 11: CMY Colour mix 
Click the DMX button to open the Add DMX Channel dia
in Class and Cyan in Type. In the DM

log. Select Colour Mix 
X channel section select Standard and 

assign the correct channel number. The Default value should be set to 0 as it is a 0 
default value only need be set. Click OK to default value feature, the Hi Byte 

create and repeat the process for Yellow and Magenta. 
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The three Colour Mix 8 bit channels 9,10 and 11 have been created in the DMX 
Chart window. 

 

Channel 12: Gobo Wheel 
 Add DMX Channel dialog. Select Gobo Wheel 

andard 
 

lick OK to create. 

Click the DMX button to open the
in Class and Gobo Wheel in Type. In the DMX channel section select St
and assign the correct channel number. The Default value should be set to 0 as it
is a 0 default value feature. C
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The Gobo Wheel 8 bit channel 8 has been created in the DMX Chart window. 

 

Channel 12: Gobo Wheel (cont.) 
Note there are three items added for this feature unlike previous features that 
have one simple range value assigned. 

Index Mode: Expand this section and select the range value section as below. 

 

As the specification requires the range for Gobo Wheel Indexing to be 0-127, the 
values need changing. On the right hand side of the DMX Chart window in the 
DMX range section. Apply the change as seen below and click apply. 
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The change to the channel range is reflected in the DMX Range column. 

 

n and select the range value section as below. Rotation Mode: Expand this sectio

 

Gobo Wheel Rotation is  to be 128-255, 
By default most fixtures have clockwise and 

a stop value. The editor places ranges for 
our fixture only rotates in one direction so 

the first thing that is required is to delete the Anti-clockwise range, the Stopped 
 

Select the Anti-clockwise range: 

As the specification requires the range for 
only one range of values is required. 
counter clockwise values as well as 
these by default. The mechanism in 

range can remain and set to 127 if desired. This will make zero rotation on the
controls  stop the wheel spinning at the last indexing value. 

 

Now click the  button to remove the range. 

Channel 12: Gobo Wheel (cont.) 
As the ranges for Stopped and Clockwise rotation are the same as the 

her changes are required. The ranges for gobo manufacturers specification no ot
wheel rotation are now set. 

 

Wheel Slots: Expand this section and Select it. Notice a single Open slot is loaded 
with a range of 0,0. 

 

Use the  button to create as many slots as is required. In this case add 
five slots to make a total of six. 
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correct, select Slot #2. As the Open slot values are already 

 

Channel 12: Gobo Wheel (cont.) 
 

On the right hand side of the DMX Chart window
to add appropriate data with the selected slot. 

A Name may be applied, a Slot Type can be set (G
be assigned, Category is useful in re
fixture types, and an image can be set for preview on the console. 

 the controls are now available 

obo or Colour) a Category can 
modelling gobo patterns when changing 
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As with other features th
values for the slot,  as the specificatio
required to operate the slot in ei

e DMX Range section is used to set the appropriate 
n below indicates, different values are 

ther Indexing or Rotating modes. 

 

Channel 12: Gobo Wheel (cont.) 
wn below, follow the same 
t value for Slot #2 (18 or 146) will 

automatically switch between the two values depending on which control is 

Set the DMX Range values for Slot #2 as sho
procedure for the remaining slots. The correc

currently being used on the console, i.e. indexing or rotating. 
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Click the Select Image button to open up the Images window, navigate to the 
gobos directory and search for the image required, select and open it then name 
it in the Name field. 

 

Tip: Switch the window view to Thumbnails for image previews. 

Channel 13 and 14: Gobo Rotation 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Gobo Slot Rotation in Type. In the DMX channel section select 16 bit 
and assign the correct channel numbers. The Default value should be set to 127 as 
it is a midpoint default feature, the Hi Byte default value only need be set. Click 
OK to create. 

21‐60  Vista User Guide, Version 2 



Appendix 8 – The Fixture Editor  DMX Chart tab: 
 

 

13 and 14 have been created in the DMX The Gobo Wheel Slot 16 bit channels 
Chart window. 

 

Channel 13 and 14: Gobo Rotation (cont.) 
Expand the Index Mode and Rotate ranges. 
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Select the range to edit and adjust t
Chart window in the DMX range se
Ant-clockwise are reverse to the
edited. Apply the change as seen bel
apply. Repeat this procedure for the 
values. 

Anti-clockwise range values: 

he values on the right hand side of the DMX 
ction. As this fixtures rotation Clockwise and 

 default values inserted the ranges need to be 
ow to the Anti-clockwise range and click 
Clockwise range, inserting the correct 

 

Clockwise range values: 

 

As the default value for Stopped is already 127, this need not be adjusted. The 

Channel 15: Iris 
 to open the Add DMX Channel dialog. Select Beam in 

Index Mode values supplied by default are the same as the fixture specification, 
so, it too, requires no adjustment. 

Click the DMX button
Class and Iris in Type. In the DMX channel section select Standard and assign the 
correct channel number. The Default value should be set to 255 as it is a 255 
default value feature. Click OK to create. 
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The Iris 8 bit channel 15 has been created in the DMX Chart window. 

 

Channel 16,17 and 18: Timing channels 
These three channels differ from the previous channels creat
not map to generic controls. They will be Custom Feature ch

ed in that they do 
annels that are 

associated with the Class of feature. 

lick 

 the DMX channel section select Standard and assign the correct channel 
. 

Click OK to create. 

For the Focus Time channel 17 (Varilite terminology states Focus is Position) c
the DMX button to open the Add DMX Channel dialog. Select Custom Position 
in Class, Custom Position will automatically be assigned to Type and as we are 
creating a Custom Feature a feature name needs to be assigned, type in Focus 
Time. In
number. The Default value should be set to 0 as it is a 0 default value feature
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hannel 17 will need 
ime, channel 18 will 

annel is also created as a Custom feature, The Class needs to be set 
trol. This will create the channel, values for the 

 set in the DMX Macros tab. 

Repeat this process for the remaining channels 17 and 18. C
Class and Type set to Custom Colour and named Colour T
need Class and Type set to Custom Beam and named Beam Time. 

Channel 19: Control 
The Control ch
as Custom Misc and Name to Con
control macros will be

 

21‐64  Vista User Guide, Version 2 



Appendix 8 – The Fixture Editor  DMX Chart tab: 
 

The Control 8 bit channel 19 has been created in the DMX Chart window. 

 

Channel 19: Control (cont.) 
To assign control macros, open the DMX Macros 
information using the specification from the manu

tab and enter the relevant 
facturer. 

 

 

Syntax: channel @ value wait milliseconds , next command. 

Complex macros 
Some fixtures require more complex macros for  for strike/reset/douse?. For 
example a fixture might require; ch1 to 255, ch4 to 17,ch 6 to 1, ch 8 to 0, ch 11 to 0 
and ch 15 to 84 and for these channels to be held for 6 seconds, and sent back to 
default 

In this case each command must state a wait time. The syntax is as follows: 

[channel] @ [value] # [wait time in milliseconds] 

So for the example above the macro would read as follows:  

1@255#0;4@17#0;6@17#0;8@0#0;11@0#0;15@84#6000 

That will send the specified values to all channels simultaneously and hold them 
for 6 seconds. 
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Saving the Fixture: 
O cking them 
ag ose OK 
fr

To use the fixture you will first need to exit the Fixture Library Editor, close the 
 library 
ase be 

kes some time. Start Vista and the new fixture will be available 
e User Fixture Library. 

nce all channel ranges have been created, spend a few  minutes che
ainst the manufacturers specification. Click the OK button then cho

om the resulting Save Fixture And Exit dialog. 

editor window and a confirmation dilaog will be presented. Click OK, the
will regenerate the library catalogues to incorporate your new fixture. Ple
patient as this ta
for patching in th

 

Channels with Custom Ranges 
While all the main features of fixtures are represented by generic controls on the 

Modes and Custom Ranges. A simple example of this is an Iris channel with 

Iris: Example ranges: 

Iris closed to open: range: 0 – 128 

Iris 

Iris Pulse-2 slow to fast:

Create the custom ranges as below: 

console,  the ranges that do not fit the generic model are controlled by Custom 

pulse ranges. 

Pulse-1 slow to fast: 129 – 190 

 191 - 255 

 

The :  Iris Pulse controls will be found inside the Custom Iris widget in Vista
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Double click the widget to open the Custom Feature Browser, in order to access 
the custom Pulse range controls: 
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22. Appendix 9 – Crash Logs 

Retrieving Software Crash 
Console 

Files from a 

th
 

and a 
mea of the necessary files for return to Jands support. 

To  port package on a L5, T2, T4 or I3: 
 the 

2. he dialogue will have an additional red 
button labeled “Export Crash Report”. Click “Export Crash Report”. 

. 

curred eg “I was in the 
andle when it crashed”. 

transferred to the USB device.  

eturn the files to Jands via the online 
andsvista.com/support/support-

plication. 

Al ough unusual software crashes can occur. If they do it is important that as 
much detail as possible is returned to Jands to enable the cause to be determined

 eliminated. In order to simplify this process the console software includes 
ns to package all 

generate a crash re
1. Select File -> Quit Application from the main menu, which will open

System Settings dialogue.  

If a crash has recently occurred t

3. Click “Select crash report files”

4. There should be at least one file available, but if there’s more select them all 
using SHIFT + Click or CTRL + Click. 

5. Click “Open”. 

6. If desired you can type some further information into the comment field to 
describe what was being done when the crash oc
timeline selection dragging a h

7. Click “Select removable device”. 

8. Select the USB device from the list. 

9. Click “Choose”. The files will be 

10. When it’s finished click “OK”. 

11. Remove the USB memory stick and r
support request page http://www.j
request-form/ 

12. Click “Vista 2” to restart the Vista ap
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Retrieving Software Crash Files from a Windows PC 
Please follow the procedure below to configure a Windows PC controlling the 
Jands Vista 2 application such that crash dump files may be collected and 
subsequently analysed in the event of a Vista crash. This procedure is for 

y. 

 

 file. If you experience a crash and no log 

The

Set
 box, enter the command "drwtsn32 -i" 

Microsoft Windows operating systems onl

This procedure must be executed before any crash, as files generated without this
application cannot be retrieved or analysed. 

Note: Not all crashes will generate a log
file is generated, please report all information you can to us. 

re are two different procedures – one for XP and another Microsoft Vista. 

up Procedure for Windows XP: 
1. In the Start menu's Run

 

2. A dialog box will appear informing you that Dr. Watson has been installed 
as the default debugger. Press OK. 

 

Windows XP: 
to the directory "C:\Documents and 

lication Data\Microsoft\Dr Watson. Should a Vista 
is directory. 

Retrieving Crash Files on 
1. Crash information will be written in

Settings\All Users\App
crash occur, navigate to th
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2. Check the modification date of the “user.dmp” and “drwtsn32.txt” files to 
make sure that you are looking at the file that corresponds with when the 
crash occurred.  

3. Rename the "user.dmp" file to something a more descriptive eg Byron2-0-
6838_20101124_01.dmp". 

4. Send the renamed user.dmp file, an exported copy of the show file, 
drwtsn32.txt, and a description of what you were doing to 
support@jandsvista.com, or use the support contact form at 
www.jandsvista.com/support. 

Reconfiguring drwtsn32 Settings: 
Running drwtsn32 without any options or switches will bring up a window that 
allows various settings to be changed eg the location of the dump files can be 
made more easily accessible, or a visual alert letting you know a crash was 
logged.  

If drwtsn32 is reconfigured, please ensure that the checkboxes and radio buttons 
remain set as shown in the following image . 
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Additionally the number of crashes to save is limited to 10 by default. Once the 
limit has been reached, the system will no longer generate new log files. To 
en

Proc
Windo d into the Microsoft Vista 
operating system. By default, Vista uploads the crash logs to Microsoft, but does 

opy of the crash logs, the registry must be 
 

 

 extensions - see below for details on changing this 
behavior). The file must have the file extension ".reg". 

ndows Explorer, find the file and double-click on 

ation crashes, the crash information will be written into 

tQueue" (where 

modification date of the directory to make sure that the appropriate directory is 
yed.  

nd files) from the user by default. This 
can be changed in the Control Panel by selecting Folder Options -> View Tab -> 

s and Folders -> Show Hidden Files). 

sure that data is collected users should periodically remove log files. 

edure for Windows Vista: 
ws Error Reporting (WER) has been integrate

not save a local copy. To save a local c
reconfigured by following these steps:

1. Download the file “ActivateCrashDumps.reg” file from the Jands Vista 
website http://www.jandsvista.com/ActivateCrashDumps.reg . Some
browsers helpfully add a ".txt" to the filename (which may not be shown if 
Windows is hiding file file

2. Save the file to the PC. 

3. Using Wi
ActivateCrashdumps.reg to run it. 

4. Respond affirmatively to any prompts. 

5. Reboot the PC. 

The next time any applic
a folder located inside 
"%LOCALAPPDATA%\local\Microsoft\Windows\WER\Repor
%LOCALAPPDATA% is usually "c:\Users\user\AppData"). Check the 

being displa

Windows Vista hides many directories (a

Hidden File
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Each crash will result in a new directory below "ReportQueue". Package up the 

 

entire directory naming each file something more descriptive eg 
“Vista_1.13.522X_20090720_01.dmp" along with the show file and a brief 
explanation of what was being done, and email them to support@jandsvista.com.
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23. Appendix 10 – the touchpad 
and the pen tablet 

Using the touchpad 
Like all pointing devices, the touchpad may take a short time to get used to. 
However you will soon find that using this device is natural and intuitive. 

you

kly tap the surface of the pad once. Or, press the left 
button once. 

ap on the pad or click the left button twice.  

Simply glide your finger across the surface of the pad to move the cursor and tap 
r finger to ‘click’. It's easy! 

Click 
To click, lightly and quic

To double-click, double t

 

Drag 
aw, or highlight, double-tap rapidly and hold your finger down on 

 

Remember, the touchpad responds best to a very firm, crisp tap. 

Right Click 
To right-click for submenus, tap the tap zone in the upper right corner of the 
touchpad or click the right button once.  

To drag, dr
the second tap, then glide to move. You may also hold the left button as you
glide your finger. 
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Glide Extend 
To drag further than the pad surface, lift and reposition your finger after 
reaching the textured edge. GlideExtend will virtually eliminate the edge of the 
pad while you drag. In other words, if you are dragging an item and you hit the 
textured edge, GlideExtend will hold the drag for three seconds while you 
reposition to complete the drag. To shut off GlideExtend earlier than three 

Scroll 
e of the touchpad and glide up or 

down. This featu e
Macintosh advanced ction for USB version of Easy Cat). 

Working  i
This information is kind e pen tablet manufacturer. 

As you work with the pen-tablet, you can rest your hand lightly on the display 
. Hold the Grip Pen as 

seconds, simply tap or click a button. 

To scroll, place your finger down the right edg
re r quires third party software on Macintosh systems (see 

features se

w th the grip pen  
ly provided by Wacom, th

screen, just as if it were a drawing board or sheet of paper
you would a pencil. Make sure the side switch is in a convenient location where 
you can press it with your thumb or forefinger, but won’t accidentally press it 
while drawing.  

 

never be stored in a container where it will rest on its 
 

our desk. 

m (0.2 in), above the 
 the screen cursor or 

use the DuoSwitch without touching the pen tip to the display screen.  

Whe  pen 
simu

 The Grip Pen should 
tip or eraser. When the pen is not in use, place your pen in the pen holder or
lay it flat on y

Tip switch / Pen Tip  
The pen is activated as soon as it enters proximity, about 5 m
Interactive Pen Display screen. This allows you to position

n pressure is applied to the pen tip, the tip switch is turned on and the
lates a mouse button click. 
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Eraser  
se the eraser, hold the GrTo u ip Pen upside down. When the eraser is within 

The

same click and double-click functions 
per 

ng the 
 in Removing and installing the Duo Switch. 

Move the Grip Pen above the pen tablet display screen to position the screen 
on where you place the pen (absolute 

he display screen to make a selection.  

lay screen once with the pen tip, or touch the pen to the display 

hen the pen is perpendicular to 
the tablet screen. 

en to move the 

 

Pen tablet 

d or sheet of paper.  

proximity of the active area, the tablet reports the pen coordinates and the 
pressure applied to the eraser.  

 eraser is not implemented in Version 1 of the Vista software.  

DuoSwitch  
The DuoSwitch can be used to perform the 
as the tip switch. Toggle the DuoSwitch in either direction to activate the up
or lower button functions.  

 If you do not care to use the side switch, you can remove if by followi
directions

Using a pen  

Pointing and Selecting  

cursor. The cursor jumps to the locati
positioning). Press the pen tip on t

Clicking  
Tap the disp
screen with enough pressure to generate a mouse click.  

Double‐Clicking  
Press the upper side switch, or quickly tap the display screen twice in the same 
place with the pen tip. Double-clicking is easier w

Dragging  
Select an object, then slide the pen tip across the display scre
object.  

Erasing  
Erasing is not currently supported in the Vista system. 

Working with the 
As you work with the pen tablet, you can rest your hand lightly on the display 
screen, just as if it were a drawing boar
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Because the drawing surface will be a little higher than a normal desk, consider 
.  

 a good posture at all times and 

 

ints to keep in mind:  

•  Take short breaks between tasks to stretch and relax your 

ts 

Working with On Screen Display Settings  

adjusting the height of you desk or chair to assure comfortable use of the device

When working with the pen tablet, maintain
change your position if you feel any discomfort due to your work position or the 
weight of the tablet.  

The Interactive Pen Display should be positioned so you can view it comfortably
with a minimum of eyestrain.  

Here are some other po

muscles.  

•  Use a gentle grip when working with the pen.  

•  Alternate tasks throughout the day.  

•  Minimize awkward postures and repetitive movemen
that cause discomfort.  

The pen tablet display is equipped with an On Screen Display function. The OSD 
function enables you to adjust and optimize a variety of display settings at the 
touch of a button. The OSD controls are located above the tablet on the T series 
consoles and in the armrest of the L series.  

 

ection buttons  Sel
Use these buttons to select an option that can then be activated when you press 
the Enter button. 

After activating a selected option, press the + button to increase a selected item 
value, and press the button to decrease it.  

The basic process for working with the OSD is as follows:  
1. Press the Menu button to open the OSD main menu.  

2. Use the + or - buttons to select an option. When the option you want to 
adjust is highlighted, press the Enter button. The current settings and 
adjustment sub-menu for that option will appear.  

3. Use the + or - buttons to adjust the option settings.  
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4.  Enter button to save. To exit, 

SD menu closes. If you make 
turn to the original settings, 

et to its original factory 

rface clean. Dust and dirt 
e display screen surface. 

e of your LCD screen surface and pen. 
ean, dry place and avoid extremes in 

n are not made to come apart 
and replacement of the pen’s 
your warranty. 

mage the coating on 
  

blet 
 

liqu ot use paint thinner, benzine, alcohol, or other 
solvents.  

To c
Whe
do n
this e coating on the screen. Please note that damage of this kind 
is not covered by the manufacturer’s warranty.  

Replacing the Pen Tip 
the pen tip gets too short, you can 

h the pen.  

When you have made your changes, press the
press the Menu button.  

 All settings are automatically saved when the O
changes to the display appearance and cannot re
use the Reset Recall option to return The pen tabl
defaults.  

Caring for the Cintiq pen tablet 
Keep the Grip Pen and the Cintiq LCD screen su
particles can stick to the pen and cause wear to th
Regular cleaning will help prolong the lif
Keep Cintiq and the Grip Pen in a cl
temperature.  

Room temperature is best. Cintiq and the Grip Pe
(except where specifically indicated for removal 
DuoSwitch). Taking apart the product will void 

Caution - If the pen tip becomes sharp or angular, it may da
the display screen. Please replace the pen tip if necessary.

Cleaning the Pen‐Ta
To clean the Grip Pen, use a soft cloth and mild detergent (such as dishwashing

id) diluted with water. Do n

lean the display screen, use an anti-static cloth or a slightly damp cloth. 
n cleaning, apply only a fixture amount of pressure to the display screen and 
ot make the surface wet. Do not use detergent to clean the display screen; 

 may damage th

The pen tip will wear with normal use. When 
replace it with one of the extra tips that came wit

 

To remove the old tip:  
Clasp it with a pair of tweezers, needle-nosed pliers, or similar instrument and 
pull the old tip straight out of the pen. 
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To insert a new tip: 
Slide it straight into the barrel of the pen.
new tip will slide into the correct position.  

If the pen tip wears and becomes an
tablet display screen. To avoid this, pe

 Firmly push the tip until it stops. The 

gular, it may damage the coating on the Pen 
riodic tip replacement is recommended.  

wing the pen tip or side switch. The 
be pulled out if children are biting on 

installing the Duo Switch  
ome users prefer to remove the DuoSwitch when working with the Grip Pen. 

For example, you may want to remove the switch in order to focus on a drawing 

utton functionality it offers. For most users it is unnecessary to 
uoSwitch. 

Important: Do not remove the switch by prying it from either end as this may 
immer capacitor that will be visible when 

tch, always 
er to protect the 

1. Firmly clasp  D
rubberized g  i

2. Remove the p  t rip 
forward over the

3. Install the op de 
the grip and push ip. Then replace the pen tip cone 

WARNING Prevent children from swallo
pen tip or side switch may accidentally 
them.  

Removing and 
S

and eliminate any accidental clicks that would occur if you unintentionally 
pressed on the switch. Note, however, that removing the DuoSwitch also 
removes the b
remove the D

damage your Pen. NEVER adjust the tr
the switch is removed. When using the pen without the DuoSwi
replace the original rubberized grip with the optional grip in ord
trimmer capacitor. 

To remove the DuoSwitch:  
the uoSwitch in the middle and pull out. Press in on the 
rip n order to better grasp the switch.  

en ip cone by turning it counterclockwise. Then pull the g
 pen tip.  

tional grip by aligning the pen case rails with the grooves insi
ing the grip over the pen t

by turning it clockwise onto the pen.  
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To Install the DuoSwitch:  
1. Remove the pen tip cone by turning it counterclockwise. Then pull the grip 

2. Install the original grip (the one with the DuoSwitch access slot) by aligning 
the pen case rails with the grooves inside the grip and pushing the grip over 
the pen tip. When properly positioned, the DuoSwitch access hole will reveal 
the trimmer capacitor. Then install the pen tip cone by turning it clockwise 
onto the pen.  

3. Align the DuoSwitch into place, making sure to match the switch position to 
the grip molding. Then gently press in on the DuoSwitch until it snaps into 
place.  

forward over the pen tip.  
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P n th ‐
Tablet 

Temperature and Humidity  
˚C, 20 to 80% RH  

e pen tablet where:  

•

•  The pen tablet and the Grip Pen are exposed to direct 

may damage 

Handling  
 screen has been damaged, DO NOT touch any liquid 

 this liquid is an irritant. In case of contact with skin, 
eyes, or mouth, rinse immediately with running water for at least 15 minutes or 

 mouth, also consult a physician.  

recautions o  using and handling  e Pen

Operating temperature and humidity 5˚ to 35

Storage temperature and humidity -10˚ to 60˚C, 20 to 90% RH  

CAUTION. Do not use or store th

  Temperature changes are severe or exceed specifications 
(e.g., outdoors or inside a vehicle).  

sunlight or heat from an appliance.  

•  The pen tablet and the Grip Pen are exposed to water or 
any other kind of liquid.  

CAUTION. Do not use The pen tablet in a dusty environment; this 
the unit 

WARNING: If the LCD
that may be leaking from it;

more. If contact is made with the eyes or

WARNING: Prevent children from swallowing the pen tip or side switch. The 
pen tip or side switch may accidentally be pulled out if children are biting on 
them.  
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CAUTION: Do not dis
malfunction. In this cas

assemble the Grip Pen. This may cause the device to 
e, Wacom shall have no responsibility to repair or replace 

 on 

N: Avoid intensive shock or vibration to the pen tablet or the Grip 
y screen 

ctive Pen Display or push 
isplay screen or bend the 

n tip becomes sharp or angular, it may damage the coating 
on the display screen. Please replace the pen tip if necessary.  

t (e.g., alcohol) or even mild 
detergent to clean the display screen. Use of these cleaners can damage the 
coating on the screen. Please note that damage of this kind is not covered by the 

.  

T splay sc se an anti-static cloth or a slight loth. 
W pply t of ssure to th y screen and 
do not make the surface wet.  

To clean the pen tablet casing or Grip Pen, use a ft cloth wi
(such as dish washing liquid) diluted with wate

the product. 

CAUTION: Do not scratch the display screen. Avoid placing sharp objects
the display screen surface.  

CAUTIO
Pen. Hitting or dropping the pen tablet display may damage the displa
or other components.  

CAUTION: Do not put heavy articles on the Intera
against it with a strong force; this may damage the d
stand.  

CAUTION: If the pe

CAUTION: Do not use any organic solven

manufacturer's warranty

o clean the di reen, u ly damp c
hen cleaning, a only a fixture amoun pre e displa

 so th mild detergent 
r. 
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24. Appendix 11 – technic
details  

al 

Power 
 T4 / T2 / 

I3 / L5 
E2 / S3 S1 M1 

Power Requirements: 100VAC to 240VAC +/- 10%, 50-6  USB 
powered 0 Hz

Power Consumption: 
max 

atts
max 

0 Watts  Watts 400 Watts 40 W  2 max 2.5
max 

Power Connector: IEC 3-pin USB 

Service & Maintenance 
With care Vista products will require little or no maintenance. However, the 
internal battery (in the T and I series only)will need to be replaced on a regular 
basis (see the following section). 

If the front panel requires cleaning, wipe with a ild deterge  a damp soft 
cloth. 

The CD drive mechanism battery (in the T4 / T2  console only) is mechanical and 
should always be treated with care. Never allow  entry of fluids into the slot. 

DO NOT spray liquids onto the front panel. 

DO NOT use solvents ng the front pan  

Warning: Do not allow the entry of liquids of any sort into the console chassis. 

The T4 / T2 CPU tray should be periodically cleaned to ensure dust does not 
build up near the fans. 

Battery replacement 
The Vista T and I series ternal battery that is used to maintain 
s ings. T st approximately 5 years from the 
date the battery was made. If the console reports BIOS check errors, please return 
the console to an authorised agent for battery replacement. 

 m nt on

 the

for cleani el.

consoles have an in
he battery should laystem BIOS sett
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Installation 
Vista consoles and control surfaces must be installed in a location that allows 
adequate ventilation around the rear of the product. There must be at least 

50mm of free space around the rear and sides of the console when in use. 
uate ventilation may result in premature shutdown of the 

console. 

An external UPS may be connected if mains blackouts are anticipated. 

T4 / T2 / I3 / L5 Shut down 
Always use the correct procedure to shut the console down. Select ‘Shutdown’ 
from the File menu. 

General Specifications 

Inputs & Outputs 
Description Type Pin Outs Function 

1
Failure to allow adeq

DMX 512 (1-4) 5 pin Female AXR  1 
2 
3 
4 
5 

Shield 
Data – 
Data + 
Data – (DMX 4 only) 
Data + (DMX 4 only) 

Ethernet 
(100BaseT) 

RJ-45  1 
2 
3 
4 
5 
6 
7 
8 

Transmit + 
Transmit – 
Receive + 
Unused 
Unused 
Receive – 
Unused 
Unused 

SMPTE (Audio) 3 pin Female AXR  
 

1 
2 
3 

Shield 
LTC – 
LTC + 

MIDI In 5 pin Female DIN  1 
2 
3 
4 
5 

NC 
Shield 
NC 
RX+ 
RXD 
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Description Type Pin Outs Function 
MIDI Thru/Out 5 pin Female DIN 1 

2 
3 
4 
5 

NC 
Shield 
NC 
TX+ 
TXD 

COM (RS232) 9 pin D 1 
2 
3 
4 
5 
6 
7 
8 
9 

DCD 
RXD 
TXD 
DTR 
Gnd 
DSR 
RTS 
CTS 
RI 

Trigger In 6.5mm Jack Socket Tip 
Sleeve 

Trigger In 
Ground 

Trigger Out 6.5mm Jack Socket Tip 
Sleeve 

Trigger Out 
Ground 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 

Red 
Green 
Blue 
NC 
Ground 
Red Ground 
Green Ground 
Blue Ground 
Vcc 
Sync Ground 
NC 
VD Data 
Horizontal sync 
Vertical sync 
VD Clock 

Video 1 
Video 2 

15 pin High Density D 

USB Type A 1 
2 
3 
4 

Vcc 
Data – 
Data + 
Ground 

Audio Mic 3.5mm Jack socket Tip 
Sleeve 

Signal 
Shield 

Audio Out 3.5mm Jack socket Tip 
Ring 
Sleeve 

Left 
Right 
Shield 

Audio Line In 3.5mm Jack socket Tip 
Ring 
Sleeve 

Left 
Right 
Shield 
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Description Type Pin Outs Function 
D
D

1 
2 
3 

Chassis 
Lamp – 
12V 

esk Lamp 1 
esk Lamp 2 

 

 

Vista User Guide, Version 2  24‐85 





Index  General Specifications 
 

25. Index 
A 
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onsole via FTP, 

co

ias cues, 6-17 
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s
apply
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audio playback, 6-28 
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applying, 5-51 
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anging 
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Chooser menu, 14-14 
chooser w
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sort order, 5-18 

oning fixtures, 4-12 
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I3, 11-2 
M1, 11-3 
S1, 11-2 

, 11-2 S3

co

co

co
 

co

console 

co

console control panel, 13-1 
console hardware, 11-1 
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co

ttings, 13-1 

tracts, 5-52, 6-48 
roups, 5-46 

sets, 5-47 

g, 6-15 

ing single cues, 6-18 

properties, 6-21 

s, 6-29 

ol, 9-6 
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9-36 

nd in, 6-11 
ts around, 6-43 

navigator, 6-12 
notes, 6-29 

r, 6-10 
trol window, 10-10 

28 

r, 6-41 
 11-20 

, 6-28 
 

-28 
 

, 6-6, 6-10 
yback, 6-51 

s within, 6-49 
9-5 
-15 

 table, 6-14 
iew cue list, 6-13 
list defaults, 6-29 

C
list tabs, 6-11 
lists, 6-1 

7, 6-23 
locking, 6-23 

yout view, 6-15 
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lues, 5-32 
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T2, 11-2 
nsole 
layout, 11-1 
setting up, 2-1 
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nsole 
modifier keys, 11-4 
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e console, 11-12configuring th
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configuring the console, 11-13 

pages, 11-23 
nsole 
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nsole menu, 14-13 
nsole settings, 13-1 
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effects, 7-4 
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g
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properties, 6-21 
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default prope
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moving even
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playback con
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release timing
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d time, 13-date an
BO, 11-3 
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midi control, 19-36 
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events arou
fixtures arou
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output view tabs 
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save 
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saving 
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selecting fixtures, 5-13 
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selection handles, 6-43 
selection order, 5-14 
selection tools, 5-13 
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using the LR button, 11-4 
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service & maintenance, 24-84 
Session menu, 14-7 
set timing window, using, 6-44 
setting 

beam, 5-26 
colour, 5-23 
gobo, 5-25 
position, 5-22 

setting cuelist properties, 11-20 
setting up, 2-1 
settings 

console, 13-1 
control panel, 13-1 

Shift, 3-4 
show 

creating a show, 2-4 
deleting, 2-6 
exporting shows (backing up), 2-5 
importing shows, 2-5 
loading existing shows, 2-4 
password-protecting, 2-7 
saving, 2-4 
saving copies of, 2-5 

shutdown, 24-85 
sidebar, 3-9, 5-18 

components tab, 5-38 
configuring, 3-9 

slider 
intensity values, 5-22 
setting intensity values in detail, 

5-27 
smartfx 

event mode, 6-24, 6-25 
SmartFX, 5-51, 7-1 
snapshots, 11-23 
soft buttons, 3-2 
software updates, 15-19, 16-24 
sorting 

fixtures, 5-13, 5-14 
specifications, 24-85 
split modes, 11-15 
standard mode, 11-15 
status 

editor, 6-40 
Step menu, 14-9 
Step pane, 10-12 
stopping 

effects, 6-47 
store 

selecting a cue and store options, 
6-8 

selecting a cuelist, 6-7 
store all, 6-2 
store part, 6-6 
storing 

modulating effects, 5-52 
swinging effects, 5-52 

striking a fixture, 3-11, 4-11 
summary 

by feature, 6-35 
by fixture type, 6-36 

summary views, 6-35 
Swap pan/tilt, 4-8 
swing 

making an effect swing, 7-13 
swing effects, 7-7 
switching on, 2-2 
Symmetrical, 4-9 

T 
table view, 4-10 
technical information, 24-84 
template effect 

applying, 7-1 
modifying, 7-3 

the multi quickpicker, 5-41 
time and date, 13-6 
timecode, 6-22, 6-28, 9-5 

adjusting cues to, 8-3 
timeline 

about, 6-6, 6-10, 6-34 
adding events to, 6-41 
aligning start and end points, 6-45 
cuelist tabs, 6-11 
default times, 6-30 
event bars, 6-34 
fade curve, 6-45 
moving events around, 6-43 
reset event time, 6-45 
zooming in and out, 5-2, 21-52, 21-

56, 21-57, 21-58 
Timeline menu, 14-15 
timeline window, 6-10 
timing 
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applying, 6-33 
making precise adjustments, 6-44 
using the set timing window, 6-44 

Timing 
Learn, 8-2 

timing configurations 
saving, 6-32 

toolbar reference, 14-7 
toolbars, 3-10 

chooser and timeline windows, 3-
11 

main, 3-1 
patch window, 3-10 

Tools menu, 14-10 
touchpad, 23-75 
track 

untracking events, 6-47 
tracking backup, 17-27 
transformers, 4-8 

U 
universes 

changing, 4-5 
update software, 15-19, 16-24 
updating 

presets, 5-49, 6-51 
USB 

booting from, 16-24 

USB interfaces, 4-16 
using effects, 7-1 

V 
view 

summary, 6-35 
the rig, 4-10 
using different views, 5-3 

View menu, 14-16 
viewing 

patch in different ways, 4-10 
views 

list view, 4-10, 4-11 
table view, 4-10 

vnc, 18-33 

W 
window basics, 3-1 
windows 

chooser, 5-1 
navigating, 3-1 

Z 
zoom, 5-26 
zoom in and out, 6-39 
zooming in and out, 5-2, 21-52, 21-

56, 21-57, 21-58 
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